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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Use only the power supply and power cord provided with this product or the manufacturer's authorized replacements.

CAUTION—POTENTIAL INJURY: To reduce risk of fire, use only the telecommunications (RJ‑11) cord provided
with this product or a UL Listed 26 AWG or larger replacement when connecting this product to the public
switched telephone network.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.

IMPORTANT SAFETY INSTRUCTIONS: When using your telephone equipment, basic safety precautions should always
be followed to reduce the risk of fire, electric shock and injury to persons, including the following:

• Do not use this product near water for example, near a bathtub, washbowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

• Avoid using a telephone (other than a cordless type) during an electrical storm. There may be a remote risk of
electric shock from lightning.

• Do not use the telephone to report a gas leak in the vicinity of the leak.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug
the power cord from the wall outlet and disconnect all cables from the printer before proceeding.

CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.

SAVE THESE INSTRUCTIONS.
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About your printer

Thank you for choosing this printer!
We've worked hard to make sure it will meet your needs.

To start using your new printer right away, use the setup materials that came with the printer, and then skim the User’s
Guide to learn how to perform basic tasks. To get the most out of your printer, read the User’s Guide carefully, and
make sure you check the latest updates on our Web site.

We're committed to delivering performance and value with our printers, and we want to make sure you're satisfied. If
you do encounter any problems along the way, one of our knowledgeable support representatives will be delighted to
help you get back on track fast. And if you find something we could do better, please let us know. After all, you are the
reason we do what we do, and your suggestions help us do it better.

Minimizing your printer's environmental impact
We are committed to protecting the environment and are continually improving our printers to reduce their
environmental impact. By selecting certain printer settings or tasks, you may be able to reduce your printer's
environmental impact even further.

Conserving energy
• Select the lowest Sleep timeout. The Sleep feature puts the printer in a minimum‑power standby mode after the

printer has been idle for a set amount of time (the Sleep timeout).

• Reduce the screen brightness. Dim the printer display to lower the power consumption of your printer.

• Share your printer. Wireless/network printers allow you to share a single printer among multiple computers, thus
conserving energy and other resources.

Conserving paper
• Print more than one page image on one side of the paper. The Pages per Sheet feature allows you to print multiple

pages on one sheet. You can print up to 16 page images on one side of a sheet of paper.

• Print on both sides of the paper. Two‑sided printing (duplexing) lets you print on both sides of the paper manually
or automatically (depending on your printer model).

• Preview print jobs before printing. Use the preview features found in Toolbars, the Print or Print Preview dialog,
or the printer display (depending on your printer model).

• Use recycled paper.

• Reduce the margins of documents to be printed.

• Scan and save. To avoid printing multiple copies, you can scan documents or photos and save them to a computer
program, application, or flash drive for presentation (depending on your printer model).
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Conserving ink
• Use Quick Print or Draft Mode. These modes can be used to print documents using less ink than normal and are

recommended for printing documents that are mostly text.

• Use font types and font settings that require less ink. Most programs or applications let you adjust the darkness
of the colors.

• Use high‑yield cartridges. Inks in high‑yield cartridges allow you to print more pages.

• Preview print jobs before printing. Use the preview features found in Toolbars, the Print Preview dialog, or the
printer display (depending on your printer model).

Recycling
• Return ink cartridges for reuse or recycling through the Lexmark Cartridge Collection Program. To return an ink

cartridge, go to www.lexmark.com/recycle. Follow the instructions to request a postage‑paid bag.

• Recycle the product packaging.

• Recycle your old printer instead of throwing it away.

• Recycle paper from discarded print jobs.

• Use recycled paper.

To read the Lexmark Environmental Sustainability Report, see www.lexmark.com/environment.

Note: Your printer may not come with some of these programs or some of the functions of these programs,
depending on the features of the printer that you purchased.

Finding information about the printer

Publications

What are you looking for? Find it here

Initial setup instructions:

• Connecting the printer

• Installing the printer software

Setup documentation

The setup documentation came with the printer and is
also available on the Lexmark Web site at
http://support.lexmark.com.
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What are you looking for? Find it here

Additional setup and instructions for using the printer:

• Selecting and storing paper and specialty media

• Loading paper

• Performing printing, copying, scanning, and faxing tasks,
depending on your printer model

• Configuring printer settings

• Viewing and printing documents and photos

• Setting up and using printer software

• Setting up and configuring the printer on a network,
depending on your printer model

• Caring for and maintaining the printer

• Troubleshooting and solving problems

User's Guide

The User's Guide is available on the installation software
CD.

For updates, check our Web site at
http://support.lexmark.com.

Creating and customizing printer solutions, depending on your
printer model

SmartSolutions User's Guide

Go to http://smartsolutions.lexmark.com.

Help using the printer software Windows or Mac Help

Open a printer software program or application, and
then click Help.

Click ?  to view context‑sensitive information.

Notes:

• The Help installs automatically with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.

The latest supplemental information, updates, and online
technical support:

• Troubleshooting hints and tips

• Frequently asked questions

• Documentation

• Driver downloads

• Live chat support

• E‑mail support

Lexmark Support Web site—
http://support.lexmark.com

Note: Select your region, and then select your product
to view the appropriate support site.

Record the following information (located on the store
receipt and the back of the printer), and have it ready
when you contact support so that they may serve you
faster:

• MAC address number

• Serial number

• Date purchased

• Store where purchased

About your printer 9

http://support.lexmark.com/
http://smartsolutions.lexmark.com
http://support.lexmark.com/


What are you looking for? Find it here

Telephone support In the US, call us at:
1-800-395-4039
Monday–Friday (9:00 AM–9:00 PM ET), Saturday
(12:00 noon–6:00 PM ET)

Support telephone numbers and hours of operation for
your region or country can be found on the Support Web
site (http://support.lexmark.com) or on the printed
warranty that came with your printer.

Warranty information • In the US—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

• In other countries or regions—See the printed
warranty that came with your printer.

Note: Your printer may not come with some of these programs or some of the functions of these programs,
depending on the features of the printer that you purchased.

Understanding the parts of the printer

Use the To

1 Automatic Document
Feeder (ADF)

• Scan, copy, or fax multiple‑page documents.

• Access ADF paper jams.

About your printer 10
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Use the To

2 ADF input tray Load original documents into the ADF.

Notes:

• Do not load postcards, photos, small items, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

• After scanning, copying, or faxing, you can lift the right end of the input tray to
retrieve the original documents easily.

3 PictBridge and USB port Connect a PictBridge-enabled digital camera or a flash drive to the printer.

4 Card reader light Check the card reader status. The light comes on when a memory card is inserted and
blinks when a memory card is being accessed.

5 Memory card slot Insert a memory card.

6 Ink cartridge access door Install, remove, or replace ink cartridges.

7 Paper tray (Tray 1) Load paper.

8 Second paper tray (Tray 2)

Note: This option is
available only in select
printer models.

Load additional paper.

You can load the same type of paper as in Tray 1. You can also load a different type of
paper and change the default paper settings so the printer uses paper from Tray 2 for
certain types of print jobs.

9 Exit bin Hold paper as it exits.

Note: For the printer to be ready for any print job, make sure to fully extend the exit
bin and to flip out the bin extender.

10 Bin extender Catch the paper as it exits.

Note: For the printer to be ready for any print job, make sure to fully extend the exit
bin and to flip out the bin extender.

11 Printer control panel Operate the printer.

Use the To

12 Customer support
label

Identify the model number of the printer, the customer support hot line, and the ink
cartridge information.

13 Scanner glass Scan, copy, or fax photos and documents.

14 Power supply with port Connect the printer to the power cord.
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Use the To

15 Duplex unit • Print on both sides of a sheet of paper.

• Access paper jams.

16 USB port Connect the printer to a computer using a USB cable.

Warning—Potential Damage: Do not touch the USB port except when plugging in or
removing a USB cable or installation cable.

Note: Remove the sticker to access the port.

17 Ethernet port Connect your printer to a computer, a local network, an external DSL, or a cable modem.

18 LINE port Connect the printer to an active telephone line through a standard wall jack (RJ‑11), DSL
filter, or VoIP adapter, or any other adapter that allows you to access the phone line to send
and receive faxes.

19 EXT port Connect additional devices (telephone or answering machine) to the printer and the
telephone line. Use this port if you do not have a dedicated fax line for the printer and if
this connection method is supported in your country or region.

Note: Remove the plug to access the port.

Selecting a location for the printer
When selecting a location for the printer, leave enough room to open trays (including optional trays), covers, and doors,
depending on the features of your printer. It is important to:

• Provide a flat, sturdy, and stable surface.

• Keep the printer:

– Away from the direct airflow of air conditioners, heaters, or ventilators

– Free from direct sunlight, humidity extremes, or temperature fluctuations

– Clean, dry, and free of dust
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Ordering and replacing supplies

Ordering ink cartridges
Make sure to order the cartridges that are available in your region.

• Region 1: For the United States, Canada, and Latin America, use 200, 200XL, or 200XLA cartridges.

• Region 2: For the European Union (EU), the European Economic Area (EEA), and Switzerland, use 210, 210XL, or
200XLA cartridges.

• Region 3: For Africa, the Middle East, Central Eastern Europe (non‑EU), the Commonwealth of Independent States
(CIS), and the Asia Pacific region, use 220, 220XL, or 200XLA cartridges.

1 Licensed for a single use only. After use, return this cartridge to Lexmark for remanufacturing, refilling, or recycling.
2 Available only on the Lexmark Web site at www.lexmark.com.

Notes:

• To get more ink, order high‑yield ink cartridges.

• Depending on your country or region, you may get the ink cartridges individually or in packs.

• You can order a mix of standard ink cartridges and high‑yield ink cartridges, depending on your needs.

• For page yield information, visit www.lexmark.com/yields.

• The cartridges used for printing documents can also be used for printing photos.

• For best results, use only genuine Lexmark ink cartridges.

Using genuine Lexmark ink cartridges
Lexmark printers, ink cartridges, and photo paper are designed to perform together for superior print quality, and our
inks are formulated to work with your printer and help extend the life of your product. We recommend that you use
only genuine Lexmark ink cartridges.

Lexmark's warranty does not cover damage caused by non-Lexmark ink or ink cartridges.

Ordering and replacing supplies 13
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Replacing ink cartridges
Make sure you have a new ink cartridge or cartridges before you begin. You must install new cartridges immediately
after removing the old ones, or the ink remaining in the printhead nozzles may dry out.

1 Turn on your printer.

2 Open the ink cartridge access door.

Warning—Potential Damage: Do not extend the ink cartridge access door beyond 90 degrees when opening to
prevent it from breaking.

3 Press the release tab, and then remove the used ink cartridge or cartridges.

4 Insert each ink cartridge until it clicks into place.

Note: Install the new ink cartridges immediately after removing them from the packaging to avoid exposing the
ink to air.

5 Close the ink cartridge access door.

Ordering and replacing supplies 14



Notes:

• If Align Printer appears on the printer display, then touch Continue or press OK , depending on your
printer model.

• Do not remove the alignment page until printing is finished.

Ordering paper and other supplies
To order supplies or to locate a dealer near you, visit our Web site at www.lexmark.com.

Item Part Number

USB cable 1021294

For more information, go to www.lexmark.com.

Paper Paper size

Lexmark Photo Paper • Letter

• A4

• 4 x 6 in.

• L

Notes:

• Availability may vary by country or region.

• For best results when printing photos or other high-quality images, use Lexmark Photo Paper.

• For more information, go to www.lexmark.com.

Recycling Lexmark products
To return Lexmark products for recycling:

1 Visit our Web site at www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country or region from the list.

3 Follow the instructions on the computer screen.

Note: Printer supplies and hardware not listed in a Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Ordering and replacing supplies 15
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Using the printer control panel buttons and menus

Using the printer control panel

1 2 3 4 5

67

Use To

1 Power • Turn the printer on and off.

• Switch to Sleep mode.

Note: When the printer is on, press  to switch to Sleep mode. Press and hold 
for three seconds to turn off the printer.

2 Display

Note: The display is
turned off in Sleep
mode.

View:

• Printer status

• Messages

• Menus

3 Arrow buttons Navigate through menu items that appear on the display.

4 Home Return to the home screen.

5 Keypad In Copy mode or Photo mode:

Enter the number of copies or prints you want to make.

In Fax mode:

• Enter fax numbers.

• Operate an automated answering system.

• Select letters when creating a Speed Dial list.

• Type numbers to enter or edit the date and time shown on the display.

6 Back • Return to the previous screen.

• Exit from one menu level to a higher one.

7 Select

OK

• Select menu options.

• Save settings.
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Use To

8 Redial Display the last number dialed. Press the left or right arrow button to view the last five numbers
dialed.

9 Pause Insert a three-second pause in a fax number to wait for an outside line or get through an
automated answering system. Enter a pause only when you have already begun entering the
number.

10 Dial Tone Dial the telephone number manually using the keypad before sending the fax.

11 Address Book Access fax numbers from a saved list of numbers.

12 Color Switch to color mode.

13 Black Switch to black‑and‑white mode.

14 Start Start a job, depending on which mode is selected.

15 Cancel • Cancel a print, copy, scan, or fax job in progress.

• Clear current settings or error messages, and return to previous settings.

16 Ethernet indicator Check the Ethernet connection of your printer.

17 Wi‑Fi indicator Check the wireless connection of your printer.

Note: This feature may be available only in select printer models.
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Changing the Sleep timeout
The Sleep timeout is the time it takes for the printer to switch to Sleep mode when the printer is left idle. The Sleep
feature optimizes energy efficiency by reducing the printer power consumption. To save the most energy, select the
lowest Sleep timeout.

1 From the printer control panel, navigate to:

 > Setup > OK  > Device Setup > OK  > Sleep > OK

2 Press the up or down arrow button to select or use the keypad to enter the value of the Sleep timeout, and then
press OK .

Saving paper and energy
To significantly cut paper usage and reduce paper waste, activate duplex printing:

1 From the printer control panel, navigate to:

 > Setup > OK  > Print Mode Setup > OK  > 2‑Sided Copy, Standalone > OK

2 Press the up or down arrow button to scroll to On, and then press OK .

To optimize energy efficiency, reduce the Sleep timeout and Screen Brightness:

1 From the printer control panel, navigate to:

 > Setup > OK  > Device Setup > OK  > Sleep > OK

2 Press the up or down arrow button to select or use the keypad to enter the Sleep timeout value, and then press
OK .

3 From the printer control panel, navigate to:

 > Setup > OK  > Device Setup > OK  > Screen Brightness > OK

4 Press the up or down arrow button to scroll to Dim, and then press OK .

Note: If you select 2‑Sided Copy, Standalone, then the printer prints on both sides of the paper (duplex) for
copy and fax jobs, and for printing in Windows and Macintosh, depending on your printer model.

Restoring factory default settings
Resetting to factory default settings will delete all the printer settings you have previously selected.

1 From the printer control panel, navigate to:

 > Setup > OK  > Restore Factory Defaults > OK

2 Press the up or down arrow button to scroll to Restore All Printer Settings, and then press OK .

3 Press the left or right arrow button to scroll to Yes, and then press OK .

The printer restarts automatically after resetting to factory default settings.

4 When prompted to set the initial settings of your printer, make your selections using the printer control panel
buttons.

Initial Setup Complete appears on the display.
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Setting the security PIN of the printer
To prevent unauthorized changes in specific menu settings, you can set a security PIN for the printer.

1 From the printer control panel, navigate to:

 > Setup > OK  > Security Setup > OK  > Set Admin PIN

2 Enter your four‑digit PIN, and then press OK .

Note: Make sure you remember your security PIN. To recover a lost PIN, you will need the assistance of
customer support.

3 From the Security Setup menu, navigate to:

Lock Settings > OK  > On > OK

Note: When Lock Settings is set to On, you need to enter the security PIN every time you want to change some
printer settings. To disable the security PIN, set Lock Settings to Off.

Using the printer control panel buttons and menus 19



Using shortcuts

What are shortcuts?
A shortcut is a way to quickly accomplish printing, copying, scanning, e‑mailing, or faxing tasks with the printer. You
can configure and save a set of frequently used printer settings available for a given task and then assign a shortcut
number and shortcut name to it.

The shortcut number and shortcut name serve as the identification for a particular task and its printer settings. When
you want to perform a task with those settings, you do not need to go through the usual process of adjusting the settings
and options. Simply enter the shortcut number or select the shortcut name and number on the printer control panel,
and the task will launch automatically.

Configure the shortcut settings for a task in the Embedded Web Server:

Select To

Copy Copy a document or photo.

Eco‑Copy Copy a document or photo using two‑sided or draft setting.

ID Card Copy Copy both sides of an ID card onto a single page.

Scan to Fax Scan a document or photo and send it through fax.

Scan to E‑mail Scan a document or photo and send it through e‑mail.

Note: Make sure the printer is connected to the network and the Internet
through an Ethernet or wireless connection.

Scan to Computer Scan a document or photo and send it to your computer.

Note: Make sure the printer is connected to the computer locally (USB).

Scan to Network Scan a document or photo and save it to a network folder.

Note: Make sure the printer is connected to the Internet through an Ethernet
or wireless connection.

Scan to Memory Device Scan a document or photo and save it to a memory card or flash drive (depending
on your printer model).

Print a File Print a document from your computer.

Note: Make sure the printer is connected to the computer through the same
Ethernet or wireless network.

Example:

A lawyer who uses his printer to send e-mails to clients normally navigates through the printer control panel to select
the feature and its available options. Instead of doing that, he can configure the printer settings (such as the message
title and recipient) from the Embedded Web Server, and then assign a shortcut number and shortcut name to the task.
Every time he enters the shortcut number or selects the shortcut name on the printer control panel, the printer
automatically sends the documents according to the selected settings.
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Getting started
During installation, a link will be provided for you to create shortcuts. If you were not able to create your shortcuts
during installation, then you may create the shortcuts through your printer software.

Launching the shortcuts page using the printer software
Before you begin, make sure:

• Your printer and computer are each connected to the network through an Ethernet or wireless connection.

• Your printer is turned on.

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Settings > Configure Shortcuts

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder > Shortcuts

2 Select your printer from the list, and then click Launch.

Creating a shortcut
1 Launch the shortcuts page, and then navigate to:

Add New Shortcut > select a task

2 Assign a shortcut number and shortcut name, and then specify the settings.

Notes:

• A shortcut number is the number you assign to a particular task and its printer settings. You can assign
shortcut numbers from 1 to 999.

• If you configured the shortcut to show the settings before running, then the settings will appear on the
printer display. Adjust the settings if necessary.

3 Click Add.

Modifying or deleting a shortcut
1 Launch the shortcuts page, and then select a shortcut.

2 Do either of the following:

• Make the necessary changes, and then click Save Changes.

• Click Delete.
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Using shortcuts on the printer
Make sure you have created a shortcut.

From the printer control panel, navigate to:

 > Shortcuts > OK  > select a shortcut > OK

or

 >  > enter the shortcut number > OK

Note: If you configured the shortcut to show the settings before running, then the settings will appear on the printer
display. Adjust the settings if necessary.
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Using the printer software

Minimum system requirements
The printer software requires up to 500MB of free disk space.

Supported operating systems
• Microsoft Windows 7 (SP1)

• Microsoft Windows Server 2008 (R2)

• Microsoft Windows Server 2003 (SP2)

• Microsoft Windows Vista (SP2)

• Microsoft Windows XP (SP3)

• Macintosh Intel OS X version 10.7.0 or later

• Macintosh Intel OS X version 10.6.0 or later

• Macintosh Intel OS X version 10.5.0 or later

• Macintosh Intel OS X version 10.4.4 or later*

• Macintosh PowerPC OS X version 10.5.0 or later

• Macintosh PowerPC OS X version 10.4.0 or later*

• Ubuntu Linux 11.10, 10.10, 10.04, 9.10, and 9.04*

• Red Hat Enterprise Linux WS 6, WS 5, and WS 4*

• Red Flag Linux Desktop 6.0*

• SUSE Linux Enterprise Server 11 and 10*

• SUSE Linux Enterprise Desktop 11 and 10*

• Linux openSUSE 12.1, 11.4, 11.3, and 11.2*

• Linpus Linux Desktop 9.6*

• Fedora 16 and 14*

• Debian GNU/Linux 6.0 and 5.0*

* The printer driver for this operating system is available only at http://support.lexmark.com.

Note: Information on additional operating system versions that are compatible with the printer may be available on
our Web site.

Using the Windows printer software

Software installed during printer installation
When you set up the printer using the installation software CD, all the necessary software was installed. You may have
chosen to install some additional programs. The following table provides an overview of various software programs
and what they can help you do.

If you did not install these additional programs during initial installation, then reinsert the installation software CD, run
the installation software, and then click Advanced Options > Install Additional Software.
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Printer software

Use the To

LexmarkTM Printer Home

(referred to as Printer Home)

• Launch applications or programs.

• Scan or e‑mail a photo or document.

• Edit scanned documents.

• Scan documents to PDF.

• Adjust settings for the printer.

• Order supplies.

• Maintain ink cartridges.

• Register the printer.

• Contact technical support.

• Access the User's Guide.

Lexmark Phone Book

(referred to as Phone Book)

Manage your fax contacts.

Abbyy Sprint OCR Scan a document and produce text that you can edit with a word‑processing
program.

Lexmark Wireless Setup Utility

(referred to as Wireless Setup Utility)
• Set up the wireless printer on a wireless network.

• Change the wireless settings of the printer.

Note: This program is installed automatically with the printer software if the
printer has wireless capability.

Lexmark Tools for Office

(referred to as Tools for Office)

Access your favorite settings in Microsoft Office 2007.

Printer Setup Utility Configure the fax and e‑mail settings of your printer.

Status Messenger Learn more about the printing problems encountered.

Status Monitor Center • Check the supplies status of your printer.

• Order supplies online.

Product Update Receive automatic notifications of updates to your printer software when new
updates are available.

Printing Preferences When you click File > Print > Properties with a document open, a Printing
Preferences dialog appears. The dialog lets you select options for the print job,
such as the following:

• Select the number of copies to print.

• Print two‑sided copies.

• Select the paper type.

• Add a watermark.

• Enhance images.

• Save settings.

Note: Printing Preferences is installed automatically with the printer software.

Note: Your printer may not come with some of these programs or some of the functions of these programs,
depending on the features of the printer that you purchased.
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Using the Macintosh printer software

Launching the Print dialog
Use the Print dialog to adjust the print settings and schedule print jobs.

With a document or photo open, choose File > Print.

Launching an application
1 From the Finder, navigate to:

Applications > select your printer folder

2 Double‑click the application that you want to use.

Use the To

Printer Settings • Customize settings for fax jobs.

• Create and edit the Contacts list.

• Configure e‑mail connectivity settings.

• Configure the language, country, date, and time.

Shortcuts Speed up usual tasks with your printer.

Wireless Setup
Assistant

Set up the printer on a wireless network.

Note: This application is automatically installed with the printer software if the printer has
wireless capability.

Uninstaller Remove the printer software from your computer.

Notes:

• Your printer may not come with these applications, depending on the features of the printer that you purchased
or the installation type (standard or custom) chosen when you installed the printer.

• To take advantage of the full features of your printer, select the custom install option during installation, and
then select all packages listed.

Accessing Web links
Web links are links to predefined Web pages that are saved in the printer folder.

1 From the Finder, navigate to:

Applications > select your printer folder > Web Links

2 Double‑click the Web link that you want to visit.

Use To

Customer Support Contact customer support.

Lexmark Software Updates Download and install the latest printer software.

Lexmark Online Visit the Lexmark Web site.

Order Supplies Online Order ink or supplies.
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Use To

Printer Registration Register your printer.

Visit Lexmark SmartSolutions • Visit the SmartSolutions Web site.

• Choose your custom solutions.

Note: Your printer may not come with these Web links, depending on the features of the printer that you purchased.

Finding and installing optional software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Support > Online support

4 From the Web site, select your printer and then download the driver.

5 Install additional or optional software.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder > Web Links > Lexmark Software Updates

2 From the Web site, select your printer and then download the driver.

3 Install additional or optional software.

Updating the printer software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then click Product Update.

4 Follow the instructions on the computer screen.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder > Web Links > Lexmark Software Updates

2 From the Web site, select your printer and then download the driver.
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Downloading PCL and PS drivers (Windows only)
Universal Print Drivers (PCL 5 emulation, PCL XL emulation, and PS emulation) can be downloaded from our Web site.
You need to search for your printer model to view compatible drivers.

Reinstalling the printer software
When you set up the printer using the installation software CD, all the necessary software was installed. If you
encountered problems while installing, or if your printer does not appear in the printers folder or as a printer option
when you send a print job, then try uninstalling and reinstalling the printer.

Uninstalling the printer software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Click the uninstaller.

4 Follow the instructions on the computer screen.

5 Once the uninstall process is complete, restart your computer.

For Macintosh users

1 Close all open applications.

2 From the Finder, navigate to:

Applications > select your printer folder

3 Double‑click Uninstaller.

4 Follow the instructions on the computer screen.

Installing the printer software

Note: If you installed the printer software on this computer before but need to reinstall the software, then uninstall
the current software first.

For Windows users

1 Close all open software programs.

2 Insert the installation software CD.

If the installation dialog screen does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

c Press Enter, or click OK.
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3 Click Install, and then follow the instructions on the computer screen.

For Macintosh users

Note: To take advantage of the full features of your printer, select the custom install option, and then select all
packages listed.

1 Close all open applications.

2 Insert the installation software CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click the software installer package, and then follow the instructions on the computer screen.

Using the Internet

1 Go to the Lexmark Web site at www.lexmark.com.

2 Navigate to:

SUPPORT & DOWNLOADS > select your printer > select your operating system

3 Download the driver, and then install the printer software.

Note: Updated printer software may be available at http://support.lexmark.com.
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Loading paper and original documents

Loading the paper tray
Make sure:

• The printer is turned on.

• You use paper designed for inkjet printers.

• The paper is not used or damaged.

• You follow the instructions that came with the specialty media.

• The paper does not buckle when you adjust the paper guides.

1 Lift the exit bin, and then pull out the tray completely.

2 Move the paper guides to the sides of the tray.
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3 If you are loading legal‑size paper, then squeeze the tab and pull to extend the tray.

4 Load the paper with the printable side facedown.

5 Adjust the paper guides to rest against the left, right, and bottom edges of the paper.

Note: Make sure the paper is below the maximum fill line located on the edge of the paper tray. Overloading
the tray can cause paper jams.
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6 Insert the tray.

Note: If you extended the tray to accommodate legal-size paper, then the tray sticks out from the front of the
printer when inserted.

7 Fully extend the exit bin, and then flip out the bin extender to catch the paper as it exits.

Loading various paper types
Note: Different paper types and sizes should not be loaded together in the paper tray.

Load up to Make sure

300 sheets of plain paper • The paper is designed for use with inkjet printers.

• The paper guides rest against the left, right, and bottom edges of the
paper.
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Load up to Make sure

100 sheets of coated paper

25 sheets of photo paper

25 sheets of glossy paper

• The paper is loaded with the glossy or printable side facedown. If you are
not sure which side is printable, then see the instructions that came with
the paper.

• The paper guides rest against the left, right, and bottom edges of the
paper.

• You do not touch or scratch the glossy surface of the unprinted paper to
prevent smudges or marks that may affect the quality of your prints.

Notes:

• For best results, allow photos to dry at least 24 hours before stacking,
displaying, or storing.

• For best results, load more photo paper than needed, but do not
exceed the maximum number of sheets for your paper type.

10 envelopes

• The envelopes are designed for use with inkjet printers.

• The envelopes are loaded with the printable side facedown and the flap
to the left as shown.

• You load the envelopes in the center of the tray as indicated by the icon.
Load them all the way to the back of the tray.

• You print the envelopes in landscape orientation.

• The paper guides rest against the left, right, and bottom edges of the
envelopes.

• You select the correct envelope size. Set the left and right margins so that
the envelope text will be correctly positioned on the envelope.

Warning—Potential Damage: Do not use envelopes that have metal
clasps, string ties, or metal folding bars.

Notes:

• Do not load envelopes with holes, perforations, cutouts, or deep
embossing.

• Do not use envelopes that have exposed flap adhesive.
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Load up to Make sure

25 sheets of labels • You use full label sheets. Partial sheets (with areas exposed by missing
labels) may cause labels to peel off during printing, resulting in a paper
jam.

• You load A4‑ or letter‑size label sheets.

• The labels are loaded with the printable side facedown.

• The top of the labels feeds into the printer first.

• The paper guides rest against the left, right, and bottom edges of the label
sheets.

50 transparencies • The transparencies are loaded with the rough side facedown.

• You load A4‑ or letter‑size transparencies.

• You remove any paper backing sheets from the transparencies before
loading.

• If the transparencies have a removable strip, then each strip faces down.

• The paper guides rest against the left, right, and bottom edges of the
transparencies.

Note: Transparencies require more drying time. Remove each
transparency as it exits, and allow it to dry to avoid ink smudging.

10 iron-on transfers • You follow the loading instructions that came with the iron-on transfers.

• The transfers are loaded with the printable side facedown.

• The paper guides rest against the edges of the transfers.

Note: For best results, load transfers one at a time.

25 index cards, photo papers, or postcards • The thickness does not exceed 0.025 inches (0.635 mm).

• Photo paper is loaded with the printable side facedown.

• You load the photo paper in the center of the tray.

• The paper guides rest against the left, right, and bottom edges of the
paper.

Note: For best results, allow photos to dry at least 24 hours before
stacking, displaying, or storing.
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Saving paper settings
You can adjust the settings for your print and copy jobs to match the paper size and type you have loaded in the printer.

1 From the printer control panel, press .

2 Adjust the settings as needed:

• If you want to set the paper size, then navigate to:

Setup > OK  > Paper Setup > OK  > Paper Size > OK  > select the default paper size > OK

• If you want to set the paper type, then navigate to:

Setup > OK  > Paper Setup > OK  > Paper Type > OK  > select the default paper type > OK

Loading original documents on the scanner glass
1 Open the scanner cover and place the document facedown on the scanner glass.

2 Close the scanner cover.
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Loading original documents into the ADF
Note: Make sure the paper is below the maximum fill line located on the edge of the paper guide. Overloading the
tray can cause paper jams.

1 Adjust the paper guides on the ADF input tray to the width of the original document.

2 Load the original document faceup and top edge first, until the tip of the document fits snugly into the ADF.

You can load the following paper sizes:

• Letter

• Legal

• 8 x 10 inches

• A4

• B5

• A5

• 20 x 25 cm

• Executive

• Oficio (Mexico)

• Folio

Note: Make sure that the paper size loaded matches the paper size setting in the scan options menu.
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Using different paper sizes and types
For best results, choose a recommended paper for a print job.

Recommended paper brands

For e‑mails, received faxes, internal documents, and similar print jobs

Size Recommended paper Weight Set paper type to

Letter PrintWorks 30% Recycled
Multipurpose Paper #00011

20 lb Plain

A4 UPM Future Multitech 80 g/m2 Plain

For colorful and high‑coverage documents

Size Recommended paper Weight Set paper type to

Letter Georgia Pacific Everyday Ink Jet
and Laser Paper #214305

24 lb ColorLok Certified Plain

Hammermill Ultra Premium Laser
Print #16600‑0
Note: For best results, set Page
Dry Time to Extended.

24 lb Premium Plain

Georgia Pacific Premium
Multipurpose Paper #214306

20 lb Colorlok Certified Plain

A4 M‑Real Data Copy Colour Printing

Note: For best results, set Page
Dry Time to Extended.

90 g/m2 Premium Plain

SOPORCEL Navigator Universal
Multifunctional

80 g/m2 Premium Plain

For résumés, letterhead documents, and similar print jobs

Size Recommended paper Weight Set paper type to

Letter Wausau Professional Series Royal
Linen paper, 30% recycled,
#WAU74089

24 lb Premium Plain

For photos, brochures, business cards, iron‑on transfers, window clings, and other specialty print jobs

Paper and
specialty media

One‑sided or
two‑sided
printing

Recommended paper Set paper type to

Photo One‑sided Lexmark PerfectFinishTM Photo Lexmark PerfectFinish Photo

Lexmark Photo Lexmark Photo
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Paper and
specialty media

One‑sided or
two‑sided
printing

Recommended paper Set paper type to

Matte brochure Two‑sided Inkjet matte brochure papers for light‑ or
moderate‑coverage printing:

• Printworks Matte Photo Paper
#00471

• Paperworks Inkjet 2‑sided Matte
Coated 8.5x11 32lb/120g 60pk P/C:
PPPJJ32‑2

Inkjet matte brochure paper for
heavier‑coverage printing:

• Paperworks Inkjet 2‑sided Matte
Coated 8.5x11 44lb/165g 60pk P/C:
PPPJJ44

Inkjet Matte Brochure

Glossy brochure • Red River Zeppelin SemiGloss

• Paperworks Inkjet 2‑sided Semi‑Gloss
P/C:PPPJJ48 and Manufacturer
#:JANUSSM8511

Inkjet Glossy Brochure

Avery specialty • Avery Half‑Fold Greeting Cards for
Inkjet Printers #3265

• Avery Tri‑Fold Brochures for Inkjet
Printers #8324

• Avery Two‑Side Printable Clean Edge
Business cards for Inkjet Printers
#8871

Business Card

Iron‑on transfer One‑sided Avery T‑shirt Transfers for Inkjet Printers
#3271

Iron‑On Transfer

Clear window
cling

Micro Format, Inc., Super Color Cling
#SP5676

Transparency

Transparent film 3M Inkjet Transparency Film #CG3480 Transparency

Setting the paper size and type
You can adjust the settings for your print and copy jobs to match the paper size and type you have loaded in the printer.

Using the printer control panel

1 From the printer control panel, press .

2 Adjust the settings as needed:

• If you want to set the paper size, then navigate to:

Setup > OK  > Paper Setup > OK  > Paper Size > OK  > select the paper size you want > OK

• If you want to set the paper type, then navigate to:

Setup > OK  > Paper setup > OK  > Paper Type > OK  > select the paper type you want > OK
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Using the printer software

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Click the Paper/Finishing tab, and then select the size or type of paper to use, and the paper source or tray.

4 Click OK.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop‑up menu, choose your printer.

6 From the print options pop‑up menu, choose Quality & Media.

7 From the Paper Type pop‑up menu, choose the type of paper to use.

Setting the page dry time

Using the control panel

1 From the printer control panel, navigate to:

 > Setup > OK  > Print Mode Setup > OK  > Page Dry Time > OK

2 Press the up or down arrow button to scroll to the dry time setting you want, and then press OK .

Note: The dry time varies depending on the print quality selected for the print job. Select Extended to extend the
dry time for your prints.

Using the printer software

For Windows users

1 Click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Print on Both Sides (Duplex) area > select a dry time setting

Note: Under conditions of high humidity, or if the normal drying time does not allow the ink to dry completely,
select Extended.

4 Click OK.
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For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax > select your printer

2 Navigate to:

Open Print Queue > Printer Setup > Driver tab

or

Printer Setup > Installable Options

3 From the Two‑Sided Printing Dry Time pop‑up menu, choose a dry time setting.

Note: Under conditions of high humidity, or if the normal drying time does not allow the ink to dry completely,
choose Extended.

4 Click OK or Apply Changes.

Linking trays
Tray linking is useful for large print jobs or multiple copies. If two trays contain paper of the same size and type, and
the trays have the same settings, then the trays are automatically linked. When one tray is empty, the print job continues
using the linked tray.

From the printer control panel, navigate to:

 > Setup > OK  > Paper Setup > OK  > Paper Tray Linking > OK  > Automatic > OK

Notes:

• Optional trays are purchased separately. For more information, contact the place where you purchased the
printer.

• Make sure the printer is off before installing the optional tray.

• The paper type and paper size in the default paper tray and the optional tray should match to avoid a media
type mismatch error.
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Printing

Tips for printing
• Make sure the exit bin is fully extended and the bin extender is flipped out.

• Use the appropriate paper for your print job.

• Select a higher print quality for better prints.

• Make sure there is enough ink in the ink cartridges.

• Remove each sheet as it is printed when printing photos or when working with specialty media.

Printing basic documents

Printing a document

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Select the print quality, the number of copies to print, the type of paper to use, and how the pages should print.

4 Click OK to close any printer software dialogs.

5 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop‑up menu, choose your printer.

6 From the print options menu, choose the print quality, the number of copies to print, the type of paper to use, and
how the pages should print.

7 Click Print.

Printing 40



Printing using advanced color options
Color printing is enabled by default. To optimize print colors for a special print job, use Color Preference and Advanced
Color Options.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Quality tab > Color Extras area

4 Select either Color Preference or Advanced Color Options.

• If you select Color Preference, then select either Natural or Vivid.

• If you select Advanced Color Options, then select Use ICC test Chart Process.

5 From the “Ink to Use” area, select either of the following:

• Color + Black to use four inks including black.

• Color Only to use cyan, magenta, and yellow inks.

6 Click OK to close any printer software dialogs.

7 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Print.

2 From the printer pop‑up menu, choose your printer.

3 From the print options pop‑up menu, choose Quality & Media > Advanced Options.

4 From the “Ink to Use” pop‑up menu, choose either of the following:

• Color + Black to use four inks including black.

• Color Only to use cyan, magenta, and yellow inks.

5 From the Color Preferences area, choose Natural or Vivid, or choose Use ICC Test Chart Process.

6 Click Print.

Collating printed copies
When printing multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies
as groups of pages (not collated).

Collated Not collated

Notes:

• The collate option is available only when you are printing multiple copies.
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• To prevent smudging when printing photos, remove each photo as it exits the printer, and then let it dry before
stacking.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Copies area

4 Enter the number of copies that you want to print, and then select Collate.

5 Click OK to close any printer software dialogs.

6 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop‑up menu, choose your printer.

6 From the Copies area, enter the number of copies that you want to print, and then select Collated.

7 Click Print.

Changing the print order of pages

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Copies area

4 To change the current page order, select the Reverse page order check box.

5 Click OK to close any printer software dialogs.

6 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.
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5 From the Printer pop‑up menu, choose your printer.

6 From the print options pop-up menu, choose Paper Handling.

7 From the Page Order pop‑up menu, choose a page order:

• To print the first page first, choose Normal.

• To print the last page first, choose Reverse.

8 Click Print.

Printing multiple pages on one sheet

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Page Layouts area > select Multiple pages per side (N‑Up)

4 Select the number of page images to print on each side.

5 Adjust other settings as needed.

6 Click OK to close any printer software dialogs.

7 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop‑up menu, choose your printer.

6 From the print options pop‑up menu, choose Layout.

7 From the Pages per Sheet pop‑up menu, choose the number of page images to print on each page.

8 Adjust other settings as needed.

9 Click Print.
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Printing documents from a memory card or flash drive

Notes:

• The printer reads only one memory device at a time.

• Make sure the memory device contains document files that are supported by the printer.

1 Insert a memory card or flash drive.

When the printer detects the memory device, Memory Card Detected or Storage Device Detected
appears on the display.

2 If document files are stored on the memory device, then the printer automatically switches to File Print mode.

If document files and image files are stored on the memory device, then press the left or right arrow button to scroll
to Documents, and then press OK .

3 Press the up or down arrow button to scroll to the document, and then press OK  to select the document for printing.

4 From the Print Options menu screen, use the arrow buttons to select your printing options, and then press OK , if
necessary.

Note: You may select the number of copies, color mode, print quality, paper settings, and paper‑saving options.
You can also enhance sharpness and use separator sheets.

5 Press  .

Printing specialty documents

Printing envelopes

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Paper/Finishing tab > Paper size list > select your envelope size

If no size matches the envelope size, then click Manage Custom Sizes and set a custom size.

4 Navigate to:

Paper type list > select Envelope

5 Navigate to:

Layout tab > Page Orientation area > select an orientation

6 Click OK to close any printer software dialogs.

7 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the “Format for” pop‑up menu, choose your printer.
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3 From the Paper Size pop‑up menu, choose your envelope size.

If no size matches the envelope size, then set a custom size.

4 Select an orientation, and then click OK.

5 From the menu bar, choose File > Print.

6 From the Printer pop‑up menu, choose your printer.

7 Click Print.

Notes:

• Most envelopes use landscape orientation.

• Make sure the same orientation is also selected in the application.

Printing on labels

Notes:

• Make sure the top of the label sheet feeds into the printer first.

• Make sure the adhesive on the labels does not extend to within 1 mm of the edge of the label sheet.

• Make sure the paper guide or paper guides rest against the edges of the label sheet.

• Use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during
printing, resulting in a paper jam.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Paper/Finishing tab > Manage Custom Sizes > New

4 Type a name and adjust the settings as needed to create a custom size, and then click OK.

5 Navigate to:

Paper type list > select the created custom type

6 Click OK to close any printer software dialogs.

7 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the “Format for” pop‑up menu, choose your printer.

3 From the Paper Size pop‑up menu, choose your paper size.

If no paper size matches the label sheet size, then set a custom size.

4 Select an orientation, and then click OK.

5 From the menu bar, choose File > Print.
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6 From the Printer pop‑up menu, choose your printer.

7 From the print options pop‑up menu, choose Quality & Media.

8 From the Paper Type pop‑up menu, choose Labels.

9 From the Print Quality menu, choose a print quality other than Quick Print or Draft.

10 Click Print.

Printing on custom‑size paper

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Paper/Finishing tab > Manage Custom Sizes > New

4 Type a name and adjust the settings as needed to create a custom size, and then click OK.

5 Click Close, and then click OK to close any printer software dialogs.

6 Click OK or Print.

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the “Format for” pop‑up menu, choose your printer.

3 From the Paper Size pop‑up menu, choose Manage Custom Sizes.

4 Adjust the settings as needed to create a custom size, and then click OK.

5 Click OK.

6 From the menu bar, choose File > Print.

7 From the printer pop‑up menu, choose your printer.

8 Click Print.
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Working with photos

Supported memory cards and file types

Memory card File type

• Secure Digital (SD)

• Secure Digital High Capacity (SDHC)

• Micro Secure Digital (with adapter) (Micro SD)

• Mini Secure Digital (with adapter) (Mini SD)

• MultiMedia Card (MMC)

• Reduced Size MultiMedia Card (with adapter) (RS‑MMC)

• MultiMedia Card mobile (with adapter) (MMCmobile)

• Memory Stick

• Memory Stick PRO

• Memory Stick Duo (with adapter)

• Memory Stick PRO Duo (with adapter)

• xD‑Picture Card

• xD‑Picture Card (Type H)

• xD‑Picture Card (Type M)

Documents:

• .pdf (Adobe Portable Document Format)

Images:

• .jpg, .jpeg, .jpe (Joint Photographic Experts Group)

• .tiff, .tif (Tagged Image File Format)

Using a memory card or flash drive with the printer
Insert a memory card into the card slot or a flash drive into the USB port.
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Inserting a memory card Inserting a flash drive

Notes:

• Insert the card with the brand name label facing up.

• Make sure any arrows on the card point toward the printer.

• If necessary, connect the memory card to the adapter that
came with it.

• Make sure that the memory card inserted is supported by the
printer. For more information, see “Supported memory cards
and file types” on page 47.

• The card reader light comes on when a memory card is inserted
and blinks when a memory card is being accessed.

Notes:

• The flash drive uses the same port that is used
for a PictBridge camera cable.

• An adapter may be necessary if your flash drive
does not fit directly into the port.

Warning—Potential Damage: Do not touch any cables, ports, any
network adapter, any connector, the memory device, or the printer in the
areas shown while actively printing, reading, or writing from the memory
device. A loss of data can occur.

Follow the instructions on the printer display or select from available options.

Notes:

• If the printer does not recognize the memory device, then remove and reinsert it.

• The printer reads only one memory device at a time.
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Printing photos from a memory card or flash drive
1 Load photo paper.

2 Insert a memory card, flash drive, or digital camera set to mass storage mode.

If image files and document files are stored in the memory device, then press the left or right arrow button to select
Photos, and then press OK .

Note: Only files with supported file types will be shown.

3 Use the up or down arrow button to select a photo printing option, and then press OK .

• Select and Print allows you to choose a layout, the number of photos per page, paper settings, photo
size, photo quality, and to sharpen the quality of graphics.

• Print Photos allows you to print all photos, selected photos by photo range, and print photos using
predefined photo size templates.

4 To adjust the print settings, press the up or down arrow button to scroll to the option you want to set, and then
press the left or right arrow button to scroll to the setting you want. If necessary, press OK  to make a selection.

5 Press .

Note: For best results, allow the prints to dry at least 24 hours before stacking, displaying, or storing.

Printing photos from a PictBridge-enabled digital camera
PictBridge is a technology available in most digital cameras that lets you print directly from your digital camera without
using a computer.

1 Insert one end of the USB cable into the camera.

Note: Use only the USB cable that came with the camera.

2 Insert the other end of the cable into the PictBridge port on the front of the printer.

Notes:

• Make sure that the digital camera is set to the correct USB mode. If the camera USB selection is incorrect,
then the camera is detected as a flash drive, or an error message is displayed on the printer control panel.
For more information, see the documentation that came with the camera.

• The printer reads only one memory device at a time.
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Warning—Potential Damage: Do not touch any open connector, the
memory device, or the printer in the areas shown while actively
printing, reading, or writing from the memory device. A loss of data
can occur.

3 If the PictBridge connection is successful, then the following message appears on the display: Use PictBridge
Device to choose and print photos. Press OK to select printer default
settings.

4 If you want to change the default print settings:

a Press OK  to access the PictBridge menu.

b Press the arrow buttons to select the paper source, paper setup, photo size, number of photos per page and
print quality. You can also enhance the quality of graphics. Press OK  each time you make a selection.

Note: The printer will use the default print settings unless you change the print settings from the camera.

5 See the documentation that came with the camera to begin printing.

Note: If you insert the USB cable of the PictBridge‑enabled camera while the printer is performing another job, then
wait for the job to finish before printing from the camera.

Printing on both sides of the paper (duplexing)

Printing on both sides of the paper (duplexing) automatically
The automatic duplex unit supports A4‑, A5‑, letter‑, legal‑, statement‑, and executive‑size paper.

Notes:

• Other paper sizes may be supported.

• Two-sided printing is not supported on envelopes, card stock, or photo paper.

• Do not remove the page until printing is finished.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Print on Both Sides (Duplex) area > select Print on both sides

4 Click OK to close any printer software dialogs.

5 Click OK or Print.
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To return to single-sided printing, repeat steps 1 and 2, and then navigate to:

Layout tab > Print on Both Sides (Duplex) area > select Print on one side only

For Macintosh users

1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop‑up menu, choose your printer.

6 From the print options pop‑up menu, choose Quality & Media.

7 From the Paper Type pop‑up menu, choose Plain Paper.

8 From the print options pop‑up menu, choose Layout.

9 From the Two‑Sided pop‑up menu, choose Long‑Edge binding or Short‑Edge binding.

• For Long‑Edge binding, pages are bound along the long edge of the page (left edge for portrait, top edge for
landscape).

Portrait Landscape

1
2 1

2

• For Short‑Edge binding, pages are bound along the short edge of the page (top edge for portrait, left edge for
landscape).

Portrait Landscape

10 Click Print.

Printing 51



Setting the duplex printing dry time

Using the control panel

1 From the printer control panel, navigate to:

 > Setup > OK  > Print Mode Setup > OK  > Page Dry Time > OK

2 Press the up or down arrow button to scroll to the dry time setting you want, and then press OK .

Note: The dry time varies depending on the print quality selected for the print job. Select Extended to extend the
dry time for your prints.

Using the printer software

For Windows users

1 Click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Layout tab > Print on Both Sides (Duplex) area > select a dry time setting

Note: Under conditions of high humidity, or if the normal drying time does not allow the ink to dry completely,
select Extended.

4 Click OK.

For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax > select your printer

2 Navigate to:

Open Print Queue > Printer Setup > Driver tab

or

Printer Setup > Installable Options

3 From the Two‑Sided Printing Dry Time pop‑up menu, choose a dry time setting.

Note: Under conditions of high humidity, or if the normal drying time does not allow the ink to dry completely,
choose Extended.

4 Click OK or Apply Changes.
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Managing print jobs

Finding the print queue for your printer
A print queue represents the printer that is connected to your computer. The print queue name is usually the printer
model or the printer nickname assigned when installing or adding the printer.

Note:  Several print queues may appear in the list depending on how the printer is connected (USB, Ethernet,
wireless). Make sure you know how your printer is connected to the computer to be able to select the correct print
queue.

For Windows users

1 Open the printers folder.

a Click , or click Start and then click Run.

b In the Start Search or Run box, type control printers.

c Press Enter, or click OK.

2 Find the print queue for your printer (Network or USB).

3 If the print queue is not in the list, then create a new print queue.

For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax > the print queue for your printer

2 If the print queue is not in the list, then create a new print queue.

Creating a print queue

For Windows users

1 From the Printer Tasks area, click Add a Printer.

2 Follow the instructions on the computer screen.

For more information, see the documentation that came with your operating system.

For Macintosh users

1 From the Print & Fax area, click +.

2 If necessary, click the Default or Default Browser tab.

3 Select your printer from the list.

Note: Printers connected to the network or locally through a USB cable may have the same default printer
name. If necessary, use the Name field to rename the printer.

4 Click Add.
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Setting your printer as the default printer
Your printer should be selected automatically from the Print dialog when you send a print job. If you have to manually
select your printer, then it is not the default printer.

To set the default printer:

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printers folder opens.

4 Right‑click the printer, and then select Set as Default Printer.

For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax

2 Select the printer from the Default Printer pop‑up menu, or select the printer and click Make Default.

Changing the default printing mode
To conserve ink, you can change the default printing mode for all print jobs to Draft or Quick Print. It uses less ink and
is recommended for printing text-only documents. If you need to change to a different print mode to print photos or
other high-quality documents, then you can select a different mode from the Print dialog before sending the print job.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Quality tab > select a print quality > OK

For Macintosh users

1 With a document open, choose File > Print.

2 From the printer pop‑up menu, choose your printer.

3 From the print options pop-up menu, choose Quality & Media.

4 From the Print Quality pop‑up menu, choose a print quality.

5 Click OK.
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Pausing print jobs

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printers folder opens.

4 Right‑click the printer, and then select Open or See what's printing.

5 Pause the print job:

• If you want to pause a particular print job, then right‑click the document name, and then select Pause.

• If you want to pause all print jobs in the queue, then click Printer, and then select Pause Printing.

For Macintosh users

1 Click the printer icon on the Dock.

The print queue dialog appears.

2 Pause the print job:

• If you want to pause a particular print job, then choose the document name, and then click Hold.

• If you want to pause all print jobs in the queue, then click Pause Printer or Stop Jobs.

Resuming print jobs

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printers folder opens.

4 Right‑click the printer, and then select Open or See what's printing.

5 Resume the print job:

• If you want to resume a particular print job, then right‑click the document name, and then select Resume or
Restart.

• If you want to resume all print jobs in the queue, then click Printer, and then clear the selection for Pause
Printing.

For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax > select your printer

2 Click Open Print Queue or Set Up Printers.

The print queue dialog appears.
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3 Resume the print job:

• If you want to resume a particular print job, then choose the document name, and then click Resume.

• If you want to resume all print jobs in the queue, then click Resume Printer or Start Jobs.

Canceling print jobs

To cancel a print job from the printer control panel, press , and then press OK . Printing stops and the printer returns
to the home screen.

To cancel a print job from the computer, do the following:

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

The printers folder opens.

4 Right‑click the printer, and then select Open or See what's printing.

5 Cancel the print job:

• If you want to cancel a particular print job, then right‑click the document name, and then select Cancel.

• If you want to cancel all print jobs in the queue, then click Printer > Cancel All Documents.

For Macintosh users

1 Click the printer icon on the Dock.

The print queue dialog appears.

2 Choose the job you want to cancel, and then click Delete.

Printing from a mobile device

What is LexPrint?
LexPrint is a free application that lets you print easily from your iPad, iPhone, or iPod touch using any Lexmark printer
connected to the same wireless network. It lets you print Web pages, photos from the photo album, or photos you
recently captured using the camera of your mobile device, depending on its features. You can also customize print
settings from your mobile device.

Depending on your Lexmark printer model, you may need to download the LexPrint Listener application from our Web
site at www.lexmark.com/lexprint.
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Supported printers
LexPrint enables your mobile device to communicate with Lexmark printers found on the same network.

• For select printer models that support Direct Image and Zeroconf or Bonjour, you can print directly from your mobile
device to the printer without using LexPrint Listener. To check if your printer model supports these features, visit
www.lexmark.com/lexprint.

• For other Lexmark printers, your mobile device can send print jobs to your printer as long as the printer software
and LexPrint Listener are installed on the computer where the printer is connected.

Note: The application referred to as Rendezvous in Mac OS X version 10.2 is now called Bonjour by Apple Inc.
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Copying

ADF Scanner glass

Use the ADF for multiple‑page documents.

Note: The ADF is available only in select printer models. If you
purchased a printer without an ADF, then load original
documents or photos on the scanner glass.

Use the scanner glass for single pages, small items (such
as postcards or photos), transparencies, photo paper, or
thin media (such as magazine clippings).

Tips for copying
• Make sure the exit bin is fully extended and the bin extender is flipped out.

• Use the ADF when scanning two‑sided pages if your printer supports duplex scanning and the ADF supports the
original document size.

• Use the scanner glass when scanning two‑sided pages if your printer does not support duplex scanning or the ADF
does not support the original document size.

• When using the ADF, adjust the paper guides on the ADF to the width of the original document.

• To easily retrieve a document after copying or scanning, lift the ADF input tray.

• When using the scanner glass, close the scanner cover, if possible, to avoid dark edges on the scanned image.

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF. Place these items on the scanner glass.

• When the document to be copied is in place with the settings you want, press  to start copying.

Making copies
1 Load paper.

2 Load an original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Copies

4 Press the left or right arrow button to select the number of copies.
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5 From the Copy menu screen, press the up or down arrow button to scroll to the option you want to set, and then
press the left or right arrow button to scroll to the setting you want. If necessary, press OK  to make a selection.

6 Select the copy mode:

• Press  to switch to color mode.

• Press  to switch to black‑and‑white mode.

When you select color or black‑only printing, the light that corresponds to your choice comes on.

7 Press .

Note: The selected copy settings are reset to the factory default after two minutes of printer inactivity.

Copying an ID card
1 Load plain A4‑ or letter‑size paper.

2 From the printer control panel, navigate to:

 > Copy > OK  > ID Card Copy

3 Press , and then load the front side of the ID card facedown at the placement corner of the scanner glass.

4 Press .

5 When prompted to copy the back side of the ID card, press the left or right arrow button to scroll to Yes, and then
press OK .

6 Load the back side of the ID card facedown at the placement corner of the scanner glass, and then press .

Enlarging or reducing images
1 Load paper.

2 Load the original document facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Scale

4 Press the left or right arrow button to scroll to the Scale setting you want.

Notes:

• If you select Custom %, then press OK , and then press the left or right arrow button to select a custom
percent value. Press OK  to save the setting.

• If you select Borderless, then the printer will reduce or enlarge the document or photo as necessary to print
a borderless copy on the paper size that you selected. For best results with this setting, use photo paper and
set the paper type to Photo.

• If you select Fit to Page, then the printer scales the document or photo proportionately to fit a single page.

5 Press .
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Adjusting copy quality
1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Quality

4 Press the left or right arrow button to set the copy quality.

5 From the Copy menu, select Content Type.

6 Press the left or right arrow button to scroll to the type that describes the original document, and then press OK .

7 From the Copy menu, select Content Source.

8 Press the left or right arrow button to scroll to the option that describes how the original document was produced,
and then press OK .

9 Press .

Making a copy lighter or darker
1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Darkness

4 Press the left or right arrow button to adjust the darkness of your prints.

• Pressing the left arrow button makes the copy lighter.

• Pressing the right arrow button makes the copy darker.

5 Press .

Collating copies using the printer control panel
If you print multiple copies of a document, then you can choose to print each copy as a set (collated) or to print the
copies as groups of pages (not collated).

Collated Not collated

1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Copies
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4 Press the left or right arrow button to select the number of copies.

5 Press the up or down arrow button until Collate appears.

6 Press the left or right arrow button to scroll to On, and then press .

Placing separator sheets between copies
A separator sheet is a sheet of paper placed between pages, copies, or jobs based on the setting selected. This feature
is useful when printing transparencies.

1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Separator Sheets

Note: Collate must be set to On for the separator sheets to be placed between copies. If Collate is set to Off,
then the separator sheets are added at the end of the print job.

4 Press the left or right arrow button to select a separator sheet setting, and then press .

Copying multiple pages on one sheet
You can copy multiple pages on one sheet by printing smaller images of each page. For example, you can condense a
20‑page document into five pages if you use this setting to print four page images per sheet.

1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Pages per Side

4 Press the left or right arrow button to select the paper orientation and the number of pages that you want to copy
on a sheet of paper. You may print up to four page images on one sheet.

5 Press .

Placing an overlay message on each page
1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Overlay

4 Press the left or right arrow button to select an overlay setting.

Note: For select printer models with a keypad, use the keypad to enter a custom text overlay, and then press
OK . To change a character, press the left arrow button. To add a space, press the number 0.

5 Press .
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Removing the background of a copy
The Background Removal feature adjusts the amount of background visible on a copy.

1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > Background Removal

4 Press the left or right arrow button to select the amount of background removal.

5 Press .

Making a duplex (two-sided) copy

Making a duplex (two‑sided) copy automatically
The automatic duplex unit supports A4-, A5-, letter-, legal-, statement-, and executive-size paper. If you need to make
two‑sided copies using other paper sizes, then see the instructions for making a two‑sided copy manually.

Note: You cannot make two‑sided copies on envelopes, card stock, or photo paper.

1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.

3 From the printer control panel, navigate to:

 > Copy > OK  > 2‑Sided Copies

4 Press the left or right arrow button to select a two‑sided copying option:

• If you are copying a one‑sided document, then press the arrow buttons to scroll to 1‑sided to 2‑sided.

• If you are copying a two-sided document and using the scanner glass, then press the arrow buttons to scroll to
2‑sided to 2‑sided.

• If you want to specify the page orientation and layout of the original document and the copy, then press the
arrow buttons to scroll to Advanced. Press OK  every time you make a selection, and then press  until you
reach the Copy menu.

Notes:

• For long-edged binding, pages are bound along the long edge of the page (left edge for portrait orientation
and top edge for landscape orientation).

• For short-edged binding, pages are bound along the short edge of the page (top edge for portrait orientation
and left edge for landscape orientation).

5 Press , and then follow the instructions on the printer display.

Making a duplex (two‑sided) copy manually
1 Load paper.

2 Load the original document faceup into the ADF or facedown on the scanner glass.
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3 From the printer control panel, navigate to:

 > Copy > OK  > Copies

4 Press the left or right arrow button to select the number of copies.

5 From the Copy menu screen, press the up or down arrow button to scroll to the option you want to set, and then
press the left or right arrow button to scroll to the setting you want. If necessary, press OK  to make a selection.

6 Select the copy mode:

• Press  to switch to color mode.

• Press  to switch to black‑and‑white mode.

When you select color or black‑only printing, the light that corresponds to your choice comes on.

7 Press  to print on one side of the paper.

8 Load the next page of the document.

• If you are copying a one‑sided document, then load the next page faceup into the ADF or facedown on the
scanner glass.

• If you are copying a two‑sided document, then flip the original document, and then reload it faceup into the
ADF or facedown on the scanner glass.

9 Remove the paper from the exit bin, and then reload the paper to print the other side of the document.

Make sure the paper is loaded with the printable side facedown.

10 When prompted to confirm the paper settings, press the left or right arrow button to scroll to Yes, and then press
OK .

11 Press .

Canceling copy jobs
To cancel a copy job, press , and then press OK .

Scanning stops and the printer returns to the previous menu.
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Scanning

ADF Scanner glass

Use the ADF for multiple‑page documents.

Note: The ADF is available only in select printer models. If you
purchased a printer without an ADF, then load original
documents or photos on the scanner glass.

Use the scanner glass for single pages, small items (such
as postcards or photos), transparencies, photo paper, or
thin media (such as magazine clippings).

Tips for scanning
• Use the ADF when scanning two‑sided pages if your printer supports duplex scanning and the ADF supports the

original document size.

• Use the scanner glass when scanning two‑sided pages if your printer does not support duplex scanning or the ADF
does not support the original document size.

• When using the ADF, adjust the paper guides on the ADF to the width of the original document.

• To easily retrieve a document after copying or scanning, lift the ADF input tray.

• When using the scanner glass, close the scanner cover, if possible, to avoid dark edges on the scanned image.

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF. Place these items on the scanner glass.

• When the document to be scanned is in place with the settings you want, press  to start scanning.

Scanning to a local computer
1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 From the printer control panel, navigate to:

 > Scan > OK  > Computer > USB‑Connected Computer > OK

The USB‑connected computer will receive the scan by default.

Note: Make sure the scan software is installed on the destination computer.
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3 Press the up or down arrow button to scroll to the scan option you want to set, and then press the left or right
arrow button to scroll to the setting you want.

Set the color, quality, original image size, and other scan options. If necessary, press OK  each time you make a
selection.

4 Press .

Scanning to a network computer
1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 From the printer control panel, navigate to:

 > Scan > OK  > Computer

3 Press the left or right arrow button to manually select the name of the destination computer, and then press OK .

Notes:

• You may be prompted to enter a PIN if the computer requires it.

• To assign a computer name and a PIN to the computer, see the Help for the printer software associated with
your operating system.

4 Press the up or down arrow button to scroll to the scan option you want to set, and then press the left or right
arrow button to scroll to the setting you want.

Set the color, quality, original image size, and other scan options. If necessary, press OK  each time you make a
selection.

5 Press .

Note: For Macintosh users, you may need to enable scanning to your computer through Image Capture to scan
documents using a network printer and save the scan output.

Scanning to a network folder
Notes:

• This feature may not appear in the Embedded Web Server, depending on your printer model.

• Make sure you have created a folder shortcut before you begin. For more information, see “Adding a network
folder shortcut” on page 66.

1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 From the printer control panel, navigate to:

 > Scan > OK  > Network Folder > OK

3 Press the left or right arrow button to scroll to the name of the network shared folder you want, and then press
OK .

4 Press the up or down arrow button to scroll to the scan option you want to set, and then press the left or right
arrow button to scroll to the setting you want.
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5 Set the color, quality, original image size, and other scan options. If necessary, press OK  each time you make a
selection.

6 Press .

Note: For Macintosh users, you may need to enable scanning to your computer through Image Capture to scan
documents using a network printer and save the scan output.

Adding a network folder shortcut
1 On your computer, create a shared folder with read/write access.

2 On a Web browser, type your printer IP address, and then press Enter.

3 Navigate to either of the following:

• Settings > Scan‑to‑Network Folder Setup

• Settings > Manage Shortcuts > Add New Shortcut > Scan to Network

4 Enter the necessary information, and then click Add.

Note: To avoid unsaved changes to your settings, make sure the network folder shortcut name is different from that
of your folder name.

Scanning to a flash drive or memory card
Notes:

• Some features are available only in select printer models.

• Make sure your flash drive or memory card is not write‑protected.

1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 From the printer control panel navigate to:

 > Scan > OK  > Memory Device

3 Insert the flash drive or memory card, and then press OK .

Note: The printer reads only one memory device at a time.

4 Press the up or down arrow button to scroll to the scan option you want to set, and then press the left or right
arrow button to scroll to the setting you want.

Set the color, quality, original image size, and other scan options. If necessary, press OK  each time you make a
selection.

5 Press .

Follow the instructions on the printer display.
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Scanning photos

For Windows users

1 Load the photo or photos facedown on the scanner glass.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > Scan > Advanced scan

5 From the Scan Source list, select Flatbed.

6 From the Scan Settings tab, select the appropriate settings:

a Set Resolution (dpi) to 150 dpi or more.

b Set Color Depth to Color.

c Set Content Type to Photo.

d From the Original Types list, select the item that best describes your original photo.

• For example, if you are scanning a glossy photo printed on your inkjet printer, then select Inkjet Glossy.

• If you are scanning a glossy photo purchased from a photo print service, then select Retail Photo.

7 Click Scan, and then follow the instructions on the computer screen.

8 When the scan is complete, save the photo or photos as JPEG(*.JPG).

For Macintosh users

1 Load the photo or photos facedown on the scanner glass.

2 From the Applications folder in the Finder, launch Image Capture.

3 From the list of devices, select your printer.

Note: If your printer name is not present in the list of devices, then you need to create a print queue for your
printer. For more information, see the documentation that came with your operating system.

4 Adjust the scan settings as follows:

a Set Kind to Color.

b Set Resolution to 150 dpi or more.

c Set Format to JPEG.

d Set Original Type to the item that best describes your original photo.

• For example, if you are scanning a glossy photo printed on your inkjet printer, then select Inkjet Glossy Photo.

• If you are scanning a glossy photo purchased from a photo print service, then select Retail Glossy Photo.

5 Start the scan job.
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Scanning directly from the printer control panel

1 Load the photo or photos facedown on the scanner glass.

Note: If you have sheets loaded on the ADF and photos loaded on the scanner glass, then the sheets on the ADF
will be scanned. Make sure to clear the ADF if you want to scan the photos on the scanner glass.

2 From the printer control panel, navigate to:

 > Scan > OK  > select a scan destination

If necessary, follow the instructions on the printer display.

Note: If you have selected a computer as the scan destination, then make sure that the scan software is
installed on the destination computer.

3 From the Scan Options menu, press the up or down arrow button to scroll to the scan option you want to set, and
then press the left or right arrow button to select an appropriate setting.

If necessary, press OK  each time you make a selection.

a Set File Type to Photo.

b Set Quality to 150 dpi or more.

c Set Content Type to Photo.

d Set Content Source to the option that best describes your original photo.

• For example, if you are scanning a glossy photo printed on your inkjet printer, then select Inkjet Glossy.

• If you are scanning a glossy photo purchased from a photo print service, then select Retail Photo.

4 Press .

Scanning documents for editing
An Optical Character Recognition (OCR) application allows you to edit an original text document that has been scanned.
In order for this to work, you must have an OCR application stored on a local or network computer and you must be
able to select it from the list of applications when you set up the scan.

When selecting settings for the scan, select to scan to the local computer or network computer where the OCR is
installed.

For Windows users

1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > Scan > Document

Scanning starts and the scan progress dialog appears.

5 When the scan is finished, save the document.

The file will be converted into a format that can be edited.

6 Open the document in the appropriate application to edit it.
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For Macintosh users

1 Load the original document faceup into the ADF or facedown on the scanner glass.

2 From the Applications folder in the Finder, launch the application you want to use.

Notes:

• Use any application that supports your printer and lets you work with the OCR software, ABBYY FineReader.

• If the OCR software is missing, then insert the installation software CD. Reinstall the printer software using
the custom install option so you can manually select all of the packages listed.

3 From the list of devices, select your printer.

Note: For information on finding the list of devices, check the documentation that came with the application or
search for Scanning an image in the Search field of the Help menu.

4 Adjust the scan settings as needed.

Note: Use a scan resolution of 300 dpi or more.

If applicable, click ?  on the preview dialog for more information.

5 Set the OCR software as the scan destination, and then start the scan job.

6 If necessary, select the format to which you want to convert the file.

7 Save the file.

Note: Depending on your settings, the file may open immediately in the appropriate application so you can start
editing.

Scanning directly to e‑mail using the printer software
Make sure you have set up your e‑mail settings before proceeding. For more information, see the section on e‑mailing
in the User’s Guide.

For Windows users

1 Load an original document faceup into the ADF or facedown on the scanner glass.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > Scan

5 Select Email photo, Email document, or Email PDF.

Note: You can select Email document only if an OCR application is stored on your computer.

Scanning starts and the scan progress dialog appears. When the scan is finished, a new e‑mail message is created
with the scanned document automatically attached.

6 Compose your e‑mail message.

Note: If your e-mail program does not open automatically, then you can scan the document to the computer and
then send it through e-mail as an attachment.
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For Macintosh users

1 Load an original document faceup into the ADF or facedown on the scanner glass.

2 From the Applications folder in the Finder, launch the application you want to use.

Note: Use any application that supports both your printer and an e‑mailing option, such as Image Capture.

3 From the list of devices, select your printer.

Note: For information on finding the list of devices, check the documentation that came with the application, or
search for Scanning an image in the Search field of the Help menu.

4 Adjust the scan settings as needed.

If applicable, click ?  on the preview dialog for more information.

5 Set the e‑mail application as the scan destination, and then start the scan job.

6 Compose your e‑mail message.

Scanning to a PDF

For Windows users

1 Load an original document faceup into the ADF or facedown on the scanner glass.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > Scan > PDF

Scanning starts and the scan progress dialog appears.

5 Save the document as a PDF.

For Macintosh users

1 Load an original document faceup into the ADF or facedown on the scanner glass.

2 From the Applications folder in the Finder, launch the application you want to use.

Note: Use any application that supports your printer.

3 From the list of devices, select your printer.

Note: For information on finding the list of devices, check the documentation that came with the application or
search for Scanning an image in the Search field of the Help menu.

4 Adjust the scan settings as needed.

If applicable, click ?  on the preview dialog for more information.

5 Set the application that supports the PDF format as the scan destination, and then start the scan job.

6 Save the document as a PDF.
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Scanning FAQ

How can I improve the quality of a scan?
• Make sure your original documents are in good condition.

• Make sure the application that receives the scanned document is appropriate. For example, if you are scanning a
photo to edit it, then make sure you choose a photo editing application to receive the scan. If you are scanning a
document to edit the text, then make sure you choose an OCR application.

• Use either of the following high resolutions:

– 300 dpi for photos

– 600 dpi for text and graphic documents

How can I adjust the color of a scan?
From the scan options menu, do the following:

• Select the Content Type option that describes the original document.

• Select the Content Source or Original Type option that describes how the original document was produced.

How do I scan in black and white?
Color is the default for all scans. To scan in black and white, press  on the printer control panel.

Why am I being asked for a PIN?
PINs are a security measure used to restrict the scanned information from going into certain locations, or to keep what
is being scanned from being seen or used by others. You may be prompted to enter a PIN if the network computer you
are scanning to requires one.

To learn how PINs get assigned to network computers, see the Help for the printer software associated with your
operating system.

Canceling scan jobs
Do one or more of the following:

• From the printer control panel, press , and then press OK .

Scanning stops and the printer returns to the previous menu.

• If you are sending the scan job using the printer software, then cancel the scan job from the software dialog.
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E-mailing
You can use your printer to send e-mail to one or more recipients without using a computer provided you have set up
the scan to e-mail task through shortcuts. For more information, see the section on shortcuts in the User's Guide.

Before you can send e-mail using the printer control panel, you must first configure the network connection and e-mail
settings of your printer.

Setting up the printer to e-mail

Setting up the e-mail function

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Settings > Set up the printer to e‑mail

The E‑mail Setup Wizard opens.

4 Follow the instructions on the computer screen.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder > Printer Settings > Email

2 Follow the instructions on the computer screen, and then click Save Settings.

Configuring e‑mail settings
1 Type the printer IP address into the address field of your Web browser.

If you do not know the IP address of the printer, you can:

• View the IP address on the printer control panel in the TCP/IP section under the Networks/Ports menu.

• Print a network setup page or the menu settings pages and locate the IP address in the TCP/IP section.

2 Click Settings > E-mail/FTP Settings > E-mail Settings.

3 Fill in the fields with the appropriate information.

4 Click Submit.
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Creating an e-mail contact list

Creating an e‑mail contact list using the computer

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Fax > Edit contact list > Select from phone book

4 From the Phone Book field, select a phone book.

You can select any mail client phone book where you store e‑mail addresses.

5 Select the contact that you want to add, and then click Add to or change list to import the contact.

6 Click OK.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder

2 Double‑click Printer Settings.

3 Navigate to:

Contacts tab > Individuals tab

4 Click  to open the Address Book.

Note: To add contacts, you need to import contacts from the Address Book on your Macintosh computer. If the
contact is not in the Mac Address Book, then first add the contact to the address book and then import it.

5 From the Address Book, click and drag the contacts that you want to add to the Contacts list.

For more information, click Help or ?  to view the help information for the fax software.
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Sending e-mail
ADF Scanner glass

Use the ADF for multiple‑page documents.

Note: The ADF is available only in select printer models. If you
purchased a printer without an ADF, then load original
documents or photos on the scanner glass.

Use the scanner glass for single pages, small items (such
as postcards or photos), transparencies, photo paper, or
thin media (such as magazine clippings).

Tips for e‑mailing
• Make sure to enter your e‑mail account information and set up the SMTP server before sending an e‑mail.

• Make sure the printer is connected to an Ethernet or wireless network before sending an e‑mail.

If necessary, make sure the network is connected to the Internet for the printer to communicate with the SMTP
server. If the printer cannot connect to the Internet, then contact your system support person.

The printer supports only one active network connection (Ethernet or wireless) at a time.

• Add contacts to your address book. When sending an e‑mail, you can just select contacts from your address book
instead of typing their e‑mail addresses repeatedly.

• Use the ADF when scanning two‑sided pages if your printer supports duplex scanning and the ADF supports the
original document size.

• Use the scanner glass when scanning two‑sided pages if your printer does not support duplex scanning or the ADF
does not support the original document size.

• When using the ADF, adjust the paper guides on the ADF to the width of the original document.

• To easily retrieve a document after copying or scanning, lift the ADF input tray.

• When using the scanner glass, close the scanner cover, if possible, to avoid dark edges on the scanned image.

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF. Place these items on the scanner glass.

• When the document to be e-mailed is in place with the settings you want, press  to start scanning.
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Canceling an e‑mail
Do one or more of the following:

• From the printer control panel, press , and then press OK .

• If you are sending the e‑mail using the printer software, then cancel the e-mail from the software dialog.

E-mailing 75



Faxing
CAUTION—POTENTIAL INJURY: To reduce risk of fire, use only the telecommunications (RJ‑11) cord provided
with this product or a UL Listed 26 AWG or larger replacement when connecting this product to the public
switched telephone network.

CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.

Setting up the printer to fax

Scenario 1: Standard telephone line

Setup 1: Printer is connected to a dedicated fax line

To connect:

Connect the cable from the wall jack to the  port of the printer.

Tips for this setup:

• You can set the printer to receive faxes automatically (Auto Answer On) or manually (Auto Answer Off).

• If you want to receive faxes automatically (Auto Answer On), then set the printer to pick up on any number of rings
that you want.
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Setup 2: Printer is sharing the line with an answering machine

Connected to the same telephone wall jack

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the answering machine to the port.

Connected to different wall jacks
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To connect:

Connect the cable from the wall jack to the  port of the printer.

Tips for this setup:

• If you have only one telephone number on your line, then you need to set the printer to receive faxes automatically
(Auto Answer On).

• Set the printer to pick up calls two rings after the answering machine. For example, if the answering machine picks
up calls after four rings, then set the printer to pick up after six rings. This way, the answering machine picks up
calls first and your voice calls are received. If the call is a fax, then the printer detects the fax signal on the line and
takes over the call.

• If you subscribe to a distinctive ring service provided by your telephone company, then make sure that you set the
correct ring pattern for the printer. Otherwise, the printer will not receive faxes even if you have set it to receive
faxes automatically.

Setup 3: Printer is sharing the line with a telephone subscribed to voice mail service

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.
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Tips for this setup:

• This setup works best if you subscribe to a distinctive ring service. If you have distinctive ring service, then make
sure that you set the correct ring pattern for the printer. Otherwise, the printer will not receive faxes even if you
have set it to receive faxes automatically.

• If you have only one telephone number on your line, then you need to set the printer to receive faxes manually
(Auto Answer Off).

When you answer the telephone and you hear fax tones, press *9* or the manual answer code on the telephone
to receive the fax.

• You can also set the printer to receive faxes automatically (Auto Answer On), but you need to turn off the voice
mail service when you are expecting a fax. This setting works best if you are using voice mail more often than fax.

Scenario 2: Digital Subscriber Line (DSL)

A Digital Subscriber Line splits your regular telephone line into two channels: voice and Internet. Telephone and fax
signals travel through the voice channel, and Internet signals pass through the other channel. This way, you can use
the same line for analog voice calls (including faxes) and digital Internet access.

To minimize interference between the two channels and ensure a quality connection, you need to install a DSL filter
for the analog devices (fax machine, telephone, answering machine) in your network. Interference causes noise and
static on the telephone, failed and poor quality faxes for the printer, and slow Internet connection on your computer.
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To install a filter for the printer:

1 Connect the line port of the DSL filter to the wall jack.

2 Connect a telephone cable from the  port on the back of the printer to the phone port on the DSL filter.

3 To continue using a computer for Internet access, connect the computer to the DSL HPN port on the DSL filter.

4 To connect a telephone to the printer, remove the protective plug from the  port of the printer and then connect
the telephone to the port.

Scenario 3: VoIP telephone service

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port on the VoIP adapter.

The port labeled Phone Line 2 or Fax Port is not always active. You may need to pay extra to your VoIP provider if
you want to activate the second phone port.

3 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.
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Tips for this setup:

• To make sure that the phone port on the VoIP adapter is active, plug an analog telephone into the phone port, and
then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two phone ports for your devices but do not want to pay extra, then do not plug the printer into the
second phone port. You can use a phone splitter. Plug the phone splitter into the Phone Line 1 or Phone Port, and
then plug the printer and telephone into the splitter.

Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct splitter, plug an
analog telephone into the splitter and then listen for a dial tone.

Scenario 4: Digital telephone service through a cable provider

Setup 1: Printer is connected directly to a cable modem

Follow this setup if you normally connect your telephone to a cable modem.

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port on the cable modem.

The port labeled Phone Line 2 or Fax Port is not always active. You may need to pay extra to your cable provider if
you want to activate the second phone port.

3 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.

Faxing 81



Tips for this setup:

• To make sure that the phone port on the cable modem is active, plug an analog telephone into the phone port, and
then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two phone ports for your devices but do not want to pay extra, then do not plug the printer into the
second phone port. You can use a phone splitter. Plug the phone splitter into the Phone Line 1 or Phone Port , and
then plug the printer and telephone into the splitter.

Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct splitter, plug an
analog telephone into the splitter and then listen for a dial tone.

Setup 2: Printer is connected to a wall jack; cable modem is installed elsewhere in the house

Follow this setup if your cable provider activated the wall jacks in your house so that you do not have to plug your
devices into the cable modem. Your cable telephone service comes from the wall jacks.

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.
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Scenario 5: Country‑ or region‑specific setup
Different countries or regions have different types of telephone wall jacks. The standard wall jack adopted by most
countries or regions is the Registered Jack-11 (RJ-11). You need to have an RJ‑11 plug, or a telephone cable that has an
RJ‑11 connector, so you can connect a device to an RJ‑11 wall jack.

The fax ports on the back of the printer and the telephone cable that comes with the printer have RJ‑11 connectors. If
you have a different type of connector in your country or region, then you may need to use an RJ‑11 adapter.

Connecting the printer to a non‑RJ‑11 wall jack

EXT

LINE

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the RJ‑11 adapter, and then connect the adapter to the wall jack.
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3 If you want to connect another device (telephone or answering machine) to the same wall jack, and if the device
has a non‑RJ 11 connector, then connect it directly to the wall jack.

Notes:

• Do not remove the wrap plug from the  port of the printer.

• The printer may not come with an RJ-11 adapter in your country or region.

If the additional device (telephone or answering machine) has an RJ-11 connector, then you can remove the wrap plug
and connect the device to the  port of the printer.

Connecting the printer in countries or regions that use serial connection

In some countries or regions, you need to plug all devices into the wall jack. You cannot plug a telephone or answering
machine into the  port of the printer. This is called serial connection.

Austria Germany Portugal

Belgium Ireland Spain

Denmark Italy Sweden

France Netherlands Switzerland

Finland Norway United Kingdom

Warning—Potential Damage: If your country or region is on the list, then do not remove the wrap plug from the 
port of the printer. It is necessary for the proper functioning of the devices on the telephone line.
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EXT

LINE

To connect:

Connect the cable from the wall jack to the  port of the printer.

Connecting the printer to a wall jack in Germany

The German wall jack has two kinds of ports. The N ports are for fax machines, modems, and answering machines. The
F port is for telephones.

N F N
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Connect the printer to any of the N ports.

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the RJ‑11 adapter, and then connect the adapter to an N port.

3 If you want to connect a telephone and answering machine to the same wall jack, then connect the devices as
shown.

Entering your user information
Your user information includes your name or your company name, your fax number (which is your telephone number,
unless you have a dedicated fax telephone line), and the time and date on your fax machine when a transmission is
made. This information appears in the header and footer of the faxes that you send.

In some countries, you cannot send a fax without this information. Some fax machines block faxes without sender
information, so make sure that you enter this information in your printer.

Setting the fax header

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Fax Name > OK

2 Enter your name or your company name, and then press OK .

• To change a character, press the left arrow button.

• To add a space, press the number 0.
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3 Press the arrow buttons to scroll to Fax Number, and then press OK .

4 Enter your fax number or your telephone number, and then press OK .

Setting the fax footer
From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Fax Footer > OK  > On > OK

Setting the date and time

1 From the printer control panel, navigate to:

 > Setup > OK  > Device Setup > OK  > Date/Time > OK

2 Enter the date, and then press OK .

3 Enter the time, and then press OK .

Configuring the fax settings
You can configure the fax settings through the printer control panel or the computer through the Printer Setup Utility.
If you configure the fax settings through the printer control panel, then the Printer Setup Utility imports those settings.
The changes appear the next time you launch the Printer Setup Utility. The printer also saves the settings that you
select in the utility, unless you set the printer to block changes made from the computer.

Configuring fax settings using the printer control panel
1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK

2 Configure the fax settings using the selections in the menu:

From here You can

Address Book Set up, view, or print the Address Book.

Fax Reports • Print activity logs. Activity logs let you view the sent and received
fax history of your printer.

• Print confirmation pages or transmission reports. These reports
let you know if the faxes that you send are sent successfully.
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From here You can

Ringing and Answering • Set the printer to receive faxes automatically or manually. Turn
Auto Answer to On or Off.

• Adjust the ringing volume.

• Set the number of rings. This is important if you choose to receive
faxes automatically (Auto Answer On).

• Set the distinctive ring. If you subscribe to the distinctive ring
feature on your telephone line, then set the correct pattern for
the printer in this menu.

• Enable fax forwarding.

• Set a manual answer code. This is the code you press to receive
faxes manually.

• Set the Caller ID pattern that you want. Some countries or
regions have multiple patterns.

• Set the printer to fit incoming faxes into a page when printing.

• Set the fax footer.

2‑Sided Faxes • Set the printer to print incoming faxes on both sides of the paper.

Dialing and Sending • Set your fax name and fax number.

• Adjust the dialing volume.

• Set the dial method, redial time, number of redial attempts,
dialing prefix, and fax sending speed.

• Convert sent faxes into modes that receiving fax machines
recognize. Otherwise, such faxes are aborted.

• Enable error correction during transmission.

Fax Blocking Block unwanted incoming faxes.

Configuring fax settings using the fax software
Before you begin, make sure that:

• The printer is properly connected to the telephone line.

• The printer is turned on and connected to the computer.

• The printer is not in Sleep mode. If the printer is in Sleep mode, then press  to wake up the printer.

Using the Fax Setup Wizard in Windows

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Click Printer Home > Fax > Set up the printer to fax.

The Fax Setup Wizard opens.

4 Run the Fax Setup Wizard. Make sure you select the correct telephone service and connection. The wizard configures
optimal fax settings based on your connection.

Note: If you want to configure the advanced fax settings, then from the Printer Home, click Fax > Configure the
advanced fax settings. This launches the Printer Setup Utility.
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Using the Printer Settings in Macintosh

1 From the Applications folder in the Finder, or from the Finder desktop, double-click the printer folder.

2 Double-click Printer Settings.

3 Configure the fax settings using the printer software.

To view the help information for the fax software, click Help or ? .

Creating a contact list
You can create a contact list using the Address Book in the printer control panel or the computer through the Phone
Book. If you create a contact list in the printer control panel, then the Phone Book automatically saves those contacts
as Phone Book entries. Likewise, when you add contacts to the Phone Book, the printer automatically saves them to
the printer Address Book.

You can save up to 89 contacts and 10 fax groups in the contact list.

Creating a contact list using the printer control panel
1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Address Book > OK

2 To add a fax number to your Address Book:

a Press the arrow buttons to scroll to Add Entry, and then press OK .

b Use the keypad to enter the contact name in the Name field.

• To change a character, press the left arrow button.

• To add a space, press the number 0.

c Press the up or down arrow button to move the cursor to the Number field.

d Use the keypad to enter the fax number in the Number field, and then press OK  to save the entry.

e If you want to add another entry, then repeat steps a through d.

3 To add a fax group:

a Press the arrow buttons to scroll to Add Group, and then press OK .

b Use the keypad to enter a group name, and then press OK .

• To change a character, press the left arrow button.

• To add a space, press the number 0.

c Press the arrow buttons to select whether you want to add a contact manually or import a contact. Press OK

when you make a selection.

• If you want to add a contact manually, then use the keypad to enter the fax number, and then press OK .

• If you want to import a contact, then press the arrow buttons to select a contact from the Address Book.
Press OK  when you make a selection.

d When you are finished adding contacts to the group, select Done.
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Creating a contact list using the fax software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Fax > Edit contact list

The Contacts tab of the Printer Setup Utility opens.

4 Click Select from phone book.

5 From the Phone Book field, select a phone book.

6 Select the contact that you want to add, and then click Add to or change list to import the contact.

Note: To add contacts, you need to import contacts from the phone books on your computer that are supported
by the fax software. In addition to the software Address Book, you may also have phone books of the mail
clients installed on your computer, such as Microsoft Outlook.

7 Click OK.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder

2 Double‑click Printer Settings.

3 Click the Contacts tab.

• To add contacts, click the Individuals tab.

• To add fax groups, click the Groups tab.

4 Click  to open the Address Book.

Note: To add contacts, you need to import contacts from the Address Book on your Macintosh computer. If the
contact is not in the Mac Address Book, then first add the contact to the address book, and then import it.

5 From the Address Book, click and drag the contacts that you want to add to the Contacts list.

For more information, click Help or ?  to view the help information for the fax software.
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Sending faxes
ADF Scanner glass

Use the ADF for multiple‑page documents.

Note: The ADF is available only in select printer models. If you
purchased a printer without an ADF, then load original
documents or photos on the scanner glass.

Use the scanner glass for single pages, small items (such
as postcards or photos), transparencies, photo paper, or
thin media (such as magazine clippings).

Tips for sending faxes
• Make sure the printer is on and connected to a working telephone, DSL, or VoIP line. The line is working if you hear

a dial tone.

• Make sure the paper exit tray is fully extended and the tray extension is flipped out.

• Depending on your printer model, use the ADF when scanning two‑sided (duplex) pages.

• To easily retrieve a document after copying or scanning, lift the ADF input tray.

• When using the ADF, adjust the paper guide on the ADF to the width of the original document.

• When using the scanner glass, close the scanner cover, if possible, to avoid dark edges on the scanned image.

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF. Place these items on the scanner glass.

• When the document to be faxed is in place with the settings you want, press  to send the fax.

Sending faxes using the printer control panel
1 From the printer control panel, navigate to:

 > Fax

2 Enter a fax number, or press Address Book to select a number from the Speed Dial or Group Dial list.

3 If you want to send a fax to a single recipient, then press OK .

If you want to send a fax to a group of numbers (broadcast fax), then press the left or right arrow button to enter
another number, and then press OK . Repeat this step to add more numbers.
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4 Press the Color/Black button to select a color or black‑and‑white fax.

5 Press  to start the fax job.

Warning—Potential Damage: Do not touch the cables or the  and  ports while actively sending a fax.

Tip:

• You can send a broadcast fax to up to 30 recipients.

Sending faxes using the computer

For Windows users

1 With a document open, click File > Print.

2 Make sure to select the fax version of your printer, and then click Properties, Preferences, Options, or Setup.

3 Click the Fax tab, and then make sure Enable Fax is selected.

4 Enter the recipient fax number or numbers in the “Fax number(s)” field.

You can enter fax numbers manually or by using the Phone Book feature.

5 If necessary, enter a prefix in the Dialing Prefix dialog.

6 Select the appropriate paper size and page orientation.

7 Select Include Cover Page with Fax, and enter the appropriate information if you want to include a cover page with
the fax.

8 Click OK.

For Macintosh users

1 With a document open, choose File > Print.

2 From the Printer pop‑up menu, select the fax version of your printer.

Note: In order to see the fax options on the Print dialog, you must use the fax driver for your printer. If the fax
version of the printer is not on the list, then choose Add a printer, and then choose the fax version of the
printer.

3 Enter the name and number of the recipient.

4 Click Fax.

Receiving faxes

Tips for receiving faxes
When receiving faxes:

• Make sure that the printer is on and connected to a working telephone, DSL, or VoIP line. The line is working if you
hear a dial tone.

• If you set the printer to receive faxes manually (Auto Answer Off), then make sure that the ringer volume is not set
to Off.
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• If you have set the printer to receive faxes automatically (Auto Answer On), then load paper in the printer.

Receiving faxes automatically
1 Make sure that Auto Answer is on:

From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Auto Answer > OK  > On > OK

2 Set the number of rings before the printer picks up incoming faxes:

a Press the arrow buttons to scroll to Pick Up On, and then press OK .

b Press the arrow buttons to scroll to the number of rings that you want, and then press OK  to save the setting.

When the number of rings you set is detected, the printer automatically receives the incoming fax.

Warning—Potential Damage: Do not touch the cables or the  and  ports while actively receiving a fax.

Tips:

• If the printer is sharing the line with other analog devices (telephone, answering machine), then set the printer to
pick up calls two rings after the answering machine. For example, if the answering machine picks up calls after four
rings, then set the printer to pick up after six rings. This way, the answering machine picks up calls first and your
voice calls are received. If the call is a fax, then the printer detects the fax signal on the line and takes over the call.
If the printer is on a dedicated fax line, then you may set the printer to pick up on any number of rings.

• If you have multiple numbers on a single line, or if you subscribe to a distinctive ring service provided by your
telephone company, then make sure that you set the correct ring pattern for the printer. Otherwise, the printer
will not receive faxes even if you have set it to receive faxes automatically.

Receiving faxes manually
1 Turn off Auto Answer:

From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Auto Answer > OK  > Off > OK

2 When the telephone rings and you hear fax tones when you pick up the handset, press  on the printer or *9* on
the telephone attached to the printer.

Warning—Potential Damage: Do not touch the cables or the  and  ports while actively receiving a fax.

Tips:

• The default code for answering faxes manually is *9*, but for increased security, you can change it to a number
that only you know. You can enter up to 7 characters for your code. The valid characters are the digits 0–9 and the
characters # and *.

• Make sure that the telephone is plugged into the  port on the back of the printer and that the printer is connected
to the wall jack through the  port.
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Faxing FAQ

If I skipped the fax setup initially, do I need to run the installer again to set up the
fax?
You do not need to run the installer again. You can set up and configure the fax through the fax software that was
installed with the printer software.

1 Connect the printer to the telephone line. For more information, see “Setting up the printer to fax” on page 76.

2 Configure the fax settings using the fax software. To access the fax software:

For Windows users

a Click  or Start.

b Click All Programs or Programs, and then select the printer program folder from the list.

c Click Printer Home > Fax  >Set up the printer to fax.
The Fax Setup Wizard opens.

d Run the wizard. Make sure you select the correct telephone service and connection. The wizard configures
optimal fax settings based on your connection.

For Macintosh users

a From the Applications folder in the Finder, or from the Finder desktop, double-click the printer folder.

b Double-click Printer Settings, and then configure the fax settings.

What is a splitter and what type of splitter should I use?
If there are limited wall jacks in your home or limited ports on your adapter, then you can use a phone splitter. A splitter
splits the telephone signal and allows you to connect multiple devices to the wall jack. It has two or more ports where
you can plug the devices. Do not use a line splitter.

To make sure that you are using the correct splitter, plug an analog telephone into the splitter and then listen for a dial
tone.

What is my fax number?
In most cases, your telephone number is also your fax number. If you subscribe to the Distinctive Ring Pattern Detection
(DRPD) service offered by telephone companies, then your fax number is the number that you assigned to the printer.
Make sure that you enter the correct distinctive ring pattern for that number in the fax software or in the Fax Setup
menu of the printer control panel.

If you have more than one telephone line, then make sure that you enter the number for the line on which the printer
is connected.
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What is my dialing prefix?
The dialing prefix is the number or series of numbers that you press before you can dial the actual fax number or
telephone number. If the printer is in an office setting or in a private branch exchange, then this can be a specific number
that you need to press so you can make a call outside the office. This can also be a country code or an area code that
you need to enter if you are sending faxes outside of town. This can be very useful if you frequently send faxes to the
same country or area. When you set the dialing prefix in the utility, the printer automatically inputs the prefix when
you dial the fax number or telephone number.

You can enter up to 8 characters as your dialing prefix. The valid characters are the numbers 0–9, the letters P and W
(uppercase and lowercase), and the characters pound (#) and star (*). If you are using the fax software to enter the dial
prefix, then you may also include the characters minus and comma.

Notes:

• Some of these characters may not be available, depending on the printer you purchased.

• Characters may vary depending on whether you are using the printer control panel or the computer keyboard.

When do I need to set Auto Answer to On?
Auto Answer is set to On by default, which lets the printer receive faxes automatically.

If the printer is connected to the same telephone line with an answering machine, then you must set Auto Answer to
On so that you can receive both your voice calls and your faxes. Make sure that the answering machine is set to pick
up on fewer rings than the rings set in the printer. This lets the other devices pick up the voice calls first. If an incoming
call is a fax, the printer can detect fax signals on the line and takes the call.

How many rings should I set?
If the printer is sharing a line with an answering machine, then set the printer to pick up after a greater number of rings
than the answering machine. For example, if the answering machine picks up calls after four rings, then set the printer
to pick up after six rings. This way, the answering machine picks up calls first and your voice calls are received. If the
call is a fax, then the printer detects the fax signal on the line and takes over the call.

If the printer is on a dedicated fax line, then you may set the printer to pick up on any number of rings that you want.

How do I set the distinctive ring for the printer?
Setting the correct ring is important if you subscribe to the Distinctive Ring Pattern Detection (DRPD) feature offered
by telephone companies. This feature allows you to have multiple telephone numbers on one telephone line. Each
telephone number has a designated ring pattern (All Rings, Single Ring Only, Double Ring Only, Triple Ring Only, Single
or Double Rings Only, Single or Triple Rings Only, Double or Triple Rings Only). The different ring patterns let you know
what telephone number was dialed, and what device you should use to answer the call.

Assign one of your telephone numbers to the printer as the fax number, and then set the printer to answer the ring
pattern of that number. If the pattern is set incorrectly, then the printer rings, but it never receives the fax.

Distinctive Ring is also called Ident-a-Call, Smart Ring, Teen Ring, RingMaster, or IdentaRing.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Ring Pattern > OK

2 Press the arrow buttons to scroll to the ring pattern you want, and then press OK .
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How can I check the dial tone?
A dial tone lets you know if the telephone line is working or if the printer is properly connected to the telephone line.
If you encounter problems sending and receiving faxes, then make sure you can hear a dial tone on the line and through
the printer.

Make sure the telephone line and the wall jack are working

1 Plug an analog telephone into the wall jack.

2 Listen for a dial tone through the telephone handset.

If you hear a dial tone, then the telephone line and the wall jack are working.

If you do not hear a dial tone, plug the analog telephone into a second wall jack, and then listen for a dial tone. If
you hear a dial tone, then the telephone line is working but the first wall jack is not working.

Make sure the printer is connected properly to the telephone line

1 While the printer is connected to a telephone line through the  port on the back of the printer, plug an analog
telephone into the  port of the printer.

2 Listen for a dial tone.

If you hear a dial tone, then the telephone line is working and properly connected to the printer.

If you do not hear a dial tone through both the wall jack and the printer, then see the “Fax troubleshooting checklist”
on page 156.

How do I adjust the speaker volume on the printer?
Listen to the dial tone to check if the telephone line is working and to check if the cables and devices are connected
properly in your telephone network. If you set the printer to receive faxes manually, then make sure that you set the
ringer volume loud enough for you to hear it.

Adjusting the dialing volume

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Speaker Volume > OK

2 Press the up or down arrow buttons to select a dial volume setting, and then press OK .

Adjusting the ringer volume

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Ringer Volume > OK

2 Press the up or down arrow buttons to select a ringer volume setting, and then press OK .
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How can I make sure that fax calls go to the printer and voice calls go to the
answering machine?
To make sure the printer picks up incoming faxes, set Auto Answer to On, and then set the printer to pick up after a
greater number of rings than the answering machine. For example, if the answering machine picks up calls after four
rings, then set the printer to pick up after six rings. This way, the answering machine picks up calls first and your voice
calls are received. If the call is a fax, then the printer detects the fax signal on the line and takes over the call.

What settings work best with voice mail service?
Voice mail and fax can share the same telephone line if you subscribe to a distinctive ring service offered by your
telephone company. This feature allows you to have multiple telephone numbers on one telephone line. Each telephone
number has a designated ring pattern (All Rings, Single Ring Only, Double Ring Only, Triple Ring Only, Single or Double
Rings Only, Single or Triple Rings Only, Double or Triple Rings Only). The different ring patterns let you know which
telephone number was dialed, and which device you should use to answer the call.

If you do not have distinctive ring service, then set the printer to receive faxes manually (Auto Answer Off). This setting
lets you receive both voice calls and fax calls, but works best if you use voice mail more often. You need to turn off
voice mail whenever you are expecting a fax.

How do I change the resolution of the documents that I fax?
The resolution, or fax quality, of the documents that you send may affect fax transmission. The receiving fax machine
may not support high resolutions and may not be able to receive your fax. You can fix this by enabling Auto Fax
Conversion, but the automatic conversion may result in an unreadable fax, especially if the original document is already
blurred.

Choose a fax quality that best suits the capacity of the receiving fax machine and the quality of the original document.

Quality Black resolution Color resolution

Standard 200 x 100 200 x 200

Fine 200 x 200 200 x 200

Superfine 300 x 300 200 x 200

Ultrafine 300 x 300 (half‑toned) 200 x 200

When sending a fax, after entering the fax number, press the arrow buttons to select a fax quality, and then
press OK .

How do I send a fax at a scheduled time?
1 From the printer control panel, navigate to:

 > Fax

2 Enter the fax number of the recipient, or press Address Book to select a number from the Speed Dial or Group Dial
list.

3 Press the arrow buttons to scroll to Schedule Fax.
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4 Enter the time you want to send the fax, and then press OK .

5 Press  to start scanning the document and to save the scheduled fax.

The printer sends the fax at the designated time. Do not turn off the printer or unplug it from the telephone line
before the scheduled time.

How do I send a fax using a phone calling card?
1 Press Dial tone.

You should hear the dial tone of the telephone line.

2 Enter the calling card information, and then when you are connected to the telephone carrier, follow the prompts.

3 When prompted, enter the fax number of the recipient, and then press .

How do I know that the fax was sent successfully?
You can set the printer to print a confirmation page, or transmission report, every time you send a fax. This report
includes the date and time that the fax was sent. If the fax job is unsuccessful, then the report also includes the cause
of the error.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Fax Reports > OK  > Transmission Log Printing > OK

2 Press the arrow buttons to select a report printing option:

• If you want to print a report every time you send a fax, then select Print Log.

• If you do not want to print the report, then select Do not print log.

• If you want to save on ink and print a report only when a fax job is unsuccessful, then select Print only for error.

3 Press OK .

How do I print the fax history of the printer?
You can print reports of sent or received faxes, or both.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Fax Reports > OK

2 Press the arrow buttons to select a report printing option:

• If you want to print the log of all sent or received fax activity, then select Print Job Log.

• If you want to print the log of all calls to and from your printer, then select Print Call Log.
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How do I print a fax on both sides of the paper?
1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > 2‑Sided Faxes > OK

2 Press the arrow buttons to select a setting:

• Never—Incoming faxes are never printed on both sides of the paper regardless of the 2‑sided button setting.

• Always—Incoming faxes are always printed on both sides of the paper regardless of the 2‑sided button setting.

3 Press OK .

How do I forward a fax?
1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Fax Forward > OK

2 Press the arrow buttons to scroll to Forward or Print & Forward, and then press OK .

3 Using the keypad, enter the number to which you want to forward the fax, and then press OK .

When you enable this option, all the faxes that you receive are automatically forwarded until you disable it.

To disable fax forwarding, return to the Fax Forward menu, and then select Off.

Can I block faxes?
You can block faxes from specific numbers. You can also block junk faxes and faxes from unidentified senders (senders
without a Caller ID). This feature is helpful if you want to receive faxes automatically but want to filter the faxes that
you receive.

1 Turn on fax blocking.

From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Fax Blocking > OK  > Turn On/Off > OK  > On > OK

2 Add a number to block.

a Press the arrow buttons to scroll to Add, and then press OK .

b Use the keypad to enter the name of the person you want to block.

c Press the down arrow button to move the cursor to the Number field.

d Use the keypad to enter the fax number, and then press OK  .

e Repeat steps 2b through 2d until you have added all the numbers that you want to block. You can block up to
50 numbers.

3 Block unidentified faxes (faxes without a Caller ID number).

a Press the arrow buttons to scroll to Block No ID, and then press OK .

b Press the arrow buttons to scroll to On, and then press OK  to save the setting.
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Can I retrieve failed faxes?
The printer saves an incoming fax in the printer memory before it prints the fax. If the printer runs out of ink or runs
out of paper, then the printer will automatically print the fax after the error is resolved.

If a fax was not sent or received due to power loss, then the printer will automatically send any outgoing faxes or print
any incoming faxes that were saved in the printer memory when the power is restored.
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Networking

Installing the printer on a wireless network

Wireless network compatibility
Your printer may contain an IEEE 802.11b, IEEE 802.11g, or IEEE 802.11n wireless print server. Your printer is compatible
with IEEE 802.11 b/g/n routers that are Wi-Fi certified.

Note: If your printer has an IEEE 802.11g wireless print server and you are having issues with an n router, then verify
with your router manufacturer that the current mode setting is compatible with g devices, as this setting varies
depending on the router brand or model.

Supported network security options
The printer supports three wireless security options: WPA2/WPA, WEP, and no security.

WPA2/WPA

WPA (Wi-Fi Protected Access) and WPA2 (Wi-Fi Protected Access 2) offer stronger wireless network security than WEP.
WPA2 and WPA are similar types of security. WPA2 uses a more complex encryption method and is more secure than
WPA. Both WPA2 and WPA use a series of characters, called the WPA pre‑shared key or passphrase, to protect wireless
networks from unauthorized access.

WPA2/WPA passphrases must be:

• Exactly 64 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• From 8 to 63 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a keyboard.
ASCII characters in a WPA passphrase are case-sensitive.

Every device on the wireless network must use the same WPA passphrase. WPA security is an option only on
infrastructure networks with access points (wireless routers) and network cards that support WPA. Most newer wireless
network equipment also offer WPA2 security as an option.

Note: If your network uses WPA2 or WPA security, then select WPA Personal when you are prompted to select the
type of security your network uses.

WEP

WEP (Wired Equivalent Privacy) is the most basic and the weakest type of wireless security. WEP security relies on a
series of characters called the WEP key.

Every device on the wireless network must use the same WEP key. WEP security can be used on both ad hoc and
infrastructure networks.
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A valid WEP key has:

• Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a
keyboard.

No Security

It is not recommended to use no security at all on a home wireless network. Using no security means that anyone within
range of your wireless network can use your network resources—including Internet access— if your wireless network
is connected to the Internet. The range of your wireless network may extend far beyond the walls of your home, allowing
access to your network from the street or from your neighbors’ homes.

Printing a network setup page
A network setup page lists the configuration settings of the printer, including the IP address and MAC address of the
printer.

1 Load plain paper.

2 From the printer control panel, navigate to:

 > Setup > OK  > Network Setup > OK  > Print Network Setup Page > OK

Information you will need during wireless setup
To set up the printer for wireless printing, you need to know the following:

• The name of your wireless network, which is also known as the SSID (Service Set Identifier)

• If encryption was used to secure your network

• The security key (either a WEP key or WPA/WPA2 preshared key/passphrase)

To find the WPA/WPA2 preshared key/passphrase for the wireless network, see the documentation that came with
the access point (wireless router), see the Web page associated with the access point, or consult your system support
person.

If your access point is using WEP security, then the WEP key should be:

• Exactly 10 or 26 hexadecimal characters

or

• Exactly 5 or 13 ASCII characters

If your access point is using WPA or WPA2 security, then the WPA/WPA2 preshared key/passphrase should be:

• Exactly 64 hexadecimal characters

or

• From 8 to 63 ASCII characters

Notes:

• Hexadecimal characters are A–F, a–f, and 0–9.

• ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII characters in a WPA/WPA2
preshared key/passphrase are case‑sensitive.

Networking 102



If your wireless network is not using security, then you will not have a security key.

Note: If you do not know the SSID of the network that your computer is connected to, then launch the wireless
utility of the computer network adapter and look for the network name. If you cannot find the SSID or the security
information for your network, then see the documentation that came with the access point, or contact your system
support person.

Information you will need during advanced wireless setup
The Wireless Setup Utility does not detect the wireless network SSID for you during advanced wireless setup. You must
know the following information before configuring the wireless printer settings manually:

Wireless Mode

Check your wireless network type:
Infrastructure—All devices on a wireless network communicate with each other through an access point (wireless
router).
Ad Hoc—Network devices communicate directly with each other without the use of centralized security or access
point. Ad hoc mode may be available only in select printer models or operating systems.

Note: Infrastructure is the recommended network configuration because of its faster transfer speeds, better security
options, and ease of configuration.

Network Name (SSID)
This is the identifying name that distinguishes a network from other networks in the area.

Channel
Auto is selected by default and cannot be changed if the network is configured in infrastructure mode.

Notes:

• If the network is set up in ad hoc mode, then select the channel that other devices in the network are using.
All devices in an ad hoc network must use the same channel to communicate with each other.

• The printer can communicate on only one wireless network at a time. Configuring the printer for an ad hoc
wireless network will keep it from working on any other wireless network, either ad hoc or infrastructure.

Authentication
Determine if you have an infrastructure or ad hoc setup, and then check the corresponding authentication type.

Note: Some authentication types may be available only in select printer models or operating systems.

Wireless mode Authentication type

Infrastructure • Open Mode

• Shared Mode

• WPA Personal

• WPA2‑Personal

• WPA2‑Enterprise

• 802.1X ‑ RADIUS

Ad hoc Open Mode
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Encryption
Check the encryption method used on your network.

Note: Some authentication types may be available only in select printer models or operating systems.

Authentication type Encryption method

Open Mode • None

• WEP

Shared Mode WEP

WPA Personal TKIP

WPA2‑Personal • TKIP

• AES

WPA2‑Enterprise • TKIP

• AES

802.1X ‑ RADIUS • None

• WEP‑DynamicKeys

• WEP‑StaticKeys

• WPA‑TKIP

• WPA‑AES

Installing the printer on a wireless network
Before you begin, make sure that:

• Your wireless network is set up and working properly.

• The computer you are using is connected to the same wireless network where you want to set up the printer.

• You know the network name (SSID) and the WEP key or WPA/WPA2 preshared key/passphrase of the wireless
network you want to connect to.

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of your CD or DVD drive.

c Press Enter, or click OK.

3 Click Install, and then follow the instructions on the computer screen.

Note: Select Wireless connection when prompted to select a connection type.
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For Macintosh users

1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click the software installer package, and then follow the instructions on the computer screen.

Note: Select Wireless connection when prompted to select a connection type.

Installing the printer on other computers
When the printer is set up on the wireless network, it can be accessed wirelessly by any other computer on the network.
However, you will need to install the printer driver on every computer that will access it. You do not need to configure
the printer again, although you will need to run the setup software on each computer to install the driver.

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of your CD or DVD drive.

c Press Enter, or click OK.

3 Click Install, and then follow the instructions on the computer screen.

For Macintosh users

1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click the software installer package.

4 Select My printer is already set up. I am installing it on a new computer.

5 Click Continue, and then follow the instructions on the computer screen.

Determining the printer status using the network indicator light
The Wi‑Fi or Ethernet indicator light shows the network status of the printer.

Notes:

• The network indicator light is located on the printer control panel. The printer may have an Ethernet or a
wireless indicator light, or both, depending on your printer model. To find out if your printer has Ethernet or
wireless capability, see the Quick Reference Guide, or contact your system support person.

• The printer supports one local (USB) connection and one network connection (Ethernet or wireless) at a time. It
is not possible to use both Ethernet and wireless at the same time.
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Indicator light Printer status

Off • The printer is turned off or is powering up.

• The printer is not connected to an Ethernet or a wireless network and is in Sleep mode.

• The printer has not been configured for an Ethernet or a wireless network.

• The printer is configured for an ad hoc connection, but it is not currently communicating with another
ad hoc device.

Blinking green • The printer has been configured for an Ethernet network, but it cannot establish a connection with the
network.

• The printer is out of the range of the access point (wireless router).

• The printer is trying to communicate with the access point, but the access point is turned off or is not
working properly.

• The access point has been turned off, and then turned back on, and the printer is trying to establish a
connection with the network.

• The wireless settings of the printer may no longer be valid.

Check if the SSID, WEP key or WPA/WPA2 preshared key/passphrase, security type, and IP address that
the printer uses are still correct.

Solid green • The printer is connected to an Ethernet or a wireless network and is ready for use.

• The printer is connected to your computer or mobile device through an ad hoc connection.

Special wireless installation instructions
The following instructions apply to customers outside of North America who are using a wireless broadband box. Some
examples of these boxes include LiveBox, AliceBox, N9UF Box, Freebox, and Club Internet.

Before you begin

• Make sure your box is wireless‑enabled and activated to work on a wireless network. For more information about
configuring the box to work wirelessly, see the documentation that came with your box.

• Make sure your box is turned on and that your computer is on and connected to your wireless network.

Adding the printer to your wireless network

1 Set up your printer for wireless networking using the setup instructions provided.

Stop when you are prompted to select a network.

2 If there is an association/registration button on the back of your box, then press it before selecting a network.

Note: After pressing the association/registration button, you have five minutes to complete the printer
installation.

3 Return to the computer screen.

From the wireless networks list that appears, select your network, and then click Continue.

If your wireless network does not appear in the list, then:

a Connect to another wireless network.

For Windows users
Click Unlisted Network.
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For Macintosh users
Select Other Wireless Network from the list, and then click Continue.

b Enter the details about your wireless network.

Note: Your WEP, WPA, or WPA2 key may be obtained from the bottom of the box, the documentation that
came with the box, or from the box Web page. If you have already changed the key for your wireless
network, then use the key you created.

4 Follow the instructions on the computer screen to complete the installation.

Assigning a static IP address
The printer is automatically assigned an IP address through DHCP on most networks.

1 Complete the wireless or Ethernet setup, allowing the printer to receive a DHCP address from a DHCP server on
the network.

2 Print a network setup page to see the IP address currently assigned to the printer.

3 Open a Web browser, and then type the printer IP address in the address field. Press Enter.

Note: If you are using a proxy server, then temporarily disable it to load the Embedded Web Server correctly.

4 Click Settings > Network/Ports > TCP/IP > Set static IP address.

5 In the Address field, type the IP address you want to assign to the printer, and then click Submit.

To verify, type the static IP address in the Web browser address field, and then press Enter.

For more information, contact your system support person.

Changing wireless settings after installation
To change the wireless settings on the printer, such as the configured network and the security key, do the following:

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then navigate to:

Printer Home > Settings > Wireless setup utility

4 Follow the instructions on the computer screen.

For Macintosh users

1 From the Applications folder in the Finder, or from the Finder desktop, double-click the printer folder.

2 Double‑click Wireless Setup Assistant.

3 Follow the instructions on the computer screen.
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Advanced wireless setup

Adding a printer to an existing ad hoc wireless network
Before you begin, make sure:

• Your wireless network adapter is properly attached to your computer and is working.

• The ad hoc wireless network that the printer will connect to is available. For more information on creating an ad
hoc wireless network, see the documentation that came with your operating system.

Notes:

• The recommended way to set up your wireless network is to use an access point. This network setup is called
infrastructure network.

• If your computer has My WiFi or Wi-Fi Direct, then you can create direct connections to your wireless printer.
For more information, see the documentation that came with your computer.

• The printer can communicate on only one wireless network at a time. Configuring the printer for an ad hoc
wireless network will remove it from any other wireless network, either ad hoc or infrastructure, for which it is
configured.

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then navigate to:

Printer Home > Settings > Wireless setup utility

4 Follow the instructions on the computer screen.

Note: Windows Vista computers may need to be reconnected to the ad hoc network after restarting.

For Macintosh users

1 From the Applications folder in the Finder, or from the Finder desktop, double-click the printer folder.

2 Double‑click Wireless Setup Assistant.

3 Follow the instructions on the computer screen.
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Configuring Wi‑Fi Protected Setup manually
Note: Make sure your access point (wireless router) is Wi‑Fi Protected Setup (WPS) certified. For more information,
see the User’s Guide.

If your printer or device has not yet been configured for wireless connection and you want to configure it using WPS,
then push the WPS button on the wireless router. Wait for the printer control panel to display a message to begin WPS
configuration. There might be a short delay before the message appears. If nothing happens after 30 seconds, then do
one of the following:

USE THE PUSH BUTTON CONFIGURATION (PBC) METHOD

1 From the printer control panel, navigate to:

 > Setup > OK  > Network Setup > OK  > Wireless 802.11b/g/n > OK  > Network Connection Setup > OK  > Wireless >
OK  > Wi‑Fi Protected Setup > OK  > WPS PBC Mode > OK

2 Follow the instructions on the printer display.

USE THE PERSONAL IDENTIFICATION NUMBER (PIN) METHOD

1 From the printer control panel, navigate to:

 > Setup > OK  > Network Setup > OK  > Wireless 802.11b/g/n > OK  > Network Connection Setup > OK  > Wireless >
OK  > Wi‑Fi Protected Setup > OK  > WPS PIN Mode > OK

2 Follow the instructions on the printer display.

Configuring security
Simple wireless networks require WEP keys or a WPA/WPA2 preshared key/passphrase, or may not have any security
at all. More‑advanced wireless network security can require one or more certificates and an authentication server. If
the network requires a certificate and you do not have it, then fill out the certificate request form provided within the
Wireless Setup Utility and follow the procedure of your organization in requesting a certificate for network access.

The following is a list of supported types of wireless network security and their requirements:

WEP

• WEP key (up to four keys may be required)

• Default WEP Transmit Key (if more than one WEP key is configured, this specifies which one to use)

WPA Personal, WPA2‑Personal or WPA2‑Enterprise

• Preshared key

• Encryption (AES or TKIP)

EAP‑MD5, MSCHAPv2, or LEAP

• RADIUS user name

• RADIUS password
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PEAP

• RADIUS user name

• RADIUS password

• CA certificate

EAP‑TLS

• RADIUS user name

• CA certificate

• Signed certificate

EAP‑TTLS

• Appropriate inner authentication

• RADIUS user name

• RADIUS password

• CA certificate

Configuring 802.1X Authentication
The information to complete is dependent on the 802.1X security mechanism you select. Some require user names,
passwords, and/or certificates. If your network contains multiple access points with different modes of authentication,
then you can select and configure more than one authentication mechanism.

1 From the Configure 802.1X Authentication dialog, select an authentication mechanism.

If you have selected Do this

EAP‑MD5, LEAP, or
MSCHAPv2

Proceed to the next step.

PEAP or EAP‑TTLS Click Install CA Certificate, and then type the path to the CA certificate, or click Browse to
locate the certificate file.

EAP‑TLS a Click Install Signed Certificate, and then type the path to the signed certificate, or click
Browse to locate the certificate file.

b Click Install CA Certificate, and then type the path to the CA certificate, or click Browse
to locate the certificate file.

2 Type the necessary information that the authentication server requires.

3 Click OK, and then follow the instructions on the computer screen.

Installing the printer on an Ethernet network

Information you will need to set up the printer on an Ethernet network
Make sure you have the following information before you begin:

• A valid, unique IP address for the printer to use

• The gateway for the network
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• The network mask of the network where the printer will be used

• The name of the domain where the printer will reside

• The hostname of the printer

• Any security information required for authentication to the network

Note: Make sure you have an Ethernet cable to connect the printer to the network, and an available port, either on a
networking device or a wall jack, that physically connects the printer to the network.

Installing the printer on an Ethernet network
Before you install the printer on an Ethernet network, make sure that:

• You have completed the initial setup of the printer.

• Your network is set up and working properly.

• Your computer is connected to your network.

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of your CD or DVD drive.

c Press Enter, or click OK.

3 Click Install, and then follow the instructions on the computer screen.

Note: Select Ethernet connection when prompted to select a connection type.

For Macintosh users

1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click the software installer package.

4 Follow the instructions on the computer screen.

Note: Select Ethernet connection when prompted to select a connection type.
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Performing network management tasks

Switching between USB, Ethernet, and wireless connections (Windows only)
You can change the way you access your printer, depending on your needs. The following procedures assume that you
have configured your printer for one type of connection and that the printer drivers are installed on the computer. See
related topics on troubleshooting specific connection types if you encounter difficulties during configuration.

Note: The printer supports one active local (USB) connection and one active network connection (Ethernet or
wireless) at a time. It is not possible to connect the printer to both Ethernet and wireless networks at the same time.

Using the printer wirelessly

Select the connection type that describes how you currently access your printer:

If the printer is currently set up locally (using USB connection)

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then navigate to:

Printer Home > Settings > Wireless setup utility

4 Follow the instructions on the computer screen.

Note: There is no need to remove the USB cable connecting the printer to the computer during wireless
configuration.

If the printer is currently set up for Ethernet

1 Unplug the Ethernet cable from the printer.

2 Place the printer close to the computer you want to use to configure the printer for wireless access.

Note: You will need to connect the printer to the computer with a USB cable. Make sure the printer is close
enough to the computer for your USB cable to reach both.

3 Click  or Start.

4 Click All Programs or Programs, and then select the printer program folder from the list.

5 Select your printer, and then navigate to:

Printer Home > Settings > Wireless setup utility

6 Follow the instructions on the computer screen.

Using the printer locally (USB)

Select the connection type that describes how you currently access your printer:

If the printer is currently set up for Ethernet

1 Attach a USB cable to the computer and to the printer.

2 Wait a moment for Windows to locate the driver and finish setting up the printer.
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3 Select the USB printer. See “Selecting a printer” on page 113.

If the printer is currently set up for wireless

1 Attach a USB cable to the computer and to the printer.

2 Wait a moment for Windows to locate the driver and finish setting up the printer.

3 Select the USB printer. See “Selecting a printer” on page 113.

Note: You can continue to use the printer through Ethernet or wireless connection.

Using the printer over an Ethernet network

Select the connection type that describes how you currently access your printer:

If the printer is currently set up for wireless

1 Plug an Ethernet cable into the printer and into an available port on a switch or wall jack.

2 Wait one minute for the Ethernet network adapter to become active and acquire an IP address from the network.

3 Select the Network printer. See “Selecting a printer” on page 113.

Note: The wireless adapter of the printer is disabled while it is connected to an Ethernet network.

If the printer is currently set up locally (using USB connection)

1 Plug an Ethernet cable into the printer and into an available port on a switch or wall jack.

2 Insert the Software and Documentation CD into the computer you want to use to configure the printer.

3 Follow the instructions on the computer screen for configuring a printer on an Ethernet network.

4 Select the Network printer. See “Selecting a printer” on page 113.

Note: You will need a USB cable to complete the configuration.

Selecting a printer

1 Open the printers folder.

a Click  or Start.

b In the Start Search or Run box, type control printers.

c Press Enter, or click OK.

2 Right‑click the printer you want to use (Network or USB).

3 Select Set as Default Printer from the menu.

4 Close the “Printers” or “Printers and Faxes” window.
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Switching between USB, Ethernet, and wireless connections (Macintosh only)
You can change the way you access your printer depending on your needs. The following procedures assume that you
have configured your printer for one type of connection and that the drivers are installed on the computer. See related
topics on troubleshooting specific connection types if you encounter difficulties during configuration.

Note: The printer supports one active local connection (USB) and one active network connection (Ethernet or
wireless) at a time. It is not possible to connect to both Ethernet and wireless at the same time.

Using the printer wirelessly

Select the connection type that describes how you currently access your printer:

If the printer is currently set up locally (using USB connection)

1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double‑click Lexmark Extras > Lexmark Setup Assistant.

4 Follow the instructions on the computer screen.

Note: There is no need to remove the USB cable connecting the printer to the computer during wireless
configuration.

If the printer is currently set up for Ethernet

1 Unplug the Ethernet cable from the printer.

2 Place the printer close to the computer you want to use to configure the printer for wireless access.

Note: You will need to connect the printer to the computer with a USB cable. Make sure the printer is close
enough to the computer for your USB cable to reach both.

3 Close all open applications.

4 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

5 Double‑click Lexmark Extras > Lexmark Setup Assistant.

6 Follow the instructions on the computer screen.

7 A second print queue will be created. Remove the Ethernet queue if you do not want to switch back to accessing
the printer over an Ethernet connection.

Using the printer locally (USB)

Select the connection type that describes how you currently access your printer:

If the printer is currently set up for Ethernet

1 Firmly plug the square end of the USB cable into the back of the printer.

2 Firmly plug the rectangular end of the USB cable into the USB port of the computer.
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3 Add the printer (see “Add the printer” on page 115).

4 A second print queue will be created. Remove the Ethernet queue if you do not want to switch back to accessing
the printer over an Ethernet connection.

If the printer is currently set up for wireless

1 Attach a USB cable to the computer and to the printer.

2 Add the printer (see “Add the printer” on page 115).

3 A second print queue will be created. Remove the wireless queue if you do not want to switch back to accessing
the printer over a wireless connection.

Using the printer over an Ethernet network

Select the connection type that describes how you currently access your printer:

If the printer is currently set up for wireless

1 Plug an Ethernet cable into the printer and to an available port on a switch or wall jack.

2 Wait a minute for the Ethernet network interface to become active and acquire an IP address from the network.

3 Add the printer (see “Add the printer” on page 115).

4 A second print queue will be created. Remove the wireless queue if you do not want to switch back to accessing
the printer over a wireless network.

If the printer is currently set up locally (using USB connection)

1 Plug an Ethernet cable into the printer and to an available port on a switch or wall jack.

2 Insert the Software and Documentation CD into the computer you want to use to configure the printer.

3 Follow the instructions on the computer screen.

Note: You will need a USB cable to complete the configuration.

Add the printer

In Mac OS X version 10.5 or later

1 From the Apple menu, navigate to:

System Preferences > Print & Fax

or

System Preferences > Print & Scan

2 Click +.

3 Click the Default or Default Browser tab, and then select your printer.

4 Click Add.

In Mac OS X version 10.4 or earlier

1 From the Finder, choose Utilities.

2 Double‑click Printer Setup Utility or Print Center.
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3 From the Printer List dialog, choose the printer you want to use, and then click Add.

4 From the Printer Browser, select your printer, and then click Add.

Sharing a printer in a Windows environment
1 Prepare the computers to share the printer:

a Make all computers printing to the printer accessible through Network Neighborhood by enabling File and Print
Sharing. See the Windows documentation for instructions on enabling File and Print Sharing.

b Install the printer software on all computers that will print to the printer.

2 Identify the printer:

a On the computer that is attached to the printer, open the printers folder:

1 Click , or click Start and then click Run.
2 In the Start Search or Run box, type control printers.
3 Press Enter, or click OK.

b Right‑click the name of your printer.

c Click Sharing or Printer Properties.

d From the Sharing tab, select Share this printer or Shared as.

e Assign a distinctive name, and then click OK.

3 Locate the printer from the remote computer:

Note: The remote computer is the one that is not attached to the printer.

a Open the printers folder:

1 Click , or click Start and then click Run.
2 In the Start Search or Run box, type control printers.
3 Press Enter, or click OK.

b Right‑click the name of your printer.

c Click Properties or Printer properties.

d Click Ports > Add Port > Local Port > New Port.

e Type the Universal Naming Convention (UNC) Port Name, which consists of the server name and the distinctive
printer name that was specified in step 2 on page 116. The name should be in the form \\server\printer.

f Click OK.

g Click Close on the Printer Ports dialog.

h Make sure the new port is selected on the Ports tab, and then click Apply.

i Click OK.

Sharing a printer in a Macintosh environment
1 From the Finder, choose Help > Mac Help.

2 In the Search field, type sharing the printer on a network, and then press return.
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3 Select only one of the following:

• Sharing your printer with Mac OS X users—Let other Macintosh computers on the network that use Mac OS X
version 10.4 or later use any printer connected to your Macintosh computer.

• Sharing your printer with Windows users—Let Windows computers on the network use any printer connected
to your Macintosh computer.

4 Follow the instructions on the computer screen.

Note: Windows users should see the Windows documentation for information on adding a network printer
connected to a Macintosh computer.

Networking FAQ

What is Wi‑Fi Protected Setup?
Wi‑Fi Protected Setup (WPS) is a simple and secure configuration that allows you to establish a wireless home network
and enable network security without requiring prior knowledge of Wi‑Fi technology. It is no longer necessary to
configure the network name (SSID) and WEP key or WPA passphrase for network devices.

Note:  WPS supports only networks that communicate through access points (wireless routers).

The printer supports the following methods in connecting to a wireless network:

• Personal Identification Number (PIN)—A PIN on the printer is entered into the wireless settings of the access point.

• Push Button Configuration (PBC)—Buttons on both the printer and the access point are pushed within a given period
of time.

Look for any of these identifier marks to check if your access point is WPS certified:

You can find these WPS logos on the side, back, or top of your access point.

For more information on accessing the wireless settings and determining the WPS capability of your access point, see
the documentation that came with the access point or contact your system support person.

Where do I find my WEP key or WPA/WPA2 preshared key/passphrase?
• Contact your system support person.

– The person who set up your network usually keeps the WEP key or WPA/WPA2 preshared key/passphrase.

– If your wireless network was set up by your Internet Service Provider (ISP), then you might find the information
in the documentation they provided.

• See the documentation that came with your access point (wireless router).

If your access point is using the default settings, then you can find the information in the documentation.

• View the security settings on the access point.

1 Open a Web browser, and then type the IP address of the access point in the address field. Press Enter.
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Notes:

– To obtain the IP address of the access point, see the documentation that came with it or contact your
system support person.

– If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Enter the user name and password for the access point when prompted.

Note: The WEP key or WPA/WPA2 preshared key/passphrase is not the same as the password for the
access point. The password lets you access the access point settings. The WEP key or WPA/WPA2 preshared
key/passphrase allows printers and computers to join your wireless network.

3 Look for the WEP key or WPA/WPA2 preshared key/passphrase.

What is an SSID?
A Service Set Identifier (SSID) is the name that identifies a wireless network. All devices on the network must know the
SSID of the wireless network, or they will not be able to communicate with each other. Usually, the wireless network
broadcasts the SSID to allow wireless devices in the area to connect to it. Sometimes, the SSID is not broadcast for
security reasons.

If the SSID of your wireless network is not broadcast, then it cannot be detected automatically and will not show up in
the list of available wireless networks. You must enter the network information manually in this situation.

An SSID can contain up to 32 alphanumeric characters. Alphanumeric characters are a combination of alphabetic (letters
A to Z) and numeric (numbers 0 to 9) characters.

Where do I find my SSID?
• View the settings on the access point (wireless router).

Most access points have a built‑in Web server that can be accessed using a Web browser.

• Check your computer to see if a program was installed with your wireless network adapter.

Many network adapters provide a software application that allows you to view the wireless settings of your
computer, including your SSID.

If you are unable to locate your SSID using either of these methods, then contact your system support person.

What is a network?
A network is a collection of devices such as computers, printers, Ethernet hubs, access points, and routers connected
together for communication through cables or through a wireless connection. A network can be wired, wireless, or
designed to have both wired and wireless devices.

How do I find out what type of security my network is using?
• Contact your system support person.

The person who set up your network usually keeps your wireless information.

• See the documentation that came with your access point (wireless router).

• Check the characters of the password that you use to access your wireless network.

If you are not using a password, then choose None or No Security.
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Characters Security type

Exactly 10 or 26 hexadecimal characters

or

Exactly 5 or 13 ASCII characters

WEP

Exactly 64 hexadecimal characters

or

From 8 to 63 ASCII characters

WPA or WPA2

Notes:

– Hexadecimal characters are A–F, a–f, and 0–9.

– ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII characters in a WPA/WPA2
preshared key/passphrase are case‑sensitive.

• View the security settings on the access point.

1 Open a Web browser. Type the IP address of the access point in the address field, and then press Enter.

Notes:

– To obtain the IP address of the access point, see the documentation that came with it, or contact your
system support person.

– If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Enter the user name and password for the access point when prompted.

Note: The WEP key or WPA/WPA2 preshared key/passphrase is not the same as the password for the
access point. The password lets you access the access point settings. The WEP key or WPA/WPA2 preshared
key/passphrase allows printers and computers to join your wireless network.

3 Look for the WEP key or WPA/WPA2 preshared key/passphrase.

How are home networks configured?
For desktop computers, laptops, and printers to communicate with each other over a network, they must be connected
by cables and/or have wireless network adapters built in or installed in them.

There are many different ways a network can be set up. Four common examples appear below.

Note: The printers in the following diagrams represent printers with internal print servers built into them so that
they can communicate over a network.

Wireless network examples

Scenario 1: Mixed wired and wireless connections on a network with Internet access

• All computers and printers connect to the network through a router with Ethernet and wireless capabilities.

• Some computers and printers connect wirelessly to the router; others connect over a wired connection.

Networking 119



• The network is connected to the Internet through a DSL or cable modem.

Internet

Scenario 2: Wireless network with Internet access

• All computers and printers connect to the network using a wireless access point or wireless router.

• The wireless access point connects the network to the Internet through a DSL or cable modem.

Internet

Scenario 3: Wireless network with no Internet access

• Computers and printers connect to the network using a wireless access point.

• The network has no connection to the Internet.
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Scenario 4: Computer connected wirelessly to a printer without Internet access

• A computer is directly connected to a printer without going through a wireless router.

• This configuration is referred to as an ad hoc network.

• The network has no connection to the Internet.

Note: Most computers can connect to only one wireless network at a time. If you access the Internet over a wireless
connection, you will lose Internet access if you are connected to an ad hoc network.

What is a USB cable?
A Universal Serial Bus (USB) cable is primarily used to connect a USB device to a host. Common hosts include computers
and video game consoles. Through the USB port and cable, it is possible to connect computer peripherals such as mouse
devices, keyboards, digital cameras, printers, personal media players, flash drives, and external hard drives. For many
of those devices, USB has become the standard connection method.

Why do I need a USB cable?
When setting up the printer on your wireless network, the printer will need to temporarily connect to a computer using
the USB cable. This temporary connection may be used to set up the wireless settings of the printer.

Note: A USB cable is not necessary when connecting to a wireless network through Wi‑Fi Protected Setup (WPS).

How do I attach the USB cable?
The USB cable attaches to a USB port on the computer and to the square connector on the back of the printer. This
connection allows you to configure the printer for a network or local (USB) installation.

The USB port on the computer and on the printer are each marked with .

Note: Do not connect the USB cable until prompted to do.

1 If the USB port at the back of the printer is covered by a sticker, then make sure to remove it.
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2 Firmly plug the square end of the USB cable into the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

4 Follow the instructions on the computer screen.

How are infrastructure and ad hoc networks different?
Wireless networks can operate in one of two modes: infrastructure or ad hoc.

In infrastructure mode, all devices on a wireless network communicate with each other through an access point (wireless
router).

In ad hoc mode, a computer with a wireless network adapter communicates directly with a printer equipped with a
wireless print server.

Infrastructure Ad hoc

Characteristics

Communication Through an access point Directly between devices

Security More security options WEP or no security

Range Determined by the range and number
of access points

Restricted to the range of individual
devices on the network
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Infrastructure Ad hoc

Speed Usually faster Usually slower

Requirements for all devices

Unique IP address for each device Yes Yes

Mode set to Infrastructure mode Ad hoc mode

Same SSID Yes, including the access point Yes

Same channel Yes, including the access point Yes

We recommend setting up a network in infrastructure mode using the installation software CD. Infrastructure mode
provides:

• Increased network security

• Increased reliability

• Faster performance

• Easier setup

Finding the signal strength
The signal strength tells you how strongly the computer or printer is receiving the wireless signal from the wireless
network. Poor signal quality could affect connectivity during configuration.

Checking computer connectivity

1 From your computer system tray, click the wireless icon that corresponds to the software managing your wireless
network adapter.

2 Check the signal quality.

Checking printer connectivity

• From the printer, print a network setup page.

In the Wireless section, look for Quality.

• View the signal strength from the printer control panel.

Navigate to:

 > Setup > OK  > Network Setup > OK  > Wireless 802.11 b/g/n > OK  > Network Connection Setup > OK  > Wireless >
OK  > View Signal Quality > OK

To improve signal quality, remove sources of interference or move wireless devices closer to the access point (wireless
router).
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How can I improve wireless signal strength?
A common reason wireless printers fail to communicate over a network is poor wireless signal quality. If the signal is
too weak, too distorted, or blocked by an object, it cannot carry information between the access point and the printer.
To determine if the printer is receiving a strong signal from the access point, print a network setup page. The Quality
field indicates the relative strength of the wireless signal the printer is receiving. Drops in signal strength can be
intermittent, however, and although the signal quality appears high, it may drop during certain conditions.

If you think signal strength is a problem between your access point (wireless router) and the printer, then try one or
more of the following:

Notes:

• The solutions below are for infrastructure networks. If you are using an ad hoc network, then adjust the
computer when the solution suggests adjusting the access point.

• Ad hoc networks have a much shorter range than infrastructure networks. Try moving the printer closer to the
computer if they seem to have trouble communicating.

MOVE THE PRINTER CLOSER TO THE ACCESS POINT

If the printer is too far away from the access point, then it will not be able to communicate with other devices on
the network. For most indoor wireless networks, the maximum distance between the access point and the printer
is approximately 100 feet (30 meters). This distance could be longer or shorter, depending upon the layout of the
network and the limitations of the access point.

REMOVE OBSTACLES BETWEEN THE ACCESS POINT AND THE PRINTER

The wireless signal from your access point will pass through most objects. Most walls, floors, furniture, and other
objects will not block the wireless signal. However, there are materials that are too dense for the signal to pass
through, such as objects containing metal and concrete. Arrange your printer and access point so that the signal is
not blocked by such objects.

REMOVE SOURCES OF INTERFERENCE

Other types of radio frequencies can cause problems with the wireless signal on your network, resulting to printing
issues that seem to come and go.

• Turn off potential sources of interference where possible.

• Avoid using microwave ovens, cordless phones (but not cellular phones), baby monitors, almost any kitchen
appliance, wireless surveillance equipment, or any appliance containing a motor when printing over your wireless
network.

• If another wireless network is operating in the vicinity, then change the wireless channel on the access point.

• Do not place your access point on a printer or other electronic device. Such devices can also interfere with the
wireless signal.

ARRANGE THE NETWORK TO REDUCE SIGNAL ABSORPTION

Even when the wireless signal is able to pass through an object, it is slightly weakened. If it passes through too many
objects, then it can be significantly weakened. All objects absorb part of the wireless signal when it passes through
them, and certain types of objects absorb enough to cause communications problems. Place your access point as
high in the room as possible to avoid signal absorption.
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How can I make sure my computer and printer are connected to the same
wireless network?
If the printer is not on the same wireless network as the computer, then you will not be able to print wirelessly. The
SSID of the printer must match the SSID of the computer, if the computer is already connected to the wireless network.

For Windows users

1 Obtain the SSID of the network that the computer is connected to:

a Type the IP address of your access point (wireless router) in the address field of your Web browser.

If you do not know the IP address of the access point, then do the following:

1 Click , or click Start and then click Run.
2 In the Start Search or Run dialog, type cmd.
3 Press Enter, or click OK.
4 Type ipconfig, and then press Enter. Check the Wireless Network Connection section:

• The “Default Gateway” entry is typically the access point.

• The IP address appears as four sets of numbers separated by periods, such as 192.168.2.134.

b Type the user name and password of the router when prompted.

c Click OK.

d In the Wireless settings section, look for the SSID.

e Write down the SSID.

Note: Make sure you copy it exactly, including any capital letters.

2 Obtain the SSID of the network that the printer is connected to:

a From the printer, print a network setup page.

b In the Wireless section, look for SSID.

3 Compare the SSID of the computer and SSID of the printer.

If the SSIDs are the same, then the computer and the printer are connected to the same wireless network.

If the SSIDs are not the same, then run the utility again to set up the printer on the wireless network used by the
computer.

For Macintosh users with an AirPort base station

In Mac OS X version 10.5 or later

1 From the Apple menu, navigate to:

System Preferences > Network > AirPort

or

System Preferences > Network > Wi‑Fi

The SSID of the network that the computer is connected to is displayed in the Network Name menu.

2 Write down the SSID.
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In Mac OS X version 10.4 or earlier

1 From the Finder, navigate to:

Applications > Internet Connect > AirPort

The SSID of the network that the computer is connected to is displayed in the Network menu.

2 Write down the SSID.

For Macintosh users with an access point

1 Type the IP address of the access point in the address field of your Web browser and continue to step 2.

If you do not know the IP address of the access point, then do the following:

a From the Apple menu, navigate to:
System Preferences > Network > AirPort
or
System Preferences > Network > Wi‑Fi

b Click Advanced or Configure.

c Click TCP/IP.
The Router entry is typically the access point.

2 Type your user name and password when prompted, and then click OK.

3 In the Wireless settings section, look for the SSID.

4 Write down the SSID, security type, and the WEP key or WPA/WPA2 preshared key/passphrase (if shown).

Notes:

• Make sure you copy the network information down exactly, including any capital letters.

• Store the SSID and the WEP key or WPA/WPA2 preshared key/passphrase in a safe place for future
reference.

Can I use my printer on a USB and a network connection at the same time?
Yes; the printer supports a simultaneous USB and network connection. The printer can be configured in the following
ways:

• Locally attached (connected to a computer using a USB cable)

• Wireless network

• Ethernet network

• Wireless network and locally attached simultaneously

• Ethernet network and locally attached simultaneously

What is a MAC address?
A Media Access Control (MAC) address is a 48‑bit identifier associated with the hardware of network equipment. The
MAC address may also be called the physical address because it is connected to the hardware of a device instead of its
software. The MAC address is displayed as a hexadecimal number in this format: 01-23-45-67-89-AB.
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While it is possible to change the MAC address of a network device, it is not common practice to do so. For this reason,
MAC addresses are considered permanent. IP addresses are easily changed, so MAC addresses are a more reliable
method of identifying a specific device on a network.

Routers with security capabilities may allow filtering of MAC addresses on networks. This allows a managed list of
devices to access the network, identified by their MAC addresses, as well as prevent access from unwanted devices. If
your network uses MAC address filtering, then be sure to add the MAC address of the printer to the list of allowed
devices.

How do I find the MAC address?
Network devices have a unique hardware identification number to distinguish them from other devices on the network.
This is called the MAC (Media Access Control) address. Other devices sometimes use a type of MAC address called
Universally Administered Address (UAA).

When installing the printer on a network, make sure you select the printer with the correct MAC address.

The MAC address of the internal print server is a series of letters and numbers.

Notes:

• A list of MAC addresses can be set on an access point (wireless router) so that only devices with matching MAC
addresses are allowed to operate on the network. This is called MAC filtering. If MAC filtering is enabled in your
access point and you want to add a printer to your network, then the MAC address of the printer must be
included in the MAC filter list.
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• If you are using an AirPort base station, then the MAC address may be referred to as AirPort ID, and MAC
address filtering may be accessed through MAC Address Access Control.

What is an IP address?
An IP address is a unique number used by devices (such as a wireless printer, computer, or access point (wireless router))
on an IP network to locate and communicate with each other. Devices on an IP network can communicate with each
other only if they have unique and valid IP addresses. A unique IP address means no two devices on the same network
have the same IP address.

An IP address is a group of four numbers separated by periods. An example of an IP address is 123.123.123.123.

What is TCP/IP?
Networks are able to function when computers, printers, and other devices are able to send data to each other, either
through cables or wireless signals. This transfer of data is made possible by sets of data transmission rules called
protocols. A protocol can be thought of as a language that has rules so that participants can effectively communicate
with each other.

Different types of networks use different protocols, but Transmission Control Protocol/Internet Protocol (TCP/IP) is the
most popular. TCP/IP is used to send data over the Internet as well as over most corporate and home networks.

Every device on a network that uses TCP/IP must have an IP address. IP addresses are essentially unique computer
names in a numeric format, used to transfer data around a network. IP addresses allow TCP/IP to confirm requests for,
and receipt of, data by various devices on the network.

How do I locate IP addresses?

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run dialog, type cmd.

3 Press Enter, or click OK.

4 Type ipconfig, and then press Enter.

The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

For Macintosh users

1 From the Apple menu, navigate to:

About This Mac > More Info

2 From the Contents pane, choose Network.

3 If you are connected over a wireless network, then choose AirPort from the Active Services list.
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Locating the printer IP address

• From the printer, print a network setup page.

In the TCP/IP section, look for Address.

• View the printer settings.

From the printer control panel, navigate to:

 > Setup > OK  > Network Setup > OK  > Wireless 802.11 b/g/n > OK  > Network Connection Setup > OK  > TCP/IP >
OK  > IP Address > OK

or

 > Setup > OK  > Network Setup > OK  > Ethernet 10/100 > OK  > Network Connection Setup > OK  > TCP/IP > OK  >
IP Address > OK

How are IP addresses assigned?
An IP address may be assigned automatically by the network using DHCP. Once the printer is set up on a computer, the
computer sends all print jobs across the network to the printer using this address.

If the IP address is not automatically assigned, you will be asked during wireless setup to manually enter an address
and other network information after selecting your printer from the available list.

What is a key index?
An access point (wireless router) can be configured with as many as four WEP keys. Only one key is used on the network
at a time, however. The keys are numbered, and the number of a key is referred to as its key index. All devices on the
wireless network must be configured to use the same key index when multiple WEP keys are configured on the access
point.

Select the same key index on your printer as you are using on your access point.

What is the difference between Guided and Advanced setup?
Use Guided setup if:

• The printer and the computer communicate on the same wireless network.

• You want the Wireless Setup Utility to automatically detect the network for you.

• You want to connect your printer to the wireless network using Wi‑Fi Protected Setup (WPS).

Use Advanced setup if:

• The printer and the installing computer are not on the same wireless network, or if the computer does not have
wireless access.

• The wireless network requires certificates.

• Enterprise‑level security is employed on the wireless network.

• You know the network SSID and security information and want to enter the information on a single screen.

• The printer will be configured for a remote network.

• You know your network information and want to enter it quickly.

• You are configuring a printer for a wireless network that uses 802.1X authentication.
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Using the Embedded Web Server
The Embedded Web Server lets you view and remotely customize printer settings even when you are not physically
near the printer. You can also view reports on printer activities, monitor and order printer supplies online, contact
customer support, and download updates for your printer.

The Embedded Web Server requires that the printer is connected to your network through Ethernet connection. For
more information on connecting the printer to your network, see the printer User’s Guide.

Accessing the Embedded Web Server
Note: Make sure the printer is connected to your network. For more information, see the printer User’s Guide.

1 Obtain the printer IP address:

• From the printer home screen

• From the TCP/IP section in the Networks/Ports menu

Note: An IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

2 Open a Web browser, and then type the printer IP address in the address field.

The Embedded Web Server appears.

Understanding the home page

Use the To

1 Navigation pane Access the Embedded Web Server menus.

2 Header bar • View a brief summary of your printer supplies.

• View the information on printer model, IP address, contact information, and location.

• Access the Search function.

Note: The search fields may not appear in the Embedded Web Server, depending on your
printer model.

3 Information pane View specific information and access submenu items, depending on the menu selected from the
navigation pane.
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Customizing printer settings
1 From the navigation pane, select Settings.

2 Do one of the following:

Click To

General Settings View and customize general printer settings.

Copy Settings View and customize settings for making copies.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

Fax Settings View and customize settings for sending and receiving faxes.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

E-mail/FTP Settings View and customize settings for sending e-mails, or sending files to a File Transfer
Protocol (FTP) address.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

Print Settings View and customize print settings.

Paper Setup View and customize paper setup options.

Network/Ports View and customize network settings.

Security View and customize security settings for the printer and Embedded Web Server.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

E-mail Alert Setup Set up the e-mail server for the Embedded Web Server, and then customize e-mail alert
settings.

Scan‑to‑Network Folder
Setup

Add or manage a folder destination when the Scan to Network application is used.

Notes:

• This feature may not appear in the Embedded Web Server, depending on your
printer model.

• To use this feature, first make sure you are using the Hyper Text Transfer Protocol
Secure (HTTPS) connection.

Manage Shortcuts Add or manage shortcut settings for a printer task.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

Manage Profiles View the IP address of a profile, or delete it.

Note: This feature may not appear in the Embedded Web Server, depending on your
printer model.

Address Book Setup Add or manage address book contacts when sending e‑mails.

Intervention Management View any messages from the printer requesting intervention from the user.

Import/Export Import or export a configuration file.

Additional Solutions Install, customize, or uninstall a solution.
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Click To

Device Management Allow the Embedded Web Server to collect data from the printer.

3 Click Submit to save, or click Reset Form to discard the new settings.
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Maintaining the printer

Maintaining ink cartridges
In addition to the following tasks that you can perform, your printer performs automatic maintenance cycles if it is
plugged into a properly grounded, working electrical outlet. It will briefly come out of Sleep mode or will temporarily
turn on if it is turned off.

Checking ink levels

Using the printer control panel

From the printer control panel, navigate to:

 > Setup > OK  >Maintenance > OK  > Check Ink Levels > OK

Using the printer software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Maintenance tab > Supplies Status

For Macintosh users

1 From the Apple menu, navigate to:

System Preferences > Print & Fax > select your printer

2 Click Options & Supplies or Print Queue.

3 Click Supply Levels.

Aligning the printhead
If the characters or lines on your printed image appear jagged or wavy, then you may need to align the printhead.

1 Load plain paper.

2 From the printer control panel, navigate to:

 > Setup > OK  >Maintenance > OK  > Align Printer > OK

An alignment page prints.

Note: Do not remove the alignment page until printing is finished.

If you aligned the cartridges to improve print quality, then print your document again. If print quality has not improved,
then clean the printhead nozzles.
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Cleaning the printhead nozzles
If you have not been using the printer for a long period, then you may need to clean the printhead nozzles to improve
the quality of your prints. Keep your printer plugged to a properly grounded, working electrical outlet to allow it to
perform automatic maintenance cycles.

Notes:

• Cleaning the printhead nozzles uses ink, so clean them only when necessary.

• Deep cleaning uses more ink, so try the Clean Printhead option first to save ink.

• If the ink levels are too low, then you must replace the ink cartridges before you can clean the printhead
nozzles.

1 From the printer control panel, navigate to:

 > Setup > OK  > Maintenance > OK

2 Press the up or down arrow button to scroll to Clean Printhead or Deep Clean Printhead, and then
press OK .

3 Press the up or down arrow button to scroll to a cleaning option, and then press OK .

Wait until the printer is ready.

Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer,
unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2 Remove all paper from the printer.

3 Dampen a clean, lint‑free cloth with water.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

4 Wipe only the outside of the printer, making sure to remove any ink residue that has accumulated on the exit bin.

Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure the printer is dry before beginning a new print job.
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Cleaning the scanner glass
Clean the scanner glass and other related parts when vertical streaks appear on your printed pages or when you see
marks or smudges on such parts.

1 Dampen a clean, lint‑free cloth with water.

2 Gently wipe clean the scanner glass and other related parts.

1 Backing material

2 Scanner glass

3 ADF scanner glass

4 ADF press plate

Note: Make sure all ink or corrective fluid on the document is dry before placing the document on the scanner glass.

Moving the printer to another location
When moving the printer and optional trays to another location, follow these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any cart
used to move the options must have a surface able to support the dimensions of the options.

• Make sure the bin extender and the exit bin are in their original positions.

• Keep the printer in an upright position.

• Make sure to remove the ink cartridges from the printer.
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• Store the used ink cartridges in a box with the nozzles faceup.

• Avoid severe jarring movements.

• If available, use the original packaging of the printer with the needed padding to keep the printer protected during
transport.
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Troubleshooting

Before you troubleshoot
Use this checklist to solve most printer problems:

• Make sure the power cord is plugged into the printer and into a properly grounded, working electrical outlet.

• Make sure the printer is turned on.

• Make sure the printer is securely connected to the computer, print server, or network access point.

• Check the printer for error messages, and resolve any errors.

• Check for paper jam messages, and clear any jams.

• Check the ink cartridges, and install new cartridges if necessary.

• Turn the printer off, wait about 10 seconds, and then turn the printer back on.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

If Troubleshooting does not solve your problem
Visit our Web site at http://support.lexmark.com to find the following:

• Knowledgebase articles with the latest information and troubleshooting for your printer

• Live online customer support

• Contact numbers for telephone customer support

• Firmware and software updates

Setup troubleshooting
• “Incorrect language appears on the display” on page 138

• “Software did not install” on page 138

• “Recovering the security PIN of the printer” on page 138

• “Print job does not print or is missing pages” on page 139

• “Printer is printing blank pages” on page 140

• “Printer is busy or does not respond” on page 140

• “Cannot delete documents from the print queue” on page 141

• “Cannot print through USB” on page 141
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Incorrect language appears on the display
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHANGE THE LANGUAGE USING THE PRINTER MENUS

1 From the printer control panel, navigate to:

 > Setup > OK  > Device Setup > OK  > Language > OK

2 Press the up or down arrow button to scroll to the language you want, and then press OK .

3 To confirm the setting, press the left or right arrow button to scroll to Yes, and then press OK .

Software did not install
If you encountered problems while installing, or if your printer does not appear in the list in the printers folder or as a
printer option when sending a print job, then try uninstalling and reinstalling the software.

Before you reinstall the software, do the following:

MAKE SURE THAT YOUR COMPUTER MEETS THE MINIMUM SYSTEM REQUIREMENTS

TEMPORARILY DISABLE SECURITY PROGRAMS IN WINDOWS BEFORE INSTALLING THE SOFTWARE

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

4 Turn on the printer.

Recovering the security PIN of the printer
Contact customer support.
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Print job does not print or is missing pages
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE INK CARTRIDGES ARE INSERTED CORRECTLY

1 Turn the printer on, and then open the ink cartridge access door.

2 Make sure the cartridges are inserted correctly.

The cartridges should click firmly into their matching color slots.

3 Close the ink cartridge access door.

SELECT YOUR PRINTER FROM THE PRINT DIALOG BEFORE SENDING THE PRINT JOB

Note: This solution applies to Macintosh users only.

1 With a document open, choose File > Print.

2 From the printer pop-up menu, choose your printer, and then click Print.

If your printer does not appear on the Printer list, then choose Add Printer. From the list of printers in the Default
tab, select your printer, and then click Add.

If your printer does not appear on the list, then try either of the following:

• For a USB-connected printer, remove and then reconnect the USB cable.

• For a printer that is wirelessly connected, see the Wireless troubleshooting section.

MAKE SURE THE PRINT JOB IS NOT PAUSED

MAKE SURE YOUR PRINTER IS SET AS THE DEFAULT PRINTER

RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

4 Turn on the printer.

REMOVE AND RECONNECT THE USB CABLE CONNECTED TO YOUR PRINTER

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.
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3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

REMOVE AND REINSTALL THE PRINTER SOFTWARE

Printer is printing blank pages
Blank pages may be caused by improperly installed ink cartridges.

REINSTALL THE INK CARTRIDGES AND DEEP CLEAN AND ALIGN THE PRINTHEAD

1 Reinstall the ink cartridges. For more information, see “Replacing ink cartridges” on page 14.

The cartridges should click firmly into their matching color slots.

2 Load plain, unmarked paper.

3 From the printer control panel, navigate to:

 > Setup > OK  > Maintenance > OK  > Deep Clean Printhead > OK

4 Press the up or down arrow button to scroll to a cleaning option, and then press OK .

Wait until the printer is ready.

5 From the printer control panel, navigate to:

 > Setup > OK  > Maintenance > OK  > Align Printer > OK

An alignment page prints.

Note: Do not remove the alignment page until printing is finished.

Printer is busy or does not respond
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE PRINTER IS NOT IN SLEEP MODE

If the power light is blinking on and off slowly, then the printer is in Sleep mode. Press  to wake up the printer.

If the printer will not come out of Sleep mode, then reset the power:

1 Unplug the power cord from the wall outlet, and then wait 10 seconds.

2 Insert the power cord into the wall outlet, and then turn on the printer.

If this problem persists, then check our Web site for updates for your printer software or firmware.
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RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

4 Turn on the printer.

Cannot delete documents from the print queue
If you have jobs stuck in the print queue and cannot delete them to get other jobs to print, then the computer and
printer may not be communicating.

RESTART THE COMPUTER AND TRY AGAIN

REMOVE AND RECONNECT THE USB CABLE CONNECTED TO YOUR PRINTER

Cannot print through USB
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

MAKE SURE THE USB PORT IS ENABLED IN WINDOWS

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type devmgmt.msc.

3 Press Enter, or click OK.

The Device Manager opens.

4 Click the plus sign (+) beside Universal Serial Bus controllers.

If USB Host Controller and USB Root Hub are listed, then the USB port is enabled.

For more information, see the computer documentation.
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REMOVE AND REINSTALL THE PRINTER SOFTWARE

Understanding printer messages

Alignment Problem
Try one or more of the following:

• Load plain, unmarked paper, and then realign the printhead.

Note: The printer will read any markings on used paper, which could cause the alignment error message to
reappear.

• Press OK  to retry, or press  to clear the message.

Cannot Collate Job
Try one or more of the following:

• Press OK  to continue printing the pages that were saved in the printer memory, and then collate the remainder of
the print job.

• Press  to cancel the current print job.

Change [Paper Source] to [Size] Paper
Try one or more of the following:

• Press OK  to continue printing after loading the correct paper size and paper type in the default paper tray.

• Press  to cancel the current job.

Change [Paper Source] to [Size] [Type] Paper
Try one or more of the following:

• Press OK  to continue printing after loading the correct paper size and paper type in the default paper tray.

• Press  to cancel the current job.

Close Printer
The printer is open. Close the printer to clear the message.
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Duplex Unit Missing
Try one or more of the following:

• Make sure the duplex unit is properly installed at the back of the printer to clear the message.

• Cancel the current job.

Ink Cartridge Access Door Open
The ink cartridge access door is either open or detached.

• If the ink cartridge access door is open, then close it to clear the message.

• If the ink cartridge access door is detached, then reattach it to clear the message.
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1 Insert the door hinges into place until they click. Make sure the door is inserted at a 90-degree position.

2 Close the ink cartridge access door to clear the message.

Ink Cartridge Error
The printer is unable to authenticate one or more of the installed ink cartridges. Try one or more of the following:

• Press  to cancel the current job.

• Use only genuine Lexmark ink cartridges.

• Install the specified ink cartridges properly.

• Turn the printer off, then wait about 10 seconds, and then turn the printer back on.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

• See the User's Guide or visit the Lexmark Support Web site at http://support.lexmark.com for more information.

Ink Cartridge Missing
Try one or more of the following:

• Install the specified missing ink cartridge or cartridges.

• Reinsert the specified ink cartridge or cartridges.

• Press OK  or  to clear the message.

• See the User's Guide or visit the Lexmark Support Web site at http://support.lexmark.com for a list of supported
ink cartridges.

Ink Cartridge Unsupported
Try one or more of the following:

• Replace the unrecognized ink cartridge with one that is supported by your printer.

• Use only genuine Lexmark ink cartridges.

• Press OK  or  to clear the message.

• See the User's Guide or visit the Lexmark Support Web site at http://support.lexmark.com for a list of supported
ink cartridges.
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Ink Low
You may need to replace the specified ink cartridge soon. Try one or more of the following:

• Press OK  or  to clear the message and continue printing.

Note: Depending on your printer settings, you may not be allowed to continue printing until you replace the
specified cartridge.

• See the User's Guide or visit the Lexmark Support Web site at http://support.lexmark.com for a list of supported
ink cartridges.

Load [Paper Source] with [Size] Paper
Try one or more of the following:

• Load the specified paper in the tray.

• Press OK  to clear the message and continue printing.

• Press  to cancel the current job.

Load [Paper Source] with [Size] [Type] Paper
Try one or more of the following:

• Load the specified paper in the tray.

• Press OK  to clear the message and continue printing.

• Press  to cancel the current job.

Memory Device Error
Try one or more of the following:

• Remove the memory device, and then reinsert it into the card slot or USB port.

• Touch OK or press OK  to clear the message.

Network [x] Software Error
[x] is the number of the network connection.

Try one or more of the following:

• Press OK  to clear the message.

• Turn the printer off and then back on to reset the printer.

Paper Tray [x] Detected
Try one or more of the following:

• Press OK  to clear the message.

• Use the arrow buttons to select Change Settings, and then select the paper size and paper type of the media loaded.
Press OK  for each selection.
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Paper Tray [x] Removed
Do one or more of the following:

• Insert the specified paper tray into the printer.

• Press OK  to clear the message.

Printer Memory Full
Try one or more of the following:

• Depending on your printer model, touch OK or press OK  to clear the message, and then try printing again.

• From the computer, adjust the printer settings to reduce the quality of the print job, and then try printing again.

Printhead Cannot Move
Try one or more of the following:

• Open the printer to remove any obstructions to the printhead, and then close the printer.

• Press OK  to clear the message.

Printhead Error
There is a problem with the printhead. Contact technical support.

Printhead Warning
Clean or Deep Clean the printhead to restore print quality.

Notes:

• Cleaning the printhead nozzles uses ink, so clean them only when necessary.

• Deep cleaning uses more ink, so try the Clean Printhead option first to save ink.

• If the ink levels are too low, then you must replace the ink cartridges before you can clean the printhead
nozzles.

• See the User's Guide for more information on how to clean the printhead nozzles.

Replace Ink Cartridge
Try one or more of the following:

• Replace the ink cartridge with one that is supported by your printer.

• Press OK  to clear the message.

• See the User's Guide or visit the Lexmark Support Web site at http://support.lexmark.com for a list of supported
ink cartridges.

Scanned Document Too Long

The scan job exceeds the maximum number of pages. Press  to clear the message and cancel the current scan job.
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Scanner ADF Cover Open
Try one or more of the following:

• Close the ADF cover to clear the message.

• Press  to cancel the current scan job.

Scanner Disabled
Try one or more of the following:

• Check the printer software settings or the Administration settings from the printer to enable the scanner.

For more information, contact customer support.

• Press OK  to clear the message.

Short Paper
Try one or more of the following:

• Touch OK or press OK , depending on your printer model.

• Make sure the paper size is correctly set.

• Load paper with the correct size in the tray or on the paper support.

• Check the paper guides, and then make sure the paper is properly loaded in the tray or on the paper support.

• Cancel the current print job.

Standard Network Software Error
Try one or more of the following:

• Press OK  to clear the message.

• Turn the printer off and then back on to reset the printer.

Unrecoverable Scan Error
Try one or more of the following:

• Restart your printer.

• Update your printer firmware. For more information, visit http://support.lexmark.com.

USB Device Not Supported
Remove the unrecognized USB device and replace it with a supported device.

USB Hub Not Supported
Remove the unrecognized USB hub.
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Clearing paper jams
• “Paper jam in the printer” on page 148

• “Paper jam in the duplex unit” on page 148

• “Paper jam in the ADF (select models only)” on page 149

• “Paper or specialty media misfeeds” on page 150

Paper jam in the printer
Note: The parts inside the printer are sensitive. Avoid unnecessarily touching these parts while clearing jams.

1 Check the paper tray, exit bin, or jam clearance area for any jammed paper.

Notes:

• For select models that support a second tray, make sure you also check the second tray.

• If the paper tray was removed, then make sure you do not replace the tray until the jam is cleared.

• Make sure you do not tilt the printer when checking the jam clearance area. Grasp and pull the latch under
the printer control panel to open the printer.

• Before clearing the jam, make sure the printhead is moved to the side and away from the jammed paper.

2 Firmly grasp the paper, and then gently pull it out.

Note: Be careful not to tear the paper while removing it.

3 If necessary, close the printer to clear the message.

Paper jam in the duplex unit
Note: The parts inside the printer are sensitive. Avoid unnecessarily touching these parts while clearing jams.
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1 Pull up the duplex latch and remove the duplex unit.

2 Firmly grasp the paper, and then gently pull it out.

Note: Be careful not to tear the paper while removing it.

3 Reinsert the duplex unit to clear the message.

Paper jam in the ADF (select models only)

Note: The parts inside the printer are sensitive. Avoid unnecessarily touching these parts while clearing jams.

1 Open the ADF cover, and then gently pull out the jammed paper.
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Notes:

• Make sure the ADF cover is fully opened to ensure that the jammed paper is properly removed.

• Be careful not to tear the paper while removing it.

2 Close the ADF cover.

Note: Make sure there is no paper on the ADF input tray before closing the ADF cover.

3 If necessary, touch OK or press OK , depending on your printer model.

4 Resume the copy, scan, or fax job.

Paper or specialty media misfeeds
These are possible solutions if paper or specialty media misfeeds or skews, or if multiple sheets feed or stick together.
Try one or more of the following:

CHECK PAPER CONDITION

Use only new, unwrinkled paper.

CHECK PAPER LOADING

• Load a smaller amount of paper into the printer.

• Load paper with the print side facedown. (If you are not sure which side is the printable side, see the instructions
that came with the paper.)

• Check the loading instructions for your paper or specialty media.

REMOVE EACH PAGE AS IT IS PRINTED

ADJUST THE PAPER GUIDES TO FIT THE LOADED PAPER
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Print troubleshooting
• “Poor quality at the edges of the page” on page 151

• “Streaks or lines on printed image” on page 152

• “Print speed is slow” on page 152

• “Computer slows down when printing” on page 153

Poor quality at the edges of the page
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK MINIMUM PRINT SETTINGS

Unless you are using the borderless feature, use these minimum print margin settings:

• Left and right margins:

– 6.35 mm (0.25 in.) for letter‑size paper

– 3.37 mm (0.133 in.) for all paper sizes except letter

• Top margin: 1.7 mm (0.067 in.)

• Bottom margin: 12.7 mm (0.5 in.)

SELECT THE BORDERLESS PRINT FEATURE

For Windows users

1 With a photo open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Paper/Finishing tab > select a borderless setting > OK

4 Click Print.

For Macintosh users

1 With a photo open, choose File > Page Setup.

2 From the “Format for” pop‑up menu, choose your printer.

3 From the Paper Size pop‑up menu, choose a paper size that has “(Borderless)” in its name.

For example, if you loaded a 4 x 6 photo paper, then choose US 4 x 6 in (Borderless).

4 Click OK.

5 From the menu bar, choose File > Print.

6 From the Printer pop‑up menu, choose your printer.

7 From the print options pop‑up menu, choose Quality & Media.

8 From the Paper Type pop‑up menu, choose a paper type.
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9 From the Print Quality pop‑up menu, choose Best or Photo.

10 Click Print.

Streaks or lines on printed image
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK THE INK LEVELS

Replace low or empty ink cartridges.

SELECT A HIGHER PRINT QUALITY FROM THE PRINTER SOFTWARE

MAKE SURE THE INK CARTRIDGES ARE PROPERLY INSTALLED

ALIGN THE PRINTHEAD

CLEAN OR DEEP CLEAN THE PRINTHEAD NOZZLES

Note: If these solutions do not remove the streaks or lines on the printed image, then contact technical support.

Printed page has ink smears or smudges
Note: The following solutions apply to ink smears or smudges that occur in the printer.

If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

SELECT A RECOMMENDED PAPER FOR THE PRINT JOB

For more information, see the section on “Using different paper sizes and types” in the User’s Guide.

SET THE PAGE DRY TIME VALUE TO EXTENDED

Under conditions of high humidity, or for certain paper types and brands, the normal drying time may not allow the
ink to dry completely. For more information, see “Setting the page dry time” in the User’s Guide.

Print speed is slow
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

SELECT A LOWER PRINT QUALITY FROM THE PRINTER SOFTWARE

MANUALLY SELECT A PAPER TYPE THAT MATCHES THE TYPE OF PAPER YOU ARE USING

REMOVE AND REINSTALL THE PRINTER SOFTWARE
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MAXIMIZE COMPUTER PROCESSING SPEED

• Close all applications not in use.

• Minimize the number and size of graphics and images in the document.

ADD MEMORY TO THE COMPUTER

Consider upgrading the RAM.

Computer slows down when printing
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK THE USB CONNECTION BETWEEN THE PRINTER AND COMPUTER

If your computer is connected to the printer through a USB cable, then try using a different USB cable.

REFRESH YOUR NETWORK CONNECTIONS

1 If your computer is connected to an Ethernet or wireless network, then turn off the access point (wireless router)
and turn it back on.

2 Wait one minute for the printer and computer to reestablish the connection.

CLOSE ALL APPLICATIONS NOT IN USE

Temporarily close unused applications or end processes that are taking too much memory from your computer.

CHECK YOUR COMPUTER PERFORMANCE

You may need to change how your computer manages resources and processes.

For more information on improving computer performance, see the documentation that came with your operating
system.

Copy and scan troubleshooting
• “Copier or scanner does not respond” on page 154

• “Scanner unit does not close” on page 154

• “Poor copy or scanned image quality” on page 154

• “Partial copies or scans of documents or photos” on page 154

• “Scan was not successful” on page 155

• “Scanning takes too long or freezes the computer” on page 155

• “Cannot scan to a computer over a network” on page 155
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Copier or scanner does not respond
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

SET YOUR PRINTER AS THE DEFAULT PRINTER

REMOVE AND REINSTALL THE PRINTER SOFTWARE

Scanner unit does not close
1 Lift the scanner unit.

2 Remove any obstruction keeping the scanner unit open.

3 Lower the scanner unit.

Poor copy or scanned image quality
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CLEAN THE SCANNER GLASS

ADJUST THE SCAN QUALITY

REVIEW THE TIPS FOR COPYING, SCANNING, AND IMPROVING PRINT QUALITY

USE A CLEARER VERSION OF THE ORIGINAL DOCUMENT OR IMAGE

MAKE SURE THE DOCUMENT OR PHOTO IS LOADED FACEDOWN ON THE SCANNER GLASS AND IN THE CORRECT

CORNER

Partial copies or scans of documents or photos
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE DOCUMENT OR PHOTO IS LOADED FACEDOWN ON THE SCANNER GLASS AND IN THE

PLACEMENT CORNER

SELECT A PAPER SIZE THAT MATCHES THE LOADED PAPER

MAKE SURE THE ORIGINAL SIZE SETTING MATCHES THE SIZE OF THE DOCUMENT YOU ARE SCANNING
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Scan was not successful
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

RESTART THE COMPUTER

Scanning takes too long or freezes the computer
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CLOSE OTHER SOFTWARE PROGRAMS THAT ARE NOT BEING USED

RESTART THE COMPUTER

Cannot scan to a computer over a network
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE PRINTER AND THE DESTINATION COMPUTER ARE CONNECTED TO THE SAME NETWORK

MAKE SURE THE PRINTER SOFTWARE IS INSTALLED ON THE DESTINATION COMPUTER

E-mail troubleshooting
• “Cannot send e‑mail” on page 155

Cannot send e‑mail

CHECK YOUR E‑MAIL CONFIGURATION SETTINGS

Make sure you have correctly completed the e‑mail setup and successfully configured an SMTP server.
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CHECK YOUR NETWORK CONNECTION

Make sure the printer is connected to an Ethernet or wireless network. Your network must be connected to the
Internet for the printer to communicate with the SMTP server.

CHECK YOUR PROXY CONFIGURATION

Your proxy server configuration should allow SMTP server connections. For help with your proxy server or SMTP
settings, contact your system support person.

MAKE SURE TO ENTER A VALID RECIPIENT E‑MAIL ADDRESS

MAKE SURE THE RECIPIENT MAILBOX IS NOT FULL

This causes e‑mail to bounce back to your inbox.

Fax troubleshooting
• “Fax troubleshooting checklist” on page 156

• “Cannot send faxes” on page 157

• “Cannot receive faxes” on page 158

• “Cannot run the fax software” on page 159

For detailed descriptions of common terms and tasks, see the following:

• “Setting up the printer to fax” on page 76

• “Faxing FAQ” on page 94

Fax troubleshooting checklist
If you encounter problems sending and receiving faxes, then check the connection first:

1 Check for a dial tone on the telephone line by plugging an analog telephone into the wall jack, DSL filter, VoIP device,
or cable modem where you connected the printer. Make sure you plug the telephone into the same port.

If you do not hear a dial tone, then contact your line provider.

2 While the printer is connected to the telephone line, check for a dial tone by plugging an analog telephone into the
 port of the printer.

If you do not hear a dial tone, then use the checklist below. Listen for a dial tone after checking each item.

If you hear a dial tone but still have problems sending and receiving faxes, then see the other topics in this section.

Connection checklist

• Make sure that the printer and other devices on the line (if applicable) are set up and configured correctly according
to your setup scenario.

• Make sure that the cables are connected to the correct ports.

• Make sure that the cables are securely plugged in.

Check the cable connections for the following hardware, if applicable:
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Power supply Answering machine Cable modem Splitter

Telephone VoIP adapter DSL filter RJ‑11 adapter

• If the printer is connected to a Digital Subscriber Line, then make sure you are using a DSL filter for the printer.

• If the printer is connected to a VoIP adapter or cable modem, then make sure that the printer is plugged into the
first phone port.

• If you are using a splitter, then make sure that you are using a phone splitter. Do not use a line splitter.

Cannot send faxes
If the “Fax troubleshooting checklist” does not solve the problem, then try one or more of the following:

MAKE SURE THAT YOU HAVE REGISTERED YOUR USER INFORMATION IN THE PRINTER

If you did not enter your user information during initial setup, then enter your fax name and fax number. In some
countries, you cannot send a fax without entering your fax name or company name. Some fax machines also block
unknown faxes or faxes without sender information.

DECREASE THE TRANSMISSION SPEED OF THE FAX MODEM

The modem of the printer can transmit data at 33,600 bps. This is the maximum speed at which the printer can send
and receive faxes. It is not necessary, however, to set the modem to its fastest transmission capability. The speed of
the modem of the receiving fax machine must match or be greater than the speed at which you are sending your
fax. Otherwise, your fax will not be received.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Max Send Speed > OK

2 Select a sending speed, and then press OK .

ENABLE ERROR CORRECTION

Errors and blurs may appear in the faxed document if there is too much noise on the line. This option enables the
printer to transmit the bad blocks of data again and correct the errors. When a fax has too many errors, the fax may
be rejected by the receiving fax machine.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Error Correction > OK

2 Check to see if error correction is set to On.

If it is not set to On, then press the arrow buttons to select On, and then press OK .
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ENABLE AUTOMATIC FAX CONVERSION

If the receiving fax machine does not support color fax, then this option automatically converts the outgoing color
fax to black and white. It also automatically reduces the resolution of the fax to a resolution that the receiving machine
can support.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Auto Fax Convert > OK

2 Check to see if automatic fax conversion is set to On.

If it is not set to On, then press the arrow buttons to select On, and then press OK .

MAKE SURE THAT THE DIAL PREFIX SETTING IS CORRECT

The dialing prefix is the number or series of numbers that you press before you can dial the actual fax number or
telephone number. If the printer is in an office setting or in a private branch exchange, this can be a specific number
that you need to press so you can make a call outside the office.

Make sure that the dial prefix entered in the printer is correct for your network.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Dialing and Sending > OK  > Dial Prefix > OK

2 Press the arrow buttons to create or modify the prefix.

3 If the prefix is not correct, enter the correct prefix, and then press OK .

Cannot receive faxes
If the “Fax troubleshooting checklist” does not solve the problem, then try one or more of the following:

MAKE SURE THAT YOU HAVE CONFIGURED THE CORRECT SETTINGS FOR YOUR SETUP

The fax settings depend on whether the printer is connected to its own fax line or shares the line with other devices.

If the printer is sharing the telephone line with an answering machine, then make sure that the following are set:

• Auto Answer is On.

• The printer picks up on a greater number of rings than the answering machine.

• The printer picks up on the correct distinctive ring (if you subscribe to a distinctive ring service).

If the printer is sharing the telephone line with a telephone subscribed to voice mail, then make sure that the following
are set:

• Auto Answer is Off (if you have only one number on the telephone line).

• The printer picks up on the correct distinctive ring (if you subscribe to a distinctive ring service).

MAKE SURE THAT THE PRINTER IS CONNECTED TO AN ANALOG PORT

The printer is an analog device. If you are using a PBX system, then make sure that the printer is connected to an
analog port on the PBX. You may need a digital line converter that converts digital signals into analog signals.
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MAKE SURE THAT THE PRINTER MEMORY IS NOT FULL

The printer saves an incoming fax to the printer memory before it prints the fax. If the printer runs out of ink or runs
out of paper while receiving the fax, then the printer saves the fax so you can print it later. However, if the printer
memory is full, then the printer may not be able to receive more incoming faxes. An error message appears on the
display when the printer memory is full. Resolve the error to free up space in the printer memory.

MAKE SURE THAT FAX FORWARDING IS DISABLED

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Fax Forward > OK

2 Press the arrow buttons to scroll to Off, and then press OK .

INCREASE THE RINGER VOLUME

If you set the printer to receive faxes manually (Auto Answer Off), then increase the ringer volume.

MAKE SURE THAT YOU HAVE THE CORRECT MANUAL ANSWER CODE

If you set the printer to receive faxes manually (Auto Answer Off), then you need to press the correct code when a
fax comes in so that the printer can receive it.

1 From the printer control panel, navigate to:

 > Setup > OK  > Fax Setup > OK  > Ringing and Answering > OK  > Manual Pickup Code > OK

2 Copy the manual answer code that appears on the display.

Note: To increase the security, you can change your manual pickup code to a number that only you know. You can
enter up to 7 characters for your code. The valid characters are the digits 0–9 and the characters # and *.

Cannot run the fax software
The printer must be connected to a telephone, DSL, VoIP, or cable service before you can configure the fax settings in
the fax software.

MAKE SURE A FAX DRIVER IS INSTALLED

The fax option is available for use only with the PostScript driver or the Universal Fax Driver. For information on
installing these drivers, see the Software and Documentation CD.

MAKE SURE THE PRINTER IS CONNECTED TO A TELEPHONE LINE

You need to connect the printer to your telephone line (through a standard wall jack, a DSL filter, a VoIP adapter, or
a cable modem) before you can open the fax software and configure the fax settings.
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Fax error messages on the printer control panel

Error Message: What it indicates: Possible solutions:

Remote Fax Error The receiving fax machine cannot
receive the fax. The error on the
receiving end could be due to several
factors.

• Resend the fax. There may have
been a problem with the quality of
the connection.

• Decrease the transmission speed of
your fax modem.

• Register your user information. In
some countries, you cannot send a
fax without registering your fax
name and fax number. Some fax
machines also block faxes without
sender information.

Fax Mode Unsupported The receiving fax machine does not
support color fax or the scan resolution
of the document that you are sending.

• Enable Auto Fax Conversion. The
printer automatically converts color
faxes to black and lowers the scan
resolution of the document.

• Lower the fax quality.

• Reformat the document on
Letter‑size paper.

Unsupported Compression The fax modem of the receiving fax
machine does not support data
compression. Fax modems compress
data to speed up transmission, but the
receiving fax modem needs to have the
same compression code.

• Lower the transmission speed of the
fax modem, and then resend the
fax.

• Enable Auto Fax Conversion.

Unsupported Resolution The receiving fax machine does not
support the scan resolution of the
document that you are sending.

• Lower the fax quality.

• Enable Auto Fax Conversion.

Unrecoverable Fax Error The fax modem encountered critical
errors.

Turn off the printer, turn it back on, and
then resend the fax.

Fax Modem Error The fax modem of the printer may be
busy, or the fax modem may have
encountered problems during
transmission.

Turn off the printer, turn it back on, and
then resend the fax.

Phone Line is connected to
the incorrect jack on the
back of the machine.

The telephone cable is connected to
the wrong port on the back of the
printer.

Connect the phone cable to the  port
on the back of the printer.

Digital line detected The printer is connected to a digital
line.

The printer is an analog device and must
be connected to an analog line. To
connect the printer to a digital line, you
must use a digital line converter or a
filter.

For more information, see the ”Setting
up the printer to fax” section.
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Error Message: What it indicates: Possible solutions:

Failed to Connect

Phone Line Error

Phone Line Not Connected

The printer cannot detect a dial tone. See the “Fax troubleshooting checklist.”

Phone Line Busy Your telephone line or the telephone
line of the receiving fax machine is
busy. This happens especially if the
printer is sharing the line with other
devices (telephone, answering
machine).

• Set the printer to redial.

• Increase the time between the
redial attempts.

• Place a test call to the number to
which you want to send a fax to
make sure that it is working
correctly.

• If the telephone line is being used
by another device, then wait until
the other device is finished before
sending the fax.

• Schedule to resend the fax at a later
time.

• Set the printer to scan before
dialing. The scanned document is
saved in the printer memory. The
printer can then retrieve it and
automatically redial the number.

No Answer Auto Answer may have been turned off
on the receiving fax machine.

• Verify the number, and then resend
the fax.

• Set the printer to redial.

Note: Depending on your country
or region, there may be a limit on
the number of redial attempts,
regardless of the redial settings
that you set in your printer.

• Schedule to resend the fax at a later
time.

No Caller ID

Call Stopped

Your printer stopped the call because
the incoming fax has no sender
information. You may have chosen to
block faxes with no Caller ID or faxes
without Caller IDs are not allowed in
your country or region.

Disable Block No‑ID.

To troubleshoot error messages in the fax software, click Help to view the help information for the fax software.

Memory card troubleshooting
• “Memory card troubleshooting checklist” on page 162

• “Nothing happens when a memory card is inserted” on page 162
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Memory card troubleshooting checklist
Before you troubleshoot, use the following checklist to solve most memory card problems:

• Make sure that the memory card you are using can be used in the printer.

• Make sure the memory card is not damaged.

• Make sure memory card contains supported file types.

Nothing happens when a memory card is inserted
If the "Memory card troubleshooting checklist" does not solve the problem, then try the following:

REINSERT THE MEMORY CARD

The memory card may have been inserted too slowly. Remove and then reinsert the memory card quickly.

Network troubleshooting
• “Network troubleshooting checklist” on page 162

• “The Continue button is unavailable” on page 163

• “Computer firewall is blocking communication with the printer” on page 165

• “Communication with printer lost when connected to Virtual Private Network (VPN)” on page 165

Network troubleshooting checklist
Before beginning to troubleshoot the wireless printer, verify the following:

General Networking

Make sure:

• The printer, the computer, and the access point (wireless router) are all plugged in and turned on.

• The wireless network is working properly.

Try accessing other computers on your wireless network. If your network has Internet access, try connecting to the
Internet over a wireless connection.

• The printer driver is installed on the computer from which you are performing a task.

• The correct printer port is selected.

• The IP address, gateway, and network mask are correct for your network.

Print a network setup page from the printer to check the network settings.

• All switches, hubs, and other connecting devices are turned on.

Ethernet Networking

Make sure:

• The Ethernet cable and connectors are not damaged.

Check the connectors at both ends for any obvious damage. If possible, use a new cable.

• The Ethernet cable is firmly plugged in to the printer and to the network hub or wall connection.
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Wireless Networking

Make sure:

• The SSID is correct.

Print a network setup page from the printer to check the network settings.

• Your wireless security settings are correct.

Log in to the access point and check the security settings.

If you are not sure if your security information is correct, run the wireless setup again.

• The printer and the computer are within the range of the wireless network.

• The computer and printer are both connected to the same wireless network.

• The printer is located away from obstacles or electronic devices that could interfere with the wireless signal.

Make sure the printer and wireless access point are not separated by poles, walls, or support columns containing
metal or concrete.

Many devices can interfere with the wireless signal, including baby monitors, motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

• The computer is not connected to a VPN.

• Your computer firewall is updated to the most recent version and allows the printer software to communicate over
the network.

The Continue button is unavailable
Try the following solutions in the order they appear until the Continue button becomes active and available:

CHECK IF THE USB CABLE IS SECURELY PLUGGED INTO THE USB PORTS ON BOTH THE COMPUTER AND THE

PRINTER

USB ports are marked with .

MAKE SURE THE PRINTER IS PLUGGED IN AND TURNED ON

Make sure the  button is lit. If you have just turned on the printer, then you might need to disconnect the USB
cable and then reconnect it.

MAKE SURE THE USB PORT ON THE COMPUTER IS WORKING

Test the USB port by connecting other devices to it. If you can successfully use other devices from the port, then the
port is working.

Notes:

• Your port may be working fine, but certain conflicts can occur with multiple USB devices. Try disconnecting
one of your other USB devices.

• If the USB port on the computer is not working, then try using the other USB ports on the computer.
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MAKE SURE THE USB CABLE IS WORKING

Try using a different USB cable. If you are using a cable longer than 10 feet, then try using a shorter cable.

Note: USB hubs, extension cables, port replicators, and docking stations may cause connection issues. Try
disconnecting these devices so that your printer is directly connected to your computer.

MAKE SURE YOU ARE USING THE CORRECT CD FOR YOUR PRINTER MODEL

Compare the printer model on the CD to the printer model on the printer. The numbers should either match exactly
or be within the same series.

If unsure, look for an updated version of the printer software on the Lexmark Web site. For more information, see
the printer User's Guide.

RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Sleep mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

4 Turn on the printer.

RUN THE INSTALLER AGAIN

1 Close the installer.

2 Remove the CD, and then restart the computer.

3 Insert the CD, and then run the installer again.

MAKE SURE YOUR COMPUTER IS ABLE TO ACKNOWLEDGE USB ACTIVITY ON THE USB PORT

Open the Device Manager to check if it has activity whenever a USB device is connected to a USB port:

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type devmgmt.msc.

3 Press Enter, or click OK.

4 Watch the Device Manager window while connecting a USB cable or another device to the USB port. The window
refreshes when the Device Manager recognizes the USB connection.

• If there is activity on the Device Manager but none of the previous solutions worked, then call customer
support.

• If there is no activity on the Device Manager, then there may be a problem with your computer and its USB
support. The computer must recognize the USB connection in order for installation to work.
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Computer firewall is blocking communication with the printer
Firewall settings may have stopped the printer from connecting to your computer.

If a firewall is installed on your computer, then do one of the following:

• Turn off your computer firewall.

• Update your computer firewall to the most recent version, and then allow the printer software to communicate
over the network.

For more information on turning off and updating the firewall, see the help pages of your operating system.

Communication with printer lost when connected to Virtual Private Network
(VPN)
You will lose your connection to a wireless printer on your local network when connected to most Virtual Private
Networks (VPNs).

Most Virtual Private Networks allow computers to communicate with only the VPN and no other network at the same
time. Disconnect from the VPN before installing the driver on the computer or before running the wireless setup on
the computer.

To check if the computer is currently connected to a VPN, open your VPN Client software, and then check your VPN
connections. If you do not have a VPN Client software installed, then check the connections manually using the Windows
VPN Client.

If you would like to have the ability to connect to your local network and to a VPN at the same time, then request the
system support person for the VPN to allow split tunneling. Be aware that some organizations will not allow split
tunneling due to security or technical concerns.

If you want to connect only to a VPN, then the documents you want to print will not be printed until you have ended
the VPN session. If you want to continue printing while connected to a VPN, then connect the printer to the computer
using a USB cable. For more information, see the User’s Guide.

Wireless troubleshooting
• “Resetting the wireless settings to factory defaults” on page 165

• “Cannot print over wireless network” on page 166

• “Wireless print server not installed” on page 169

• “'Communication not available' message appears when printing wirelessly” on page 169

• “Resolving intermittent wireless communications issues” on page 171

Resetting the wireless settings to factory defaults

1 From the printer control panel, navigate to:

 > Setup > OK  > Restore Factory Defaults > OK

2 Press the up or down arrow button to scroll to Restore Network Settings, and then press OK .
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3 Press the left or right arrow button to scroll to Yes, and then press OK .

The printer restarts automatically after resetting the wireless settings to factory defaults.

4 When prompted to set the initial settings of your printer, make your selections using the printer control panel
buttons.

Initial Setup Complete appears on the display.

Cannot print over wireless network

If you encountered problems while installing, or if your printer does not appear in the printers folder or as a printer
option when sending a print job, then try uninstalling and reinstalling the software.

Before you reinstall the software, check the troubleshooting checklist, and then do the following:

TURN THE ACCESS POINT (WIRELESS ROUTER) OFF AND THEN BACK ON

Wait one minute for the printer and computer to reestablish the connection. This can sometimes refresh network
connections and resolve connectivity issues.

DISCONNECT FROM VPN SESSION

When you are connected to another network through a VPN connection, you will not be able to access the printer
over your wireless network. End your VPN session, and then try printing again.

MAKE SURE DEMO MODE IS TURNED OFF

Select printer features are not available when Demo Mode is turned on.

From the printer control panel, navigate to:

 > Setup > OK  > Demo Mode > OK  > Off > OK

CHECK YOUR WEP KEY OR WPA PASSPHRASE

If your access point is using WEP security, then the WEP key should be:

• Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII
characters in a WEP key are case‑sensitive.

If your access point is using WPA or WPA2 security, then the WPA/WPA2 preshared key/passphrase should be:

• Exactly 64 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• From 8 to 63 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII
characters in a WPA passphrase are case‑sensitive.

Note: If you do not know this information, then see the documentation that came with the access point, or
contact your system support person.
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CHECK IF YOUR ACCESS POINT HAS AN ASSOCIATION/REGISTRATION BUTTON

Wireless broadband boxes in Europe, the Middle East, and Africa such as Livebox, AliceBox, N9UF Box, Freebox, or
Club Internet may require you to press an association/registration button when adding the printer to your wireless
network.

If you are using one of these boxes and need more information, then see the documentation that came with your
box, or contact your internet service provider (ISP).

MOVE YOUR ACCESS POINT AWAY FROM OTHER ELECTRONIC DEVICES

There may be temporary interference from electronic devices such as microwave ovens or other appliances, cordless
phones, baby monitors, and security system cameras. Make sure your access point is not positioned too closely to
these devices.

MOVE THE COMPUTER, PRINTER, OR BOTH CLOSER TO THE ACCESS POINT

The range of your wireless network depends on many factors, including the abilities of your access point and network
adapters. If you are having trouble printing, then try placing the computer and printer no more than 100 feet apart.

CHECK THE WIRELESS SIGNAL QUALITY

Print a network setup page and check the signal quality. If the signal quality is listed as good or excellent, then another
factor is causing the problem.

CHECK YOUR ADVANCED SECURITY SETTINGS

• If you are using MAC (Media Access Control) address filtering to limit access to your wireless network, then you
must add the printer MAC address to the list of addresses allowed to connect to the access point.

• If you set the access point to issue a limited number of IP addresses, then you must change this so that the printer
can be added.

Note: If you do not know how to make these changes, then see the documentation that came with the access
point, or contact the person who set up your wireless network.

MAKE SURE YOUR COMPUTER IS CONNECTED TO YOUR ACCESS POINT

• See if you have access to the Internet by opening your Web browser and accessing any site.

• If there are other computers or resources on your wireless network, then check to see if you can access them
from your computer.

MAKE SURE THAT YOUR COMPUTER AND PRINTER ARE CONNECTED TO THE SAME WIRELESS NETWORK

If the printer is not on the same wireless network as the computer, then you will not be able to print wirelessly. The
SSID of the printer must match the SSID of the computer, if the computer is already connected to the wireless network.

For Windows users

1 Obtain the SSID of the network that the computer is connected to.

a Type the IP address of your access point into the address field of your Web browser.

If you do not know the IP address of the access point, then do the following:

1 Click , or click Start and then click Run.
2 In the Start Search or Run dialog, type cmd.
3 Press Enter, or click OK.
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4 Type ipconfig, and then press Enter. Check the Wireless Network Connection section:

• The “Default Gateway” entry is typically the access point .

• The IP address appears as four sets of numbers separated by periods, such as 192.168.2.134.

b Type the user name and password of the access point when prompted.

c Click OK.

d In the Wireless settings section, look for the SSID.

e Write down the SSID.

Note: Make sure you copy it exactly, including any capital letters.

2 Obtain the SSID of the network that the printer is connected to:

a From the printer, print a network setup page.

b In the Wireless section, look for SSID.

3 Compare the SSID of the computer and SSID of the printer.

If the SSIDs are the same, then the computer and the printer are connected to the same wireless network.

If the SSIDs are not the same, then run the utility again to set up the printer on the wireless network used by the
computer.

For Macintosh users with an AirPort base station

In Mac OS X version 10.5 or later

1 From the Apple menu, navigate to:

System Preferences > Network > AirPort

or

System Preferences > Network > Wi‑Fi

The SSID of the network that the computer is connected to is displayed in the Network Name menu.

2 Write down the SSID.

In Mac OS X version 10.4 or earlier

1 From the Finder, navigate to:

Applications > Internet Connect > AirPort

The SSID of the network that the computer is connected to is displayed in the Network menu.

2 Write down the SSID.

For Macintosh users with an access point

1 Type the IP address of the access point in the address field of your Web browser, and then continue to step 2.

If you do not know the IP address of the access point, then do the following:

a From the Apple menu, navigate to:
System Preferences > Network > AirPort
or
System Preferences > Network > Wi‑Fi

b Click Advanced or Configure.
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c Click TCP/IP.
The Router entry is typically the access point.

2 Type your user name and password when prompted, and then click OK.

3 In the Wireless settings section, look for the SSID.

4 Write down the SSID, security type, and the WEP key or WPA/WPA2 preshared key/passphrase (if shown).

Notes:

• Make sure you copy the network information down exactly, including any capital letters.

• Store the SSID and the WEP key or WPA/WPA2 preshared key/passphrase in a safe place for future
reference.

MAKE SURE YOUR OPERATING SYSTEM IS COMPATIBLE WITH WIRELESS PRINTING THROUGH AIRPORT

The printer supports wireless printing only through AirPort base stations for Mac OS X version 10.5 or later.

Wireless print server not installed

You may see a message during installation indicating that the printer does not have a wireless print server installed. If
you are sure the printer is capable of wireless printing, try the following:

CHECK POWER

Make sure the  light is on.

“Communication not available” message appears when printing wirelessly

Try one or more of the following:

MAKE SURE YOUR COMPUTER AND PRINTER HAVE VALID IP ADDRESSES FOR THE NETWORK

If you are using a laptop and have power saving settings enabled, then you may see the ”Communication not available”
message on your computer screen when you attempt to print wirelessly. This can occur if the laptop hard drive has
powered down.

If you see this message, then wait a few seconds and then try to print again. The laptop and printer require a few
seconds to power up again and reconnect to the wireless network.

If you see this message again after you have waited long enough for the printer and the laptop to connect to the
network, then there may be a problem with your wireless network.

Make sure that the laptop and printer have both received IP addresses:

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run dialog, type cmd.

3 Press Enter, or click OK.

4 Type ipconfig, and then press Enter.

The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.
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For Macintosh users

1 From the Apple menu, navigate to:

About This Mac > More Info

2 From the Contents pane, choose Network.

3 If you are connected over a wireless network, then choose AirPort from the Active Services list.

The Router entry is typically the access point.

Locating the printer IP address

• From the printer, print a network setup page.

In the TCP/IP section, look for Address.

• View the printer settings.
From the printer control panel, navigate to:

 > Setup > OK  > Network Setup > OK  > Wireless 802.11 b/g/n > OK  > Network Connection Setup > OK  >
TCP/IP > OK  > IP Address > OK

or

 > Setup > OK  > Network Setup > OK  > Ethernet 10/100 > OK  > Network Connection Setup > OK  > TCP/IP >
OK  > IP Address > OK

If the printer or the laptop does not have an IP address, or if either has an address of 169.254.x.y (where x and y are
any two numbers between 0 and 255), then do the following:

1 Turn off the device that does not have a valid IP address (the laptop, the printer, or both).

2 Turn on the device, and then check the IP addresses again.

If the printer or the laptop still does not receive a valid IP address, then there is a problem with your wireless network.
Try the following:

• Make sure your access point (wireless router) is turned on and is working.

• Remove any objects that could be blocking the signal.

• Temporarily turn off any unnecessary wireless devices on your network and pause any network‑intensive
activities, like large file transfers or network games. If the network is too busy, then it is possible that the printer
is not receiving the IP address within the allowed time.

• Make sure your DHCP server, which may also be your wireless router, is working and is configured to assign IP
addresses. If you are not sure how to do this, then refer to the manual that came with your wireless router.

If the printer and computer have valid IP addresses and the network is operating correctly, then continue
troubleshooting.

MAKE SURE THE WIRELESS PORT IS SELECTED

Note: This solution applies to Windows users only.

1 Click , or click Start and then click Run.

2 In the Start Search or Run dialog, type control printers.

3 Press Enter, or click OK.

4 Right‑click the printer, and then select Properties or Printer properties from the menu.
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5 Click the Ports tab, and then locate the selected port.

The selected port has a check mark beside it in the Port column.

6 If the Description column of the selected port indicates that it is a USB port, then scroll through the list and select
the port with Printer Port in the Description column. Check the printer model in the Printer column to make sure
you select the right printer port.

7 Click OK, and then try to print again.

MAKE SURE BIDIRECTIONAL COMMUNICATION IS ENABLED

Note: This solution applies to Windows users only.

1 Click , or click Start and then click Run.

2 In the Start Search or Run dialog, type control printers.

3 Press Enter, or click OK.

4 Right‑click the printer, and then select Properties or Printer properties from the menu.

5 Click the Ports tab.

6 Click the box next to Enable bidirectional support if it is not already checked.

7 Click Apply > OK, and then try to print again.

Resolving intermittent wireless communications issues

You may notice that your printer works for a short time and then stops working, although apparently nothing has
changed on your wireless network.

Many different issues can interrupt network communications, and sometimes more than one problem exists at the
same time. Try one or more of the following:

DISCONNECT FROM ALL VPNS WHEN ATTEMPTING TO USE THE WIRELESS NETWORK

Most Virtual Private Networks (VPNs) allow computers to communicate with only the VPN and no other network at
the same time. Disconnect from the VPN before installing the driver on the computer or before running the wireless
setup on the computer.

To check if the computer is currently connected to a VPN, open your VPN Client software and check your VPN
connections. If you do not have a VPN Client software installed, then check the connections manually using the
Windows VPN Client.

If you would like to have the ability to connect to your local network and to a VPN at the same time, then request
the system support person for the VPN to allow split tunneling. Be aware that some organizations will not allow split
tunneling due to security or technical concerns.

TURN OFF THE ACCESS POINT (WIRELESS ROUTER) AND TURN IT BACK ON

Wait one minute for the printer and computer to reestablish the connection. This can sometimes refresh network
connections and resolve connectivity issues.
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ELIMINATE NETWORK CONGESTION

If a wireless network is too busy, then the computer and printer may have difficulty communicating with each other.
Some causes of wireless network congestion can include:

• Transferring large files across the network

• Networked games

• Peer‑to‑peer file swapping applications

• Streaming video

• Too many computers on the wireless network at once

ELIMINATE SOURCES OF INTERFERENCE

Common household items can potentially disrupt wireless network communications. Cordless phones (but not
cellular phones), microwave ovens, baby monitors, almost any kitchen appliance, wireless surveillance equipment,
nearby wireless networks, and any appliance containing a motor can disrupt wireless network communications.

Try turning on any potential sources of interference and see if it causes the problem. If it does, then separate your
wireless network from the device.

CHANGE THE CHANNEL THE ACCESS POINT USES

You can sometimes eliminate interference from unknown sources by changing the channel your access point uses
to broadcast. There are three distinct channels on a router. See the documentation that came with your router to
determine which three apply. Other channels are offered as options, but these overlap. If the router is configured
to use the default settings, then change the channel setting to use a different distinct channel. If you are not sure
how to change the channel, then see the documentation that came with your access point.

CONFIGURE THE ACCESS POINT WITH A UNIQUE SSID

Many wireless networks use the SSID that the router was originally configured by the manufacturer to use. Using
the default SSID can cause problems when more than one network is operating in the same area with the same SSID.
The printer or computer may attempt to attach to the wrong network, although it will appear to be trying to connect
to the correct network.

To avoid this type of interference, change the SSID on your access point from the default. If you are not sure how to
change the SSID, then see the documentation that came with your access point.

Note: You must change the SSID on all of the other devices that access your wireless network if you change the
SSID on the access point.

ASSIGN STATIC IP ADDRESSES TO ALL DEVICES IN THE NETWORK

Most wireless networks use a DHCP server (Dynamic Host Configuration Protocol) built in to the wireless router to
assign IP addresses to clients on the wireless network. DHCP addresses are assigned when they are needed, as when
a new device is added to the wireless network or when it is powered on. Wireless devices must send a request to
the router, and receive an IP address in response so they can function on the network. Because the wireless router
performs many other tasks besides assigning addresses, it sometimes does not respond quickly enough with an
address. The requesting device sometimes gives up before it receives an address.

Try assigning static IP addresses to the devices in your network to resolve this issue.
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To assign a static IP address to the printer:

1 Complete the wireless setup, allowing the printer to receive a DHCP address from a DHCP server on the network.

2 Print a network setup page to see what IP address is currently assigned to the printer.

3 Open a Web browser and then type the printer IP address in the address field. Press Enter.

4 Click Settings > Network/Ports > TCP/IP > Set static IP address.

5 In the Address field, type the IP address you want to assign to the printer, and then click Submit.

Confirm that the IP address is updated by typing the static IP address in the browser address field and checking to
see if the Embedded Web Server reloads. For more information on assigning static IP addresses, see the
documentation that came with your router and operating system.

CHECK FOR KNOWN ISSUES WITH THE ACCESS POINT

Some wireless routers have documented defects that were identified and resolved by the manufacturers. Visit the
company Web site of the router manufacturer. Check for firmware updates and other advice from the manufacturer.
See the documentation that came with your wireless router if you are not sure how to reach the manufacturer Web
site.

CHECK FOR WIRELESS NETWORK ADAPTER UPDATES

If you are having trouble printing from one particular computer, then check the Web site of the manufacturer of the
wireless network adapter card in that computer. It is possible that there is an updated driver available that could
resolve the issue.

CHANGE ALL NETWORK DEVICES TO THE SAME TYPE

While it is possible to successfully mix 802.11b, 802.11g, and 802.11n devices on the same wireless network, the
faster devices will sometimes prevent the slower devices from communicating.

Try turning on only the network devices of the same type and see if network communications improve. If this solves
the problem, then you may want to upgrade your older devices with newer wireless network adapters.

PURCHASE A NEW ROUTER

If your router is several years old, then it may not be fully compatible with the newer wireless devices on your network.
Consider purchasing a newer router that is fully compliant with the 802.11 IEEE specifications.

Ethernet network troubleshooting

Printer does not appear in the list of printers found on the network

CHECK THE ETHERNET CABLE

• Check the Ethernet cable and the Ethernet connectors at both ends for any obvious damage.

• Firmly plug one end of the Ethernet cable into the printer. Firmly plug the other end of the Ethernet cable into
the network hub or wall connection.

• Try using a different cable. Damage to the cable may not be obvious.
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MAKE SURE THE PRINTER POWER IS ON

Make sure the printer is connected to a power source and is turned on.

MAKE SURE THAT THE NETWORK IS OPERATING PROPERLY

• Try to access other computers on the network.

• Make sure all switches, hubs, and other connecting devices are turned on.

MAKE SURE THE PRINTER HAS VALID NETWORK SETTINGS

Print a network setup page from the printer and check the following. See the “Networking” section of the User's
Guide for instructions on how to print a network setup page.

• Verify that the IP address is correct for your network.

• Verify that the gateway is correct.

• Verify that the network mask is the same as the network mask used for other computers and printers on your
network.

Cannot print to the network printer

CHECK THE ETHERNET CABLE

• Check the Ethernet cable and the Ethernet connectors at both ends for any obvious damage.

• Firmly plug one end of the Ethernet cable into the printer. Firmly plug the other end of the Ethernet cable into
the network hub or wall connection.

• Try using a different cable. Damage to the cable may not be obvious.

MAKE SURE THE PRINTER POWER IS ON

Make sure the printer is connected to a power source and is turned on.

MAKE SURE THAT THE NETWORK IS OPERATING PROPERLY

• Try to access other computers on the network.

• Make sure all switches, hubs, and other connecting devices are turned on.

UNINSTALL AND REINSTALL THE SOFTWARE

See the “Reinstalling the printer software” section of the User’s Guide.

Embedded Web Server does not open
Try one or more of the following:

CHECK THE NETWORK CONNECTION

Make sure the printer and computer are turned on and connected to the same network.
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CHECK THE ADDRESS ENTERED IN THE WEB BROWSER

• Depending on the network settings, you may need to type “https://” instead of “http://” before the printer
IP address to access the Embedded Web Server. For more information, contact your system support person.

• Make sure printer IP address is correct.

TEMPORARILY DISABLE WEB PROXY SERVERS

Proxy servers may block or restrict you from accessing certain Web sites including the Embedded Web Server. For
more information, contact your system support person.

Contacting customer support
When you contact customer support, you will need to be able to describe the problem you are experiencing, the message
on the printer display, and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label on the inside top
front cover of the printer. The serial number is also listed on the menu settings page.

Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:

Tech Library You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.

E-mail You can send an e-mail to the Lexmark team, describing your problem. A Lexmark team representative will
respond and provide you with information to solve your problem.

Live chat You can chat directly with a Lexmark Service Representative. They can work with you to solve your printer
problem or provide Assisted Service where the Lexmark Service Representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit the
Lexmark Web site at http://support.lexmark.com.
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Notices

Product information

Product name:

Lexmark Pro4000 Series

Machine type:

4447

Model(s):

Pro4000: 0n0, 0nE; Pro4000c: 000

Edition notice

April 2012

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

If you don't have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2012 Lexmark International, Inc.

All rights reserved.
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GOVERNMENT END USERS

The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commerical Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.

Trademarks

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United
States and/or other countries.

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.

PCL® is a registered trademark of the Hewlett-Packard Company.

All other trademarks are the property of their respective owners.

AirPrint and the AirPrint logo are trademarks of Apple, Inc.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult your point of purchase or service representative for additional suggestions.
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The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Modular component notice
This product may contain the following modular component(s):

Lexmark regulatory type/model LEX-M03-003; FCC ID: US:2G2CN00BM03003; Industry Canada IC:2376A-M03003

Lexmark regulatory type/model LEX-M01-003; FCC ID: IYLM01003; Industry Canada IC:2376A-M01003

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

Note: Some modes may not apply to your product.

1-meter average sound pressure, dBA

Printing 52 dBA

Scanning 47 dBA

Copying 52 dBA

Ready inaudible

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive
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The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the
Lexmark Web site at www.lexmark.com for your local sales office phone number.

Battery notice

This product contains Perchlorate material. Special handling may apply. For more information, go to
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/.

Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR
Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Temperature information

Ambient temperature 15°C to 32°C (60°F to 90°F)

Shipping and storage temperature -40°C to 60°C (-40°F to 140°F), 1°C to 60°C (34°F to 140°F)

Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.
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Mode Description Power consumption (Watts)

Printing The product is generating hard‑copy output from electronic inputs. 37 W

Copy The product is generating hard‑copy output from hard‑copy original
documents.

36 W

Scan The product is scanning hard‑copy documents. 19 W

Ready The product is waiting for a print job. 12 W

Sleep Mode The product is in a high‑level energy‑saving mode. 5.3 W

Off The product is plugged into a wall outlet, but the power switch is turned off. 0.55 W

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.

Sleep Mode

This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by lowering
power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged after this product
is not used for a specified period of time, called the Sleep Mode Timeout.

Factory default Sleep Mode Timeout for this product (in minutes): 30

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 240 minutes. Setting
the Sleep Mode Timeout to a low value reduces energy consumption, but may increase the response time of the product.
Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more energy.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l’industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.
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European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2009/125/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energy-
related products.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for telecommunication terminal equipment

This section contains regulatory information pertaining to products that contain telecommunication terminal
equipment such as facsimile.

Notice to users of the US telephone network: FCC requirements
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other information, a
product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to your telephone
company.

This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.

A plug and jack used to connect this equipment to the premises’ wiring and telephone network must comply with the
applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is
provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See your
setup documentation for more information.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to a telephone
line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most
but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact your local telephone company. For products approved
after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX.
The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products,
the REN is shown separately on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. If advance notice is not practical, the telephone company will
notify the customer as soon as possible. You will also be advised of your right to file a complaint with the FCC.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the
operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to
make necessary modifications to maintain uninterrupted service.

If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International, Inc.
at www.lexmark.com or your Lexmark representative. If the equipment is causing harm to the telephone network, the
telephone company may request that you disconnect the equipment until the problem is resolved.
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This equipment contains no user serviceable parts. For repair and warranty information, contact Lexmark International,
Inc. See the previous paragraph for contact information.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service
commission, or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this
equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment,
consult your telephone company or a qualified installer.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter's
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic
device, including fax machines, to send any message unless said message clearly contains in a margin at the top or
bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification
of the business or other entity, or other individual sending the message, and the telephone number of the sending
machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or
any other number for which charges exceed local or long-distance transmission charges.)

See your user documentation in order to program this information into your fax machine.

Notice to users of the Canadian telephone network
This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is
an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of
an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of
all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter’s
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.

This equipment uses CA11A telephone jacks.

Avis réservé aux utilisateurs du réseau téléphonique du Canada

Ce produit est conforme aux spécifications techniques d’Industrie Canada. Le numéro REN (ringer equivalence number :
numéro d’équivalence de sonnerie) fournit une indication du nombre maximum de terminaux pouvant être connectés
à l’interface téléphonique. En bout de ligne, le nombre d’appareils qui peuvent être connectés n’est pas directement
limité, mais la somme des REN de ces appareils ne doit pas dépasser cinq. Le numéro REN du modem est indiqué sur
l’étiquette produit située à l’arrière de l’équipement.

Les compagnies de téléphone constatent que les surtensions électriques, en particulier celles dues à la foudre,
entraînent d'importants dégâts sur les terminaux privés connectés à des sources d’alimentation CA. Il s’agit-là d’un
problème majeur d’échelle nationale. En conséquence, il vous est recommandé de brancher un parasurtenseur dans
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la prise de courant à laquelle l’équipement est connecté. Utilisez un parasurtenseur répondant à des caractéristiques
nominales satisfaisantes et certifié par le laboratoire d’assureurs UL (Underwriter’s Laboratories), un autre laboratoire
agréé de type NRTL (Nationally Recognized Testing Laboratory) ou un organisme de certification agréé dans votre région
ou pays. Ceci prévient tout endommagement de l’équipement causé par les orages et autres surtensions électriques.

Cet équipement utilise des prises de téléphone CA11A.

Notice to users of the New Zealand telephone network
The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal
equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection
to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above
all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted
equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom's network
services.

This equipment shall not be set up to make automatic calls to the Telecom's 111 Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom
customers.

Some parameters required for compliance with Telecom's telepermit requirements are dependent on the equipment
associated with this device. The associated equipment shall be set to operate within the following limits for compliance
to Telecom's specifications:

• There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual
call initiation, and

• The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the
beginning of the next call attempt.

• The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not
less than 5 seconds between the end of one call attempt and the beginning of another.

Using this product in Switzerland

This product requires a Swiss billing tone filter (Lexmark part number 14B5109 or 80D1877) to be installed on any line
which receives metering pulses in Switzerland. The filter must be used, as metering pulses are present on all analog
telephone lines in Switzerland.

Utilisation de ce produit en Suisse

Cet appareil nécessite l’utilisation d’un filtre de tonalité de facturation suisse (nº de référence Lexmark : 14B5109 ou
80D1877) devant être installé sur toute ligne recevant des impulsions de comptage en Suisse. Ce filtre doit être utilisé
pour toute installation car ces impulsions existent sur toutes les lignes téléphoniques suisses.

Verwendung dieses Produkts in der Schweiz

Für dieses Produkt muss ein schweizerischer Billing Tone Filter zur Zählzeichenübertragung (Lexmark Teilenummer
14B5109 oder 80D1877) für jede Leitung installiert werden, über die in der Schweiz Zeitsteuertakte übertragen werden.
Die Verwendung des Filters ist obligatorisch, da in allen analogen Telefonleitungen in der Schweiz Zeitsteuertakte
vorhanden sind.
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Uso del prodotto in Svizzera

Questo prodotto richiede un filtro toni Billing svizzero, (codice Lexmark 14B5109 o 80D1877) da installare su tutte le
linee che ricevono impulsi remoti in Svizzera. È necessario utilizzare il filtro poiché gli impulsi remoti sono presenti su
tutte le linee analogiche in Svizzera.

Notice to Users in the European Union

Products bearing the CE mark are in conformity with the protection requirements of EC Council directives 2004/108/EC,
2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio
equipment and telecommunications terminal equipment.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

Refer to the table at the end of the Notices section for further compliance information.

Regulatory notices for wireless products

This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation

The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.
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The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Notice to users in the European Union
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, radio
equipment and telecommunications terminal equipment and on the ecodesign of energy-related products.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the
laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use
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within certain voltage limits and on radio equipment and telecommunications terminal equipment and on the ecodesign
of energy-related products.

Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product may be used in the countries indicated in the table below.

AT BE BG CH CY CZ DE DK EE

EL ES FI FR HR HU IE IS IT

LI LT LU LV MT NL NO PL PT

RO SE SI SK TR UK

Česky Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.
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Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.

Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.

Svenska Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

Statement of Limited Warranty
Lexmark Pro4000 Series

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-
specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts

—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).

If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.
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If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed.

To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web at http://support.lexmark.com.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance

—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
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WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.
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2‑sided, fax 

setting  87
802.1X authentication  110

A
ad hoc network  122
ad hoc wireless network 

adding a printer  108
adding 

network folder shortcut  65
additional computers 

installing wireless printer  105
Additional Solutions 

customize printer settings
using  131

Address Book 
setting up  89, 90

Address Book Setup 
customize printer settings

using  131
Address Book, fax 

setting  87
ADF input tray 

location  11
ADF press plate 

cleaning  135
ADF scanner glass 

cleaning  135
adjusting 

scan color  71
adjusting dialing and ringer
volume  96
adjusting speaker volume  96
advanced wireless setup  103
AliceBox  106
aligning the printhead  133
Alignment Problem  142
answering machine 

best settings for fax  97
setting up  76

appliances 
wireless network  124

assigning IP address  129
authentication 

802.1X  110
Auto Answer 

when to turn on  95

Automatic Document Feeder (ADF) 
clearing a paper jam in  149
loading documents  35
location  10
paper capacity  35
supported paper sizes  35

automatic fax conversion 
setting  87

B
background, removing  62
backing material 

cleaning  135
bidirectional communication 

enabling  169
bin extender 

location  11
black and white scanning  71
blocking faxes  99
broadcast fax, sending 

immediately  91
buttons, printer control panel 

Address Book  17
arrow buttons  16
Back  16
Black  17
Cancel  17
Color  17
Dial Tone  17
Home  16
keypad  16
Pause  17
Power  16
Redial  17
Select  16
Start  17

C
cable 

installation  121
USB  121

Caller ID  86
Caller ID pattern, fax 

setting  87
camera 

connecting  49
canceling 

copy job  63

e‑mail  75
print job  56
scan job  71

Cannot Collate Job  142
cannot delete documents from
print queue  141
cannot open Embedded Web
Server  174
cannot print over wireless
network  166
cannot print through USB  141
cannot print to network
printer  174
cannot receive faxes  158
cannot run fax software  159
cannot scan to computer over a
network  155
cannot send e‑mail  155
cannot send faxes  157
card reader light 

location  11
cartridges, ink 

ordering  13
using genuine Lexmark  13

certificate requests  110
Change [Paper Source] to [Size]
[Type] Paper  142
Change [Paper Source] to [Size]
Paper  142
changing default printing mode  54
changing page order  42
changing print order  42
changing Sleep timeout  18
changing wireless settings after
installation (Macintosh)  107
changing wireless settings after
installation (Windows)  107
checking 

ink levels  133
checking an unresponsive
printer  137
checking the dial tone  96
checklist 

before you troubleshoot  137
fax troubleshooting  156
memory card troubleshooting  162

choosing a splitter, faxing  94
cleaning exterior of the printer  134
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cleaning printhead nozzles  134
Close Printer  142
Club Internet  106
coated paper 

loading  32
collating copies  60
color scanning  71
Communication not available 

message  169
computer slows down when
printing  153
configuring 

fax settings  87, 88
IP address  107

configuring e‑mail settings  72
configuring security settings  109
configuring Wi‑Fi Protected Setup 

PBC, Push Button Configuration
method  109

PIN, Personal Identification
Number method  109

confirmation page, fax  98
connection 

configurations  126
conserving energy  18
conserving energy, ink, and paper  7
conserving paper  18
contact list 

setting up  89, 90
contact list, e‑mail 

creating  73
setting up  73

contacting customer support  175
Continue button unavailable  163
copier or scanner does not
respond  154
copies 

making  58
copy and scan troubleshooting 

cannot scan to computer over a
network  155

copier or scanner does not
respond  154

partial document or photo
scans  154

poor scanned image quality  154
scan not successful  155
scanning takes too long or freezes

the computer  155
copy job 

canceling  63
copy quality, adjusting  60

Copy Settings 
customize printer settings

using  131
copy troubleshooting 

scanner unit does not close  154
copying  58

adding an overlay message  61
adjusting quality  60
collating copies  60
enlarging an image  59
ID cards  59
making a copy lighter or darker  60
multiple page images on one

sheet  61
on both sides of the paper  62
Pages per Side  61
placing separator sheets between

copies  61
reducing an image  59
removing background  62
tips  58

customer support  137
customer support label 

location  11
custom‑size paper 

printing on  46

D
date and time 

setting  86
default printer, setting  54
default printing mode 

changing  54
defaults 

restoring factory defaults  18
Device Management 

customize printer settings
using  131

dial method, fax 
setting  87

dial tone 
checking  96

dial tone volume 
adjusting  96

dialing prefix  95
Digital Subscriber Line (DSL) 

fax setup  79
digital telephone service 

fax setup  81
distinctive ring  95

documents 
adding a network folder

shortcut  65
faxing using the computer  92
faxing using the control panel  91
loading into the Automatic

Document Feeder (ADF)  35
loading on scanner glass  34
printing  40
scanning for editing  68
scanning using the printer control

panel  65
scanning using the touch

screen  64
downloading PCL drivers  27
downloading PS drivers  27
downloading Universal Print
Driver  27
drivers 

downloading  27
DSL filter  79
duplex 

copying, automatic  62
copying, manual  62
faxing  99
printing, automatic  50

duplex printing dry time 
setting  38, 52

duplex unit 
location  12

Duplex Unit Missing  143

E
EAP  109
EAP‑MD5  110
EAP‑TLS  110
EAP‑TTLS  110
Embedded Web Server 

accessing  130
problem accessing  174

emission
notices  177, 178, 180, 181, 184, 
185
energy 

conserving  7
enlarging an image  59
entering 

fax user information  86
envelopes 

loading  32, 44
printing  44
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error correction, fax 
setting  87

error using memory card  162
Ethernet  126

network indicator light  105
Ethernet network 

information needed for setting up
Ethernet printing  110

Ethernet port 
location  12

Ethernet setup 
information needed for  110

exit bin 
location  11

EXT port 
location  12

extending the duplex printing dry
time  52
extending the two‑sided printing
dry time  38
exterior of the printer 

cleaning  134
e‑mail 

canceling  75
E‑mail Alert Setup 

customize printer settings
using  131

e‑mail function 
setting up  72

e‑mail troubleshooting 
cannot send e‑mail  155

E‑mail/FTP Settings 
customize printer settings

using  131
e‑mailing 

Address Book  73
configuring e‑mail settings  72
scanned documents  69
setting up e‑mail function  72
tips  74

F
factory default settings 

restoring  18
failed faxes 

retrieving  100
fax 

confirmation page  98
printer memory  100
transmission report  98

fax activity report  98

fax blocking 
setting  87

fax error messages 
Digital Line Detected  160
Failed To Connect  161
Fax Mode Unsupported  160
Fax Modem Error  160
No Answer  161
No Caller ID  161
Phone Line Busy  161
Phone Line Error  161
Phone Line is connected to the

incorrect jack on the back of the
machine  160

Phone Line Not Connected  161
Remote Fax Error  160
Unrecoverable Fax Error  160
Unsupported Compression  160
Unsupported Resolution  160

fax footer 
setting  87

fax forwarding  99
fax header 

setting  87
fax header and footer 

setting  86
fax number  94
fax quality 

setting  97
fax resolution 

setting  97
fax sending speed 

setting  87
Fax Settings 

customize printer settings
using  131

fax settings 
configuring  87, 88
for answering machine  97
for voice mail  97

fax setup 
country‑ or region‑specific  83
digital telephone service  81
DSL connection  79
standard telephone line

connection  76
VoIP  80

Fax Setup Wizard  88
fax troubleshooting 

cannot receive faxes  158
cannot run fax software  159
cannot send faxes  157

error messages, printer control
panel  160

fax troubleshooting checklist  156
faxing 

Address Book  89, 90
blocking  99
calling card, using  98
dial prefix  95
distinctive ring  95
duplex  99
fax history  98
pick up on  95
receiving automatically  93
receiving manually  93
rings  95
scheduling  97
sending a broadcast fax

immediately  91
sending using the control

panel  91
setup  94
tips, receiving  92
tips, sending  91
two‑sided  99
using the computer  92
using the control panel  91

faxing tips 
receiving faxes automatically  93

FCC notices  177, 181, 184
file types 

supported  47
finding 

information  8
MAC address  127
print queue  53
publications  8
Web site  8

firewall on computer  165
flash drive 

inserting  47
printing documents from  44
scanning to  66

forwarding faxes  99
France 

special wireless setup
instructions  106

Freebox  106
frequently asked questions 

USB cable  121
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G
General Settings 

customize printer settings
using  131

glossy paper 
loading  32

greeting cards 
loading  33

Group Dial 
setting up  89, 90

H
header bar  130
home page 

areas  130
understanding  130

I
ID cards 

copying  59
Import/Export 

customize printer settings
using  131

improving scan quality  71
incorrect language appears on
display  138
index cards 

loading  33
information 

finding  8
information needed for setting up
printer on Ethernet network  110
information pane  130
information you will need during
wireless setup  102
infrastructure network  122
ink 

conserving  7
ink cartridge access door 

location  11
Ink Cartridge Access Door
Open  143
Ink Cartridge Error  144
Ink Cartridge Missing  144
ink cartridges 

ordering  13
replacing  14
using genuine Lexmark  13

ink levels 
checking  133

Ink Low  145

inserting a memory card or flash
drive  47
installation 

cable  121
installing 

network printer  129
installing optional software  26
installing printer 

on wired network
(Macintosh)  111

on wired network (Windows)  111
on wireless network

(Macintosh)  104
on wireless network

(Windows)  104
installing printer on wired network
(Macintosh)  111
installing printer on wired network
(Windows)  111
installing printer software  27
installing wireless printer 

additional computers  105
interference 

wireless network  124
Intervention Management 

customize printer settings
using  131

IP address  128
configuring  107

IP address of computer 
finding  128

IP address of printer 
finding  128

IP address, assigning  129
iron-on transfers 

loading  33

J
jams and misfeeds troubleshooting 

paper jam in the ADF  149
paper jam in the duplex unit  148
paper jam in the printer  148
paper or specialty media  150

junk faxes 
blocking  99

K
key index  129

L
labels 

loading  33
printing  45

language 
changing  138

LEAP  109, 110
LexPrint  56
line filter  79
LINE port 

location  12
linking trays  39
LiveBox  106
Load [Paper Source] with [Size]
[Type] Paper  145
Load [Paper Source] with [Size]
Paper  145
loading 

documents into the Automatic
Document Feeder (ADF)  35

documents on scanner glass  34
envelopes  44
paper tray  29
various paper types  31

locating 
SSID  118
WEP key  117
WPA/WPA2 preshared

key/passphrase  117

M
MAC address  126

finding  127
MAC address filtering  126
Macintosh 

installing printer on wireless
network  104

USB  114
wireless  114

Macintosh printer software 
using  25

Manage Profiles 
customize printer settings

using  131
Manage Shortcuts 

customize printer settings
using  131

memory card 
inserting  47
printing documents from  44
scanning to  66
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supported types  47
memory card cannot be
inserted  162
memory card slot 

location  11
memory card troubleshooting 

checklist  162
nothing happens when memory

card is inserted  162
Memory Device Access Error  145
minimum system requirements  23
moving the printer  135
MSCHAPv2  110
multiple pages per sheet,
printing  43
multiple WEP keys  129

N
N9UF Box  106
navigation pane  130
Network [x] Software Error  145
network connection 

with USB  126
network indicator light  105
network overview  118
network printer 

installing  129
network security  118
network setup page 

printing  102
network troubleshooting 

cannot print to network
printer  174

printer to be configured does not
appear in list of printers found
on network  173

Network/Ports 
customize printer settings

using  131
networking 

sharing the printer with a
Macintosh computer  116

sharing the printer with a
Windows computer  116

noise emission levels  178
nothing happens when memory
card is inserted  162
notices  177, 178, 179, 180, 181, 
182, 183, 184, 185, 186

O
on‑hook faxing  98
ordering paper and other
supplies  15

P
page does not print  139
page order 

changing  42
Pages per Side copies  61
paper 

conserving  7
loading  29, 31

paper and other supplies 
ordering  15

paper default settings 
saving  34

paper jam in the ADF  149
paper jam in the duplex unit  148
paper jam in the printer  148
paper or specialty media
misfeeds  150
Paper Setup 

customize printer settings
using  131

paper size and type 
setting  37

paper tray 
location  11

Paper Tray [x] Detected  145
Paper Tray [x] Removed  146
paper, recommended brands 

types and sizes  36
partial document or photo
scans  154
parts 

diagram  10
password  118
pausing 

print job  55
PDF 

creating from scan  70
PEAP  109, 110
Personal Identification Number
method 

using  109
phone book 

setting up  89, 90
phone plug  83
phone splitter  80

photo cards 
loading  33

photo paper 
loading  32

photos 
making borderless copies  59
printing from a memory card or

flash drive  49
PictBridge and USB port 

location  11
PictBridge-enabled camera,
connecting  49
PIN 

setting for security  19
poor quality at the edges of
page  151
poor scanned image quality  154
postcards 

loading  33
power supply port 

location  11
Print dialog 

launching  25
print job 

canceling  56
pausing  55
resuming  55

print order 
changing  42

print queue 
creating  53
finding  53

Print Settings 
customize printer settings

using  131
print speed is slow  152
print troubleshooting 

cannot delete documents from
print queue  141

computer slows down when
printing  153

poor quality at the edges of
page  151

printed page has ink smears or
smudges  152

slow print speed  152
streaks or lines on printed

image  152
printed page has ink smears or
smudges  152
printer 

moving  135
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selecting a location  12
sharing  116
sharing in Windows  116

printer control panel 
buttons  16
display  16
Ethernet indicator  16
layout  16
location  11
using  16
Wi‑Fi indicator  17

printer does not respond  140
printer memory 

fax  100
Printer Memory Full  146
printer messages 

Alignment Problem  142
Cannot Collate Job  142
Change [Paper Source] to [Size]

[Type] Paper  142
Change [Paper Source] to [Size]

Paper  142
Close Printer  142
Duplex Unit Missing  143
Ink Cartridge Access Door

Open  143
Ink Cartridge Error  144
Ink Cartridge Missing  144
Ink Low  145
Load [Paper Source] with [Size]

[Type] Paper  145
Load [Paper Source] with [Size]

Paper  145
Memory Device Access Error  145
Paper Tray [x] Detected  145
Paper Tray [x] Removed  146
Printer Memory Full  146
Printhead Cannot Move  146
Printhead Error  146
Printhead Warning  146
Replace Ink Cartridge  146
Scanned Document Too Long  146
Scanner ADF Cover Open  147
Scanner Disabled  147
Short Paper  147
Unrecoverable Scan Error  147
Unsupported Cartridge  144
USB Device Not Supported  147
USB Hub Not Supported  147

printer printing blank pages  140
printer problems, basic
solutions  137

Printer Settings  88
printer settings, customizing 

Additional Solutions  131
Address Book Setup  131
Copy Settings  131
Device Management  131
E‑mail Alert Setup  131
E‑mail/FTP Settings  131
Fax Settings  131
General Settings  131
Import/Export  131
Intervention Management  131
Manage Profiles  131
Manage Shortcuts  131
Network/Ports  131
Paper Setup  131
Print Settings  131
Scan‑to‑Network Folder

Setup  131
Security  131

printer software 
installing  27
uninstalling  27

printer status 
determining  105

printer to be configured does not
appear in list of printers found on
network  173
printer, setting as default  54
printers 

supported  57
printhead 

aligning  133
Printhead Cannot Move  146
Printhead Error  146
printhead nozzles 

cleaning  134
Printhead Warning  146
printing 

advanced color  41
collate  41
custom‑size paper  46
documents  40
documents from a memory card

or flash drive  44
envelopes  44
first page first  42
from a PictBridge‑enabled

camera  49
labels  45
multiple pages on one sheet  43
network setup page  102

on both sides of the paper  50
photos from a memory card or

flash drive  49
tips  40
two‑sided  50

printing a confirmation page  98
printing a transmission report  98
printing using advanced color
options  41
protocol  128
publications 

finding  8
Push Button Configuration method 

using  109

R
received history report  98
receiving faxes 

Auto Answer setting  93
automatically  93
manually  93
tips  93

recommended paper brands 
types and sizes  36

recovering the security PIN  138
recycling  7

Lexmark products  15
WEEE statement  178

redial attempts, fax 
setting  87

redial time, fax 
setting  87

reducing an image  59
registering 

fax user information  86
Transmit Terminal Identification

(TTI)  86
Replace Ink Cartridge  146
replacing ink cartridges  14
reports 

fax history  98
reports, fax 

setting  87
resetting 

wireless settings to factory
defaults  165

resetting to factory defaults  18
resuming 

print job  55
retrieving failed faxes  100
ringer volume 

adjusting  96
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RJ‑11 adapter  83

S
safety information  6
saving energy  18
saving paper  18
saving paper default settings  34
scan 

improving quality  71
PIN  71

scan job 
canceling  71

scan was not successful  155
Scanned Document Too Long  146
Scanner ADF Cover Open  147
Scanner Disabled  147
scanner glass 

cleaning  135
location  11

scanner unit does not close  154
scanning 

creating a PDF from scan  70
documents for editing  68
documents for e‑mailing  69
in black and white  71
tips  64
to a flash drive  66
to a local computer  64
to a memory card  66
to a network  65
to a network computer  65
to a network folder  65
using the printer control panel  65
using the touch screen  64

scanning photos 
using the Macintosh printer

software  67
using the printer control panel  68
using the Windows printer

software  67
scanning takes too long or freezes
the computer  155
Scan‑to‑Network Folder Setup 

customize printer settings
using  131

scheduled fax 
sending  97

Security 
customize printer settings

using  131
security 

configuring  109

wireless network  101
security information 

wireless network  118
security key  118
security PIN 

recovering  138
setting  19

selecting the wireless port  169
sender information 

registering  86
sending a scheduled fax  97
sending faxes, tips  91
sent history report  98
setting 

Auto Answer  95
Caller ID  86
fax header and footer  86
fax quality  97
maximum sending speed  87
sender information  86
Transmit Terminal Identification

(TTI)  86
setting the duplex printing dry
time  52
setting the paper size and type  37
setting the two‑sided printing dry
time  38
setting up fax 

country‑ or region‑specific  83
digital telephone service  81
DSL connection  79
standard telephone line

connection  76
VoIP connection  80

setting up printer 
faxing  94
on wired network

(Macintosh)  111
on wired network (Windows)  111
on wireless network

(Macintosh)  104
on wireless network

(Windows)  104
setup troubleshooting 

cannot print through USB  141
incorrect language appears on

display  138
page does not print  139
printer does not respond  140
printer printing blank pages  140
recovering security PIN  138
software did not install  138

shared printing  116
sharing printer in Windows  116
Short Paper  147
shortcut 

creating  21
deleting  21
modifying  21

shortcuts  20, 21
using shortcuts on printer  22

shortcuts page 
launching  21

signal strength 
finding  123

Sleep timeout 
changing  18

software did not install  138
software updates 

checking  26
software, optional 

finding, installing  26
speaker volume 

adjusting  96
Speed Dial 

setting up  89
splitter, choosing  94
SSID 

finding  125
locating  118
wireless network  118

Standard Network Software
Error  147
streaks or lines on printed
image  152
supported memory cards and file
types  47
supported operating systems  23
supported printers  57
switching from Ethernet 

to USB, using Windows  112
to wireless, using Windows  112

switching from USB 
to Ethernet, using Windows  112
to wireless, using Mac OS X  114
to wireless, using Windows  112

switching from wireless 
to Ethernet, using Windows  112
to USB, using Mac OS X  114
to USB, using Windows  112

T
TCP/IP  128
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telecommunication
notices  181, 182, 183, 184
tips for 

copying  58
e‑mailing  74
printing  40
receiving faxes  92
scanning  64
sending faxes  91

transmission report, fax  98
transmit key 

WEP  109
transparencies 

loading  33
tray 

loading paper  29
trays 

linking  39
troubleshooting 

cannot open Embedded Web
Server  174

checking an unresponsive
printer  137

contacting customer
support  137, 175

Continue button is
unavailable  163

fax checklist  156
solving basic printer

problems  137
wireless network  162

troubleshooting, copy 
scanner unit does not close  154

troubleshooting, copy and scan 
cannot scan to computer over a

network  155
copier or scanner does not

respond  154
partial document or photo

scans  154
poor scanned image quality  154
scan not successful  155
scanning takes too long or freezes

the computer  155
troubleshooting, e‑mail 

cannot send e‑mail  155
troubleshooting, fax 

cannot receive faxes  158
cannot run fax software  159
cannot send faxes  157
error messages, printer control

panel  160

troubleshooting, jams and
misfeeds 

paper jam in the ADF  149
paper jam in the duplex unit  148
paper jam in the printer  148
paper or specialty media  150

troubleshooting, memory card 
checklist  162
nothing happens when memory

card is inserted  162
troubleshooting, network 

cannot print to network
printer  174

printer to be configured does not
appear in list of printers found
on network  173

troubleshooting, print 
cannot delete documents from

print queue  141
computer slows down when

printing  153
ink smears or smudges  152
poor quality at the edges of

page  151
slow print speed  152
streaks or lines on printed

image  152
troubleshooting, setup 

cannot print through USB  141
incorrect language appears on

display  138
page does not print  139
printer does not respond  140
printer printing blank pages  140
recovering security PIN  138
software did not install  138

troubleshooting, wireless 
cannot print over wireless

network  166
changing wireless settings after

installation (Macintosh)  107
changing wireless settings after

installation (Windows)  107
resolving communication

problems  171
two‑sided 

copying, automatic  62
copying, manual  62

two‑sided printing 
supported paper sizes and paper

types  50

two‑sided printing dry time 
setting  38, 52

TX report, fax  98

U
UK 

special wireless setup
instructions  106

uninstalling printer software  27
Universal Print Driver 

downloading  27
Unrecoverable Scan Error  147
Unsupported Cartridge  144
updating printer software  26
USB  126

cable  121
Macintosh  114

USB cable  121
definition  121

USB connection 
with network connection  126

USB Device Not Supported  147
USB Hub Not Supported  147
USB port 

location  12
user information, fax 

setting  87

V
Virtual Private Network  165
voice mail 

setting up  76
voice mail, fax settings  97
Voice over Internet Protocol (VoIP) 

fax setup  80
VoIP adapter  80
volume, adjusting 

ringer and dial tone  96
speaker  96

VPN 
lost connection to printer  165
printing locally  165

W
Web Links 

accessing  25
Web site 

finding  8
WEP  101, 109
WEP key 

key index  129
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locating  117
WEP transmit key  109
Windows 

installing printer on wireless
network  104

Windows software 
Abbyy Sprint OCR  23
Phone Book  23
Printer Home  23
Printer Setup Utility  23
Printing Preferences  23
Product Update  23
Status Messenger  23
Status Monitor Center  23
Tools for Office  23
Wireless Setup Utility  23

wired (Ethernet) networking for
Macintosh  111
wired (Ethernet) networking for
Windows  111
wireless  126

Macintosh  114
network indicator light  105

wireless network 
adding a printer to existing ad hoc

network  108
advanced setup  103
common home

configurations  119
information you will need for

setting up wireless printing  102
installing printer on

(Macintosh)  104
installing printer on

(Windows)  104
interference  124
resolving communication

problems  171
security  101
security information  118
signal strength  123
SSID  118
troubleshooting  162
types of wireless networks  122

wireless network compatibility  101
wireless print server 

not installed  169
wireless settings 

changing after installation
(Macintosh)  107

changing after installation
(Windows)  107

resetting to factory defaults  165
wireless setup 

advanced  103, 129
guided  129
information needed for  102

wireless signal 
strength  123

wireless signal absorption  124
wireless troubleshooting 

cannot print over wireless
network  166

changing wireless settings after
installation (Macintosh)  107

changing wireless settings after
installation (Windows)  107

lost connection to printer  165
printer and computer on different

networks  125
printer works intermittently on

wireless network  171
Wi‑Fi Protected Setup 

configuring manually  109
using  117

Wi‑Fi Protected Setup logo 
identifying  117

WPA  101, 109
WPA/WPA2 preshared/passphrase 

locating  117
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